# Table of Contents

Chapter 1: Introduction .................................................................................................................. 4

Chapter 2: Getting Started ............................................................................................................. 5
  How the Program Works ................................................................................................................ 5
  Configuring the Program and Network Environment ................................................................. 5
  Local, Remote and Web Access to the Program .............................................................................. 5
  Getting to Know the Program Interface ......................................................................................... 5
  Enumerating a Network to Discover PCs ....................................................................................... 5
  Configuring and Executing Remote Operations ............................................................................ 5
  Remote Operations Overview .......................................................................................................... 5
  Using Wake-on-LAN to Wake Up Computers ................................................................................ 5
  Working Effectively with Collections and Dynamic Targets ......................................................... 5
  Creating Tasks and Schedules ......................................................................................................... 5

Chapter 3: Program Interface Overview .......................................................................................... 42
  Welcome Screen ............................................................................................................................ 42
  Tasks and Schedule View .............................................................................................................. 42
  Credentials View .......................................................................................................................... 42
  Execution Results View ............................................................................................................... 42
  Log View ...................................................................................................................................... 42
  All Machines View ....................................................................................................................... 42
  Access Control View .................................................................................................................... 42
  Operations View .......................................................................................................................... 42
  Graphical User Interface features ................................................................................................. 42

Chapter 4: Configuring Machines’ Hardware for Wake-on-LAN .................................................... 93
  Setting up Machines’ BIOS ........................................................................................................... 93
  Configuring Machines’ Network Adapter ....................................................................................... 93

Chapter 5: Operating Remote Machines ........................................................................................ 100
  Shutting Down and Restarting Machines ...................................................................................... 100
  Waking Machines Up .................................................................................................................... 100
  Retrieving MAC Addresses .......................................................................................................... 100
  Switching Machines to Power Saving States ............................................................................... 100
  Sending Messages to Remote Machines ...................................................................................... 100
  Sessions Management on Remote Machines .............................................................................. 100
  Locking and Unlocking Input Devices on Remote Machines ..................................................... 100
  Overriding Operation Settings ...................................................................................................... 100
  Remote Agent Management ......................................................................................................... 100

Chapter 6: Tasks and Schedule ..................................................................................................... 132
  Creating Tasks ............................................................................................................................. 132
  Scheduling Tasks ........................................................................................................................ 132
  Configuring Recurrence .............................................................................................................. 132
  Task Execution Confirmations ..................................................................................................... 132
  Importing and Exporting Tasks ................................................................................................... 132
  Notification E-mails ..................................................................................................................... 132

Chapter 7: Network Management .................................................................................................. 146
  Configuring Machines to allow remote access ............................................................................ 146
  Network Enumeration .................................................................................................................. 146
  Collections .................................................................................................................................... 146
  Credentials .................................................................................................................................... 146
  Defining Machines to Operate ..................................................................................................... 146
  Remote Machine Statuses ........................................................................................................... 146
  Network Objects Properties ......................................................................................................... 146
  Importing and Exporting Network ............................................................................................... 146

Chapter 8: Operations' Execution Results ..................................................................................... 194
  Analyzing Execution Results ........................................................................................................ 194
  Exporting Execution Results ......................................................................................................... 194
  Execution Results on the Web ........................................................................................................ 194
  Analyzing Log ............................................................................................................................... 194
  Exporting Log ............................................................................................................................... 194

Chapter 9: Program Preferences .................................................................................................... 207
  Remote Shutdown Part .................................................................................................................. 207
  Tasks and Schedule Part .............................................................................................................. 207
  Miscellaneous Part ....................................................................................................................... 207
**Chapter 10: Evaluation of the Program** ....................................................................................................................................................................................................................... 246
  Evaluation Wizard ......................................................................................................................................................................................................................... 246
  Where can I get my License Code? ..................................................................................................................................................................................................................... 246
  How should I formulate the Extended License request? ..................................................................................................................................................................................................................... 246

**Chapter 11: Program Updates** ..................................................................................................................................................................................................................... 252
  Live Update ..................................................................................................................................................................................................................... 252
  Major Update ..................................................................................................................................................................................................................... 252

**Chapter 12: Main Program Actions** ..................................................................................................................................................................................................................... 255
  Home Ribbon Page ..................................................................................................................................................................................................................... 255
  Remote Actions Ribbon Page ..................................................................................................................................................................................................................... 255
  View Ribbon Page ..................................................................................................................................................................................................................... 255
  Program Ribbon Page ..................................................................................................................................................................................................................... 255
  Network Tools Category ..................................................................................................................................................................................................................... 255
  Tasks and Schedule Tools Category ..................................................................................................................................................................................................................... 255
  Execution Results Tools Category ..................................................................................................................................................................................................................... 255

**Chapter 13: Remote Shutdown Client-Server Concept** ..................................................................................................................................................................................................................... 270

**Chapter 14: Access Control** ..................................................................................................................................................................................................................... 272

**Chapter 15: Notification Center** ..................................................................................................................................................................................................................... 274

**Chapter 16: Requirements** ..................................................................................................................................................................................................................... 275

**Chapter 17: How can I leave my Feedback?** ..................................................................................................................................................................................................................... 277

**Chapter 18: About EMCO Software** ..................................................................................................................................................................................................................... 279

**Chapter 19: Contact Information** ..................................................................................................................................................................................................................... 281
Chapter 1: Introduction

Welcome to EMCO Remote Shutdown. You have chosen the product that will help you to manage network PCs remotely so that you can turn remote PCs on and off, reboot and perform other operations. This manual provides you with detailed information on all of the program features.

Getting Help

If you face a problem, it makes sense to check the errors reported in the Execution Results and Log views. If the problem can be resolved by a user, the error description in the log includes troubleshooting information, so you can follow the suggestions to resolve the problem. In other cases, you may contact the support team at https://emcosoftware.com/support.

To get help on the problem, you need to provide the support team with the problem details. For example, you can send them the error notification you received and describe the steps you had performed before getting this error. Provide the support team with all the available information regarding the problem to speed up the problem reproduction and troubleshooting.
Chapter 2: Getting Started

EMCO Remote Shutdown is a program that allows you to manage Windows PCs from a central location across a local network. Using the program, you can turn on and off network PCs and perform other operations with one or multiple remote computers on demand and automatically on schedule. The program allows you to execute the following operations remotely:

- Shut Down, Wake-on-LAN, Restart, Hibernate, Sleep;
- Sign Out, Lock Session;
- Lock Input Devices, Unlock Input Devices;
- Send a Message.

EMCO Remote Shutdown is a solution suitable for all types of Windows networks. It is designed to automate remote operations and allows you to manage any number of network PCs with a few mouse clicks. The following features of the program help you to manage PCs remotely:

- **Working in Windows domains and workgroups.** The program can work in networks of any complexity. You can manage PCs located in workgroups and domains. Configurations including multiple domains and workgroups are also supported.

- **No manual agent installation is required.** You do not need to install anything manually on remote PCs. The program automatically installs and uninstalls agents remotely. To use the program, you just need to have administrative rights on remote PCs.
• **Managing an unlimited number of PCs in a single operation.** Do you need to shut down or wake up thousands of PCs? No problem! Configure a remote operation and run it within seconds. The program is designed to manage a large number of remote PCs simultaneously.

• **Running operations on demand and on schedule.** You can execute operations on demand by initiating them manually. You can schedule operations for an automatic execution at a defined date/time. The program can automatically repeat scheduled operations on a regular basis, for example, every day, every week, etc.

• **Managing static and dynamic groups of PCs.** Remote operations can be executed for PCs configured statically or dynamically. You can specify a static list of PCs or define queries and filters that select required PCs that meet certain conditions.

• **Reports and notifications for every operation.** For every executed operation, you can see a detailed report with information on the execution status for every targeted PC. The reports are displayed in the program, are available through the web and can be sent in e-mail notifications.

• **Client/Server architecture with concurrent access to a server.** The program works as client/server. The server part executes all operations and stores the configuration, tasks and other information. It accepts multiple concurrent connections of clients used to manage data and execute operations. All clients share the same data by connecting to the server through a LAN or the Internet.

In the following chapters, you will get a quick overview of the main features of the program. You will learn how the program works, how to scan a network to discover available PCs, how to run a remote operation and check its execution results. You will also learn how to work effectively by creating tasks, scheduling them for an automatic execution and managing dynamic groups of target PCs.
How the Program Works

EMCO Remote Shutdown Enterprise consist of two parts: a client and a server. The server works as a Windows service and is responsible for executing remote operations, storing data and sending notifications. If you log off from Windows or reboot a PC, it will continue working and executing scheduled operations. The client part is a Windows application that shows a GUI and allows a user to work with a server. The client is used to configure and initiate operations, review their results, manage schedules, etc.

Multiple clients may work with a server concurrently and use shared data. The program supports local and remote connections to a server, and the number of connected clients is not limited. You can install as many clients as needed, so they can connect to a server locally or remotely through a LAN/WAN/VPN.
The program allows you to manage computers across your network. So how does it work? In the program, you can select the required operation to be executed on remote PCs, configure its options and specify the PCs where the operation should be executed. For example, you can shut down remote PCs, send messages to remote PCs, wake up PCs, or execute any other supported operation. The list of options depends on the operation. The shutdown operation, for example, allows you to display a shutdown message to users, specify the shutdown timeout, or allow a user to cancel the operation. Other operations have different options, so you can access those options when configuring an operation in the program. You will see how it works in practice in the Configuring and Executing Remote Operations chapter.

Pic 1. Shutdown options
A remote operation can be executed on a single PC or multiple remote PCs simultaneously. The program is designed to work effectively in large networks, so any operation can be executed with a few mouse clicks across the entire corporate network. The program supports multiple ways of selecting the PCs where an operation should be executed. The easiest way is to select the target PCs manually. This works well in a small network, but is not convenient for corporate networks. In large networks, you can enter conditions to select target PCs automatically. For example, you can specify a condition to select all PCs from a specific Organizational Unit in Active Directory. You can learn more about this in the Working Effectively with Collections and Dynamic Targets chapter.

Pic 2. Target PCs configuration
The configured operations can be executed right away or scheduled for an automatic execution on a specified date and time. For example, you can create a task to shut down a specific PC tomorrow at 7pm. The program has a full-featured scheduler that allows you to create schedules of any complexity. You can schedule operations for a one-time or recurrent execution [Pic 3]. You will learn more about this in the Creating Tasks and Schedules chapter.

Pic 3. Execution schedule
Remote operations are executed by EMCO Remote Shutdown server. It communicates with the target PCs at the defined execution time and executes the configured operation with the defined options. When the server communicates with a target PC for the first time, it automatically installs an EMCO Remote Shutdown agent, then sends a command to the agent to execute the remote operation. When you need to execute another operation on the same PC, it already has the agent installed, so the remote operation will be executed immediately.

When a remote operation is executed, the server checks its execution status on every target PC. For example, for a wake-up operation, the server checks that the target PCs are actually turned on and reports statuses for every target PC [Pic 4]. You can see this information in the Execution Results view.

![Pic 4. Execution results](image)

If you manage large networks that include hundreds or thousands of PCs, you may need to execute different operations on the same PCs. You can save time needed to configure operation targets by creating reusable collections of PCs. You can configure a collection once and then execute different operations for it with a single mouse click. You can see how it works in the Working Effectively with Collections and Dynamic Targets chapter.
Configuring the Program and Network Environment

To manage computers remotely, you need to have Windows administrative permissions on those PCs. The program automatically installs an agent on the managed PCs through the network, so you need to have administrative permissions to be able to install and uninstall the agent remotely, to interact with the agent and to get required information from remote PCs. When you start the program for the first time, Initial Configuration Wizard is displayed asking you to specify the administrative credentials. If you work in a domain, you should enter the domain administrator credentials there. If you work in a workgroup, you should enter the credentials of a user that has the administrative credentials on all computers in the workgroup.

Pic 1. Credentials configuration in Initial Configuration Wizard
The entered credentials are securely saved in the program and are used to access remote PCs. You can change the credentials in the **Credentials** view. For example, if you have multiple domains in your network, you can specify different administrative credentials to access different domains in the **Credentials** view. You can also specify different credentials to access, for example, workgroup PCs if they use different administrative accounts [Pic 2].

![Credentials configuration in the Credentials view](image)

The program uses the standard Microsoft networking services to communicate with remote PCs. If you use the default Windows configuration, you do not need to apply any changes to your configuration. Make sure that your network is configured to satisfy the **requirements**. The required services must be started on the server and remote PCs, and the required ports must be opened. If you would like to install the program server and clients on different computers to connect remotely, make sure that the 48014 and 48015 ports are opened in the firewall on the computer where the server is installed.

If you plan to use the Wake-on-LAN operation, you need to make sure that Wake-on-LAN is enabled in the BIOS, and the network card settings on the remote PCs and, depending on your network structure, your routers are properly configured to transmit WOL packets. You can learn more on this topic in the **Using Wake-on-LAN to Wake Up Computers** chapter.
Local, Remote and Web Access to the Program

The Enterprise edition of the program works as client/server and allows for an unlimited number of local and remote concurrent connections to the same server. You can install multiple clients on different PCs and connect to the server through a LAN/WAN/VPN.

When running a client, you should specify if you would like to connect to a server installed locally or remotely [Pic 1]. If you wish to connect to a remote server, you should enter its host name or IP address. The server requires the user authentication, so when using the default settings, you need to specify a Windows account that is a member of the Administrators group on the PC where the server is installed. If your account satisfies this condition, you can enable the **Use Windows session credentials** option and skip entering the username and password.

[Pic 1. The server connection dialog]

When using the default settings of the program, you should use a Windows account that is a member of the Administrators group to connect to the server. If required, you can change the access permissions in the **Access Control** view of the program [Pic 2]. There you can manage roles and their privileges and assign those roles to Windows users and groups. This allows you to organize flexible management of permissions. For example, using roles, you can provide an administrative access with all permissions to some users, a read-only access to other users, and a restricted access to still other users. Learn more about using roles and permissions in the **Access Control** chapter.

[Pic 2. Configuring roles and permissions]
The program uses secure communication between the client and the server, so all the data traffic is encrypted. By default, the program deploys a self-signed SSL certificate, and you get a warning that the certificate used is not trusted when you connect to the server. If you have a SSL certificate, it is recommended to specify it in the program preferences to validate the identity of the server when connecting to it remotely.

You can access the execution results of remote operations through the web, so you can see this data anytime and from any location [Pic 3]. The program uses Microsoft IIS to deploy the web infrastructure. If you choose to deploy web components, the program installation automatically configures Microsoft IIS, so you can access the execution results in a browser.

![Pic 3. Web access to execution results](image)

Web access to execution results allows you to check the execution status of remote operations through the web. For every operation, you can see the list of PCs where it was executed and the execution status for every PC. The available information is similar to information displayed in the **Execution Results** view in the GUI client.
Getting to Know the Program Interface

The graphical user interface of the program consists of multiple views with different functionalities. The main screen of the program is split into several areas where views are organized as tabs. If you wish, you can reorganize them by moving views to other areas, closing views and changing their order and layout. The program interface is flexible and allows you to change the layout according to your needs. In this chapter, you can get an overview of the program views available in the default layout Pic 1.

Pic 1. The main program window
EMCO Remote Shutdown uses a Ribbon UI that represents all main actions as the Ribbon menu located at the top of the main screen. Different types of actions are grouped into different Ribbon tabs, so you need to switch to the corresponding Ribbon tab to access a specific action. The Ribbon menu can also display highlighted contextual tabs with actions suitable for the currently selected element.

Under the Ribbon, on the left of the screen, you can find the Network view. It is used to display the network structure and the available remote PCs. In this view, you can also add and manage collections of network PCs. To configure a remote operation, you can select PCs or collections in this view and then select the required operation type, so the selected PCs will be configured as the operation targets. At the bottom of this view, you can find the Credentials tab, that allows you to access the Credentials view. In this view, you can configure the credentials that will be used to access domains, workgroups and network PCs. To manage remote PCs, you should specify administrative credentials there.

On the top right of the main screen, you can find the Tasks and Schedule view, which consists of several controls. At the top, you can see Calendar with Date Navigator, which are used to configure and browse the scheduled tasks. You can switch the calendar to show scheduled tasks for a specific date, week or month, as well as edit, move and delete tasks using the visual controls. On the right, you can see Machine Queue that displays target PCs of the selected task. If required, you can edit targets there. Under Calendar, you can see Tasks displaying already configured operations that can be executed without any additional configuration. Tasks lists the scheduled tasks displayed in Calendar and non-scheduled tasks that can be executed on demand.

At the bottom of the main screen, you can find a few other views displayed as tabs. The Execution Results view shows information about the executed remote operations. There you can see a list of executed operations with statuses for every target PC. The Log view shows the program logs used for troubleshooting. If the program detects any errors, you can find the error messages and the troubleshooting instructions there. The Access Control view allows managing roles and permissions of the program users. All currently running operations are displayed in the Operations view where you can review and manage them. Finally, the All Machines view lists all the PCs managed by the program. You can use this view to select target PCs and perform other operations that require selecting PCs.

More detailed information about the program views and other graphical user interface features is available in the Program Interface Overview chapter.
Enumerating a Network to Discover PCs

There are multiple ways for you to start using the program. If you manage a large network with hundreds or thousands of PCs, the best way to select target PCs for remote operations is writing a query able to report PCs dynamically during the operation execution. In this case, you can skip network enumeration and work with dynamic targets configured in collections. Proceed to the next chapters that explain how to configure remote operations, create and schedule tasks and use dynamic targets for remote operations.

If you work in a relatively small network or would like to be able to select PCs where remote operations should be executed manually, you need to scan the network to detect available PCs. To start network enumeration, press the **Enumerate Machines** button on Ribbon or select this action in the context menu of the **Network** view. **Enumerate Machines Wizard** is opened where, after the welcome screen, you should proceed to the next step. The program offers multiple ways for you to add remote machines to the program. You can scan the network to automatically discover all available domains and workgroups as well as hosts they include. Alternatively, you can add machines by an IP range or import data from a file.

![Enumerate Machines Wizard](image)

**Pic 1. Network enumeration options**
Select the network scanning option, then the network enumeration scope on the next page of the wizard. By default, the program enumerates all discovered domains and workgroups to detect the PCs that they include. If you plan to manage the whole network, which is the best option, all the network machines will be added to the program. If you plan to manage only a specific domain or workgroup, or only a group of machines, adding all network machines into the program does not make sense. In this case, choose the **Enumerate Selected Groups** option and select the domains and workgroups that you plan to manage [Pic 2].
As it has been mentioned above, if you need to manage only a group of machines in a selected workgroup or domain, adding all machines from the selected workgroup or domain into the program does not make sense. In this case, you can specify a filter that allows selecting the required machines. Select a workgroup or a domain to enumerate; then click the **Edit Filter** button on the toolbar to specify the filter conditions. Click the plus button to enter a new condition  

![Pic 3. Enumeration filter conditions](image)

Using a filter, you can discover machines that satisfy the entered conditions and add them to the program. For example, you can add PCs that belong to a specific container in Active Directory or PCs that have specific names or PCs where last logon names match the entered criteria.

After selecting the required options in **Enumerate Machines Wizard**, you can press the **Finish** button to start enumeration. As a result, the discovered machines will appear in the **Network** view. You can see the enumeration status in the **Log** view. If some workgroups or domains cannot be enumerated, you will find detailed error messages there and be able to take the required actions to resolve the reported problems.

Note that machines in workgroups are reported by Windows and can be discovered by the program only if they are turned on, so make sure that all the PCs are turned on before starting enumeration. Machines in domains are always reported by Active Directory, so it does not matter if they are turned on or off during network enumeration.
Configuring and Executing Remote Operations

To execute a remote operation using the program, you should select the operation you need to execute and configure its options and target PCs, i.e. the PCs where the operation should be executed. The most time-consuming part of configuring a remote operation is the configuring of target PCs, especially if you need to execute the operation on a large number of PCs. To simplify the operation configuring, the program offers multiple ways of configuring the operation targets.

If you have previously enumerated the network and can see the network structure in the Network view, the simplest way to execute a remote operation starts from selecting target PCs in the tree. It works well if you need to execute an operation on only a few remote PCs. Select those PCs, then choose the required operation in the context menu or by clicking the corresponding button on Ribbon Pic 1.

Pic 1. Selecting a remote operation
When a remote operation has been selected, the program displays the wizard that allows you to configure the operation options. In the first step of the wizard, you can see the options of the selected operation. Different types of operations include different options. For example, for a shutdown operation, you can configure the reason for a shutdown, which will be logged on remote PCs, enter a custom comment, specify a timeout and a message to users to be displayed on remote PCs before shutdown, etc [Pic 2].

![Pic 2. Shutdown options configuration](image-url)

When a remote operation has been selected, the program displays the wizard that allows you to configure the operation options. In the first step of the wizard, you can see the options of the selected operation. Different types of operations include different options. For example, for a shutdown operation, you can configure the reason for a shutdown, which will be logged on remote PCs, enter a custom comment, specify a timeout and a message to users to be displayed on remote PCs before shutdown, etc [Pic 2].

![Pic 2. Shutdown options configuration](image-url)
Once you have configured the options of a remote operation, you can proceed to the next step of the wizard and specify the operation targets, i.e. network PCs where the operation will be executed. If you select PCs in the network tree as we did in the previous steps, you can see that Machine Queue is already preconfigured. Expand the **Selected Machines** node to make sure that the selected PCs are displayed under **Static Machines** [Pic 3].

![Machine Queue configuration](image)

**Pic 3. Machine Queue configuration**
In this step, you can add or remove PCs to/from Machine Queue if required. Select Edit in the context menu of the **Selected Machines** or press the **Edit** button on the toolbar. In the opened dialog, you can add or remove PCs where the operation should be executed (Pic 4).

Pic 4. Editing the target machines
To execute a configured remote operation, press the **Finish** button in the wizard, and the operation will start being executed on target PCs. You can see the execution progress in the **Operations** view. Once the operation has been executed, you can check its execution status. Switch to the **Execution Results** view, find the executed operation and expand the corresponding node to see the execution results for every target PC [Pic. 5]. If execution fails for some PCs, you can see the error messages and information about the problem cause. So resolve the problem and repeat the operation.

![Execution Results](image)

**Pic 5. The operation execution results**

In this chapter, we have tried the simplest way of configuring and executing a remote operation by selecting the operation targets manually in the program. In the Working Effectively with Collections and Dynamic Targets chapter, you can see other approaches to configuring target PCs. Besides, if you need to repeat the same operation multiple times, you can create a preconfigured task. You can schedule tasks for automatic execution at a defined date/time. These topics are explained in the Creating Tasks and Schedules chapter.
Remote Operations Overview

In the previous chapter, you could see how to execute a shutdown operation remotely. Beyond that, the program supports many remote operation types, and every operation has own configuration options. Below you can see a quick overview of the supported remote operations.

Power Management Operations

These operations allow you to control the state of remote PCs.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Shut Down</strong></td>
<td>It allows executing the Windows shutdown operation on network PCs. You can select the reason for the shutdown operation, which will be logged in Windows. If required, you can configure the program to display a message before shutting down. You can also specify a shutdown timeout and allow the users working on the PCs to cancel the shutdown.</td>
</tr>
<tr>
<td><strong>Wake on LAN</strong></td>
<td>This operation allows you to wake up network PCs using the Wake-on-LAN technology. You can specify a port configured to receive WOL packets and configure the WOL transmission methods. This operation is explained in the Using Wake-on-LAN to Wake Up Computers chapter.</td>
</tr>
<tr>
<td><strong>Restart</strong></td>
<td>Using this operation, you can restart remote PCs. You can specify the reason for restart. This reason is logged by Windows. You can also show a message before restart and specify a timeout before restart. You can allow users working on target PCs to cancel the restart operation.</td>
</tr>
<tr>
<td><strong>Hibernate</strong></td>
<td>You can hibernate Windows remotely using this operation. You can show a message to the users before hibernation and allow the users to cancel the hibernation.</td>
</tr>
<tr>
<td><strong>Sleep</strong></td>
<td>Using this operation, you can switch Windows to the sleep mode. You can configure the operation to show a message to the users and allow the users to cancel the operation.</td>
</tr>
</tbody>
</table>

Administrative Operations

These operations allow you to execute specific actions on network PCs.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retrieve MAC Address</strong></td>
<td>Using this operation, you can get the MAC addresses of the network cards from remote PCs. The retrieved MAC addresses are used to perform a Wake-on-LAN operation. The program allows retrieving MAC addresses using various methods.</td>
</tr>
<tr>
<td><strong>Send Message</strong></td>
<td>Using this operation, you can display a Windows dialog with a custom message on remote PCs. You can configure the message text and specify for how long it should be displayed.</td>
</tr>
</tbody>
</table>

Session Management Operations

These operations allow you to manage user sessions on remote PCs.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sign Out</strong></td>
<td>It allows you to log off currently logged-on users from Windows remotely. You can display a message to the users and allow the users to cancel the operation. You can also enable termination of the currently running programs.</td>
</tr>
<tr>
<td><strong>Lock Session</strong></td>
<td>This operation allows you to lock the current Windows session remotely. You can display a message to the users and allow the users to cancel the operation.</td>
</tr>
</tbody>
</table>
Input Devices Management Operations

These operations allow locking and unlocking input devices remotely.

| Lock Devices | Using this operation, you can lock input devices (the keyboard and the mouse) remotely. You can display a message to the users before executing the operation and allow the users to cancel the operation. |
| Unlock Devices | This operation allows unlocking previously locked input devices (the keyboard and the mouse). You can display a message to the users before executing the operation and allow the users to cancel the operation. |

Using Wake-on-LAN to Wake Up Computers

In the previous chapters, you could see how to configure and execute operations remotely. You can use the same principles to configure and execute different operations. However, Wake-on-LAN is a specific operation because it is based on using the hardware technology to wake up computers, so it has a few specific requirements. In this chapter, you can see how to configure and use Wake-on-LAN.

Wake-on-LAN (WOL) is a technology supported by hardware that allows waking up computers by sending a specific network packet to them. To uniquely identify the target computer, a sender uses the unique MAC address of the network card of the receiver. Besides, to wake up a computer, the receiver should listen to network packets, so the network card should be turned on even if you turn the computer off. It means that to use the Wake-on-LAN technology, the computer you need to wake up should be configured to enable WOL.

If you plan to use Wake-on-LAN, you need to enable it on the remote computers by following these steps:

- Enable Wake-on-LAN in the BIOS settings;
- Enable Wake-on-LAN in the network card configuration in Windows.

You can find detailed instructions for enabling Wake-on-LAN in the Configuring Machines’ hardware for Wake-on-LAN chapter.

In addition, to use Wake-on-LAN, the program should know the MAC addresses of remote PCs to generate individual WOL packets for them. The program can detect MAC addresses in multiple ways:

1. MAC addresses for remote PCs are detected automatically during the network enumeration. Check the Execution Results view after the network enumeration to make sure that MAC addresses of the network PCs have been detected successfully. Note that for extracting a MAC address, a remote PC should be turned on during the network enumeration. If a PC was turned off, you can run the Retrieve MAC Address operation to get the MAC addresses. Switch to the All Machines view to see the PCs from which a MAC address has not been extracted and run Retrieve MAC Address.

2. If you use Microsoft DHCP in your network, you can extract MAC addresses for all the network computers. Open the MAC Addresses Scan page of the program preferences to enable and check the DHCP servers configuration. Once DHCP is configured, it will be able report MAC addresses during Retrieve MAC Address operations.
Before executing a Wake-on-LAN operation, make sure that the program knows MAC addresses of the remote PCs. Switch to the **All Machines** view to make sure that all the PCs have reported their MAC entries [Pic 1]. It is preferable to extract MAC addresses from Microsoft DHCP, because in this case the program can get MAC addresses of all the PCs in your network automatically. Microsoft DHCP reports MAC addresses of all PCs regardless of their current state (turned on or off), so if you have configured the program to use Microsoft DHCP, you can execute Wake-on-LAN operations immediately for any set of remote PCs, including collections and dynamic groups.

![All Machines View](image)

**Pic 1. Reported MAC addresses**
If you do not use Microsoft DHCP, you need to extract MAC addresses for all target PCs first to use Wake-on-LAN. As explained above, most MAC detection methods work only when the PCs are turned on, so turn the remote PCs on and extract their MAC addresses. Make sure that you have extracted MAC addresses for all the PCs by checking the data in the All Machines view. See the MAC Address Retrieving Methods chapter for details.

Finally, to send a WOL packet to remote PCs, you need to configure the correct WOL transmission method in the program depending on your network configuration. The program supports different transmission methods that can be configured on the WOL Configuration page of the program preferences. You can learn more about these methods in the WOL Packets Transmission Methods chapter.

Once you have enabled WOL on remote PCs, extracted MAC addresses for remote PCs and configured the WOL transmission method for your network, you can execute a Wake-on-LAN operation in the program. It can be configured similarly to other operations, so you need to configure the operation options and the target computers. Check the execution status in the Execution Results view. If the PCs cannot be turned on, make sure that the Wake-on-LAN requirements explained above are satisfied.
Working Effectively with Collections and Dynamic Targets

Configuring the target PCs is the most time-consuming part of the remote operation configuration. You can save time by using collections, which define a preconfigured set of PCs, so you can configure them once and then use in remote operations.

Let's see how collections work. To create a collection, right-click on the Collections item in the Network view and select New Collection in the context menu. The collection configuration consists of multiple tabs. On the Properties tab, you can specify a name and a comment.

![Pic 1. Collection properties]
To configure the PCs to be included into the collection, you need to switch to the Members tab. On the left of the screen in the Available Sources view, select the PCs that you would like to add to the collection and press the Move to Collection button to move them to the Collection Members view displayed on the right. The added computers are displayed under the Static Machines node [Pic 2].

Pic 2. Configuring the collection members
Once you have configured the collection members, you can press the **Save** button in the dialog to create a collection, and it will appear in the **Network** view under the **Collections** node. Now you can select the collection, choose the required operation in the context menu and execute it. The target PCs for the remote operation will be the same as configured in the collection.

As you can see, using collections simplifies configuration of remote operations significantly. You can configure a collection once and then use it in remote operations. Now, what do you do if you need to work with a dynamic set of computers? For example, you need to execute a remote operation on all computers that belong to a specific organizational unit of Active Directory. You can also use a collection in this case since collections can work with dynamic group of computers, too.

Let's create a new collection to manage a dynamic group of computers. After configuring the collection properties, in the second step of the collection configuration wizard, we can click the **Add Machine Queries** link to configure the queries that will report dynamic computers. In the opened dialog we need to specify a query name, select a domain or a workgroup where the query will be executed and define a condition for selecting target PCs. **Pic 3.**

![Pic 3. Configuring a query](image-url)
A configured query will appear under the **Machine Queries** node of the **Collection Members** view. If required, you can edit it or add a new query. A collection may have a complex configuration including static machines and multiple queries. To check what PCs are reported by a query, switch to the **Machines Preview** tab of the collection and click the **Preview** button. As a result, the program will run queries, combine their results with the static computers and list the PCs that will be reported by the collection, so you can make sure that your configuration is correct. 

![Collection Preview](Image)
In addition to **Static Machines** and **Machine Queries**, a collection can also include a **Filters** configuration. A filter allows you to filter out computers reported by **Static Machines** and **Machine Queries** if they do not satisfy a defined condition. For example, you can define a filter that reports only PCs running a specific version of Windows [Pic 5].

![Pic 5. Filter configuration in a collection](image)

Just to summarize the above, a collection defines a group of target PCs that can be configured using the following objects:

- A set of static Machines that you can select in the UI.
- A set of Machine Queries. A query is a logical condition that allows selecting the required PCs from a workgroup/domain based on the PC names and names of the organizational units where such PCs are located.
- A Filter used to filter out the PCs reported by Machine Queries and static Machine definitions. In the Filter, you can use logical conditions that operate with the OS information of remote PCs.

As you can see, you can combine configurations of static Machines, Machine Queries and Filters to create configurations of any complexity. More detailed information on this topic is available in the **Collections** chapter. Read it to learn how to preview collection results, use collection snapshots and familiarize yourself with other advanced features.
Creating Tasks and Schedules

In the previous chapter, you could learn how to create reusable collections to simplify configuration of target PCs in remote operations. It showed how to configure and run an operation with just a few clicks. Nevertheless, you still need to configure the options of remote operations every time you configure a new operation. If you need to repeat the same operation with the same options and the same targets, you can create a task and execute it with just a single click.

Tasks can be managed in the Tasks and Schedule view. It consists of a calendar located at the top and a list of tasks located at the bottom. Right-click the Tasks area located at the bottom and select New Task in the popped up context menu. You need to select an operation for the created task, for example, select Shut Down. In the first step of the task configuration, you need to specify the task name and fill the optional comment and description fields [Pic 1].

![Pic 1. Common task information](image-url)
In the second step of the task configuration wizard, you need to configure the selected remote operation. The available options are identical to those of the shutdown configuration we used earlier, so configure the required options. 

Pic 2. Shutdown options configuration in a task
When executing a task, you can be notified of the execution results for every remote PC. If you have configured the e-mail and notification settings in Preferences, you will get an e-mail notification of the task execution. You can override the global notification settings, if required, on the E-Mail Notifications tab of the task's configuration.

In the final step of the task configuration, you need to configure the task's Machine Queue, i.e. its execution targets. Click the Link button and choose a collection in the popped up menu that should be used to select target PCs. If you do not have a collection, you can create one.

![Image of task configuration](image-url)

**Pic 3. Target configuration of a task**
Once the targets have been configured, you can click the **Create** button to create a task. As a result, it appears in the **Tasks** area. To execute a task, select it and choose **Run** in the context menu. There are two options available: you can execute it for all machines or only for the machines where the previous execution failed **Pic 4**.

![Pic 4. Task execution options](image)

The tasks displayed in the **Tasks** area can be executed with a single mouse click, but they should be initiated by the program user. If you need to execute tasks automatically at a defined date and time, you may create scheduled tasks. There are two types of scheduled tasks available:

- Scheduled one-time tasks that will be executed once at a defined date and time;
- Scheduled recurring tasks that will be executed on a regular basis, for example, every Monday at 9am.
To create a scheduled task, right-click the calendar and select the required type for the task. Select the **New Task** option if you plan to create a scheduled task for one-time execution. To create a scheduled recurrent task, select the **New Recurring Task** option.

![Creating a scheduled task](Image)

**Pic 5. Creating a scheduled task**
When creating a task, you need to select its type. Once the type is selected, the program shows the scheduled task configuration wizard. It is different for one-time and recurring tasks. For a one-time task, you need to specify a date and time when the task should be executed (Pic 6).

![Pic 6. Configuring execution data for a scheduled task](image-url)
If you create a recurring task, you need to configure its recurrence options. You can execute a task on a daily, weekly, monthly and yearly basis and specify other available options [Pic 7].

After configuring the scheduling settings, you need to configure the operation options and targets. These steps are identical to the steps explained earlier. Once a task is created, it appears on the calendar. You can browse daily, weekly, monthly views of the calendar to see all scheduled tasks. In the **Tasks and Schedule** chapter, you can learn how to edit the schedule, skip task occurrences and manage scheduled tasks. The scheduled tasks will be executed automatically at a defined date/time. If you have configured the notification and e-mail options in **Preferences**, you will get notifications about execution of the tasks by e-mail. The task execution result can also be seen in the **Execution Results** view.
Chapter 3: Program Interface Overview

Let's take a look at the program's main window to become familiar with the user interface. In the middle of the program's main window you can find the Welcome Screen and Tasks and Schedule views. The Task and Schedule view has several functionality areas Pic 1.

Pic 1. The program's main window
At the top of the main screen, you can find the **Ribbon bar** that provides access to the main program actions. It consists of four static pages together with several contextual pages, and you can switch between them to get access to different groups of actions.

The program is designed to work with remote PCs in the network. The hierarchical network structure is represented in the **Network view** located on the left of the main screen. It shows the available domains, workgroups, organization units and PCs. If you need to easily manage PCs that belong to different organization units or workgroups/domains, you can put them into **Collections** inside the **Collections** node. It allows you to regroup PCs according to your needs and launch group operations with a single click. The tabs at the bottom are used to switch between the **Network** view, which displays the network structure, and the **Credentials** view, which is intended to set up different credentials to access different network groups and PCs.

All tasks are shown in the **Tasks area** and the scheduled tasks are also present in the **Scheduling area**. The latter displays past and future tasks on the calendar according to their execution date and time. You can switch between dates using the **Date Navigator** pane located on the right. Also, you can scale and zoom the presentation area to display daily, weekly or monthly views and the timeline using the control bar at the bottom.

To manage tasks, you can select them in the **Tasks area** or the **Scheduling area**. When selecting a task, you can see a list of Collections describing a set of Machines where it will be executed on the **Machine Queue** pane. If required, you can add or remove Collections using the actions available on the pane's toolbar. Detailed information about the selected task is available on the **Task Details** pane. There, you can see the common task information and the task execution statistics. Information about the MAC addresses retrieved for the Machines is gathered within the **All Machines** view. Detailed results of each business operation over remote Machines are displayed in the **Execution Results** view. If you need the information about supplementary operations results and events taking place while running the program, you can find it in the **Log** view. In case of any errors, you should check the **Execution Results** and **Log** views because they contain important troubleshooting information.
Welcome Screen

The Welcome Screen is located right in the middle of the application main window and is intended to help you start working with Remote Shutdown Pic 1.

In the middle of the Welcome Screen, there are shortcut buttons that enable you to execute most commonly used actions. The buttons sequence is set in such a way as to help you understand the sequence of the steps to be performed to solve the tasks Remote Shutdown is designed for.

In the top right corner of the Welcome Screen, you can find the information area used to show you the tips that may be useful for you while using Remote Shutdown. If you find the displayed tip interesting, you may click it to get more information on the subject.

Finally, if you want to know more about EMCO Software, you can visit our web-site by clicking the company logo in the bottom left corner of the Welcome Screen.
Tasks and Schedule View

The **Tasks and Schedule** view is located at the very middle of the Remote Shutdown main screen and consists of five parts: the **Scheduling area A**, the **Tasks area B**, the **Machine Queue pane C** and the **Task Details pane D**.

In this chapter, you will be introduced to all these parts, which will make it easier for you to understand the concept of the **Tasks and Schedule** view and to get to know the set of available features better.
Tasks Area

The Tasks area [Pic 1] displays all the tasks created and scheduled within Remote Shutdown in form of a table. Using this area, you can create new tasks, schedule already created tasks, run the selected tasks, review their execution results and delete them when they are no longer needed.

You can drag Collections from the Network view and drop them on the Tasks area. You are offered to create a new task if Collections are dropped on an empty space. Collections dropped on a task are added to its Machine Queue. The same result can be achieved by using the Copy/Paste technique. It is also possible to drag/drop and copy/paste standalone Machines and Queries, whereas the embedded Collections containing those Machines and Queries will be created automatically.

By default, the Tasks area shows you the name of every task, the comment specified for it, its scheduling properties, last execution time, and last results, as well as the task type and scheduling state, both represented by icons. You can also make it display the column that shows each task's description by using the column chooser. It is possible to sort this view both by the text fields and the fields that represent the task type and state. Thus, you can configure the view layout in the way that is most convenient for your everyday work with Remote Shutdown. Detailed information on every task is available in the tool tip shown when you are hovering the mouse pointer over the row representing this task. The tasks that require additional configuration before being executed are highlighted.

[Pic 1. The Tasks area]

The state of every scheduled task can be seen in the Tasks area and is represented with a colored bell icon. This enables you to always see what is going to happen to each one of the scheduled tasks in future. Below you can see the meaning of each of the bell icons:

- The task has already been processed by the scheduling engine. It has either been executed or its execution has been skipped.
- The task is waiting for its execution time to come and will be executed as soon as the scheduled time comes.
- The task is either created in the past or moved to the past, and is processed according to the specified confirmations configuration.
- The task is the Past Task. It should have been executed on the schedule but the program was not running, so it is processed according to the specified confirmations configuration.
- The decision regarding the task execution was postponed by snooze when asked for the execution confirmation.

### Toolbar Overview

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Task</strong></td>
<td>The New Task button from the Tasks area toolbar can be used to create a new task to be executed in the future.</td>
</tr>
<tr>
<td><strong>Schedule Task</strong></td>
<td>The Schedule Task button from the Tasks area toolbar should be used to put the selected task on schedule.</td>
</tr>
<tr>
<td><strong>Run</strong></td>
<td>The Run button from the Tasks area toolbar can be used to execute the selected tasks immediately. You can execute the task either for all Machines from the Machine Queue or only for those not processed during the latest execution due to errors.</td>
</tr>
<tr>
<td><strong>Show Results</strong></td>
<td>The Show Results button from the Tasks area toolbar allows you to display the execution results for the selected tasks in the Execution Results view.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>The Edit button from the Tasks area toolbar allows you to edit the selected task.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>The Delete button from the Tasks area toolbar allows you to delete the selected tasks.</td>
</tr>
<tr>
<td><strong>Full Expand</strong></td>
<td>The Full Expand button should be used to expand all the grouping rows in the Tasks area.</td>
</tr>
<tr>
<td><strong>Full Collapse</strong></td>
<td>The Full Collapse button should be used to collapse all the grouping rows in the Tasks area.</td>
</tr>
<tr>
<td><strong>Group By Box</strong></td>
<td>The Group By Box button is used to display Group By Box for configuring data grouping within the Tasks area.</td>
</tr>
<tr>
<td><strong>Choose Columns</strong></td>
<td>The Choose Columns button should be used to choose the columns to be displayed in the Tasks area.</td>
</tr>
<tr>
<td><strong>Filter Editor</strong></td>
<td>The Filter Editor button should be used to define the custom filter criteria to be applied to the data displayed within the Tasks area.</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>By using the Configuration button, you can configure and reset the layout of the Tasks area.</td>
</tr>
</tbody>
</table>
You can create, edit, delete and execute tasks directly from the Tasks area using the buttons from the view toolbar. In addition to the options of creating a new task, opening an already existing task for edit, running a selected task, copying or deleting it, pasting a task from the clipboard or pasting Collections from the clipboard into the Machine Queue of an existing task is available in the pop-up menu of the Tasks area.

If you prefer to work with scheduled tasks only, you can collapse this area using a glyph on the area caption. You can also change the orientation between the Tasks area and the Scheduling area and switch their places using the Rotate Layout and Flip Layout items from the Group Layout pop-up of the Configuration menu.
Scheduling Area

The Scheduling area shows the scheduled Tasks on a timeline where the level of details depends on the chosen view and zoom factor. On the right of the Scheduling area you can find the Date Navigator pane that can be used for navigation within the Scheduling area. This chapter describes every view that can be chosen for the Scheduling area and their advantages, and provides you with an overview of the navigation features.

You can drag Collections from the Network view and drop them on the Scheduling area. You are offered to schedule a new task if Collections are dropped on an empty space. Collections dropped on a task are added to its Machine Queue. The same result can be achieved by using the Copy/Paste technique. It is also possible to drag/drop and copy/paste standalone Machines and Queries, whereas the embedded Collections containing those Machines and Queries will be created automatically.

Within the Scheduling area, you can see the name and state images for every task, and the task's location on the timeline shows its execution time. The state images allow you to see the type of each task, understand if the task is recurrent and if it should still be executed or has already been executed. Detailed information on every task is available in the tool tip shown when you are hovering the mouse pointer over this task in the Scheduling area.

The state of every task that is still unprocessed by the scheduling engine can be seen in the Scheduling area and is represented with a colored bell icon. Below, you can see the meaning of each of the bell icons:

- 🌞 - the task is waiting for its execution time to come and will be executed as soon as the scheduled time comes.
- 🌞 - the task is either created in the past or moved to the past and is processed according to the specified confirmations configuration.
- 🌞 - the task is a Past Task. It should have been executed on schedule but the program was not running, so it is processed according to the specified confirmations configuration.
- the decision regarding the task execution was postponed when asked for the execution confirmation.

**Toolbar Overview**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Task</strong></td>
<td>The <em>New Task</em> button from the <em>Scheduling</em> area toolbar can be used to create a new task and put it on schedule.</td>
</tr>
<tr>
<td><strong>New Recurring Task</strong></td>
<td>The <em>New Recurring Task</em> button from the <em>Scheduling</em> area toolbar can be used to create a new task to be executed recurrently.</td>
</tr>
<tr>
<td><strong>Run</strong></td>
<td>The <em>Run</em> button from the <em>Scheduling</em> area toolbar can be used to execute the selected tasks immediately. You can either execute the task for all Machines from the Machine Queue or only for those not processed during the latest execution due to errors.</td>
</tr>
<tr>
<td><strong>Show Results</strong></td>
<td>The <em>Show Results</em> button from the <em>Scheduling</em> area toolbar allows you to display the execution results for the selected tasks in the <em>Execution Results</em> view.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>The <em>Edit</em> button from the <em>Scheduling</em> area toolbar allows you to edit the selected task.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>The <em>Delete</em> button from the <em>Scheduling</em> area toolbar allows you to delete the selected tasks either from schedule or permanently.</td>
</tr>
<tr>
<td><strong>Backward</strong></td>
<td>The <em>Backward</em> button from the toolbar should be used to navigate backward in the currently selected view within the <em>Scheduling</em> area.</td>
</tr>
<tr>
<td><strong>Forward</strong></td>
<td>The <em>Forward</em> button from the toolbar should be used to navigate forward in the currently selected view within the <em>Scheduling</em> area.</td>
</tr>
<tr>
<td><strong>Today</strong></td>
<td>The <em>Today</em> button from the toolbar enables you to quickly navigate to the today’s date within the <em>Scheduling</em> area.</td>
</tr>
<tr>
<td><strong>Go to Date</strong></td>
<td>The <em>Go to Date</em> button from the toolbar should be used to navigate to a specific date within the <em>Scheduling</em> area.</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>By using the <em>Configuration</em> button, you can configure and reset the layout of the <em>Scheduling</em> area.</td>
</tr>
</tbody>
</table>

You can schedule new tasks, edit existing tasks, delete them from schedule, execute them and navigate within the *Scheduling* area using the toolbar. Besides, a quick access to the options of scheduling a new task, opening an already existing task for edit, running the selected task or deleting it from the schedule, pasting a task from the clipboard or pasting Collections from the clipboard into the Machine Queue of an existing task is available from the pop-up menu of the *Scheduling* area.
If you prefer to work with regular tasks only, you can collapse this area using a glyph on the area caption. You can also change the orientation between the Tasks area and the Scheduling area and switch their places using the Rotate Layout and Flip Layout items from the Group Layout pop-up of the Configuration menu.

Now that the Scheduling area is fully described, we will show you the range of the available views, and describe each view in details so that you can understand its concept and choose the views you feel comfortable with while using Remote Shutdown in your work.

### Scheduling area views

The Scheduling area can be displayed in different view modes giving you different levels of detail. You can choose among five views: Day View, Work Week View, Week View, Month View and Timeline View. The view chooser, along with the zooming editor, is located on the Tasks and Schedule contextual Ribbon page and in the main screen status bar next to the progress bar.

For the Day View and the Work Week View, it is possible to define additional time rulers showing the time for time zones that differ from the one set in the underlying operating system. To configure additional time rulers, you can either choose the Additional Time Rulers item from the Configuration menu on the toolbar or right-click the default time ruler and choose the Additional Time Rulers item from the pop-up menu. The Additional Time Rulers preference page will appear on the screen enabling you to configure the required time rulers.

Let us take a closer look at each view available for representation of the Scheduling area. Each view is designed to help you solve a specific problem without any difficulties.

#### Day

The Day button from the View Mode Ribbon group on the contextual Presentation page from the Tasks and Schedule Tools category and on the status bar should be used to switch the Scheduling area to the Day View. If the Day View is already chosen, this button is highlighted.

The Day View offers the most detailed picture of tasks during a single day or a couple of days. It displays tasks within vertical timelines where the task's topmost edge corresponds to its start time. The time ruler is displayed to the left of the Day View. If the day chosen in the Date Navigator pane is a part of a working week, the working hours are highlighted on the timeline. The timeline header is highlighted if the chosen day is the current date. The current time is marked with a stroke on the time ruler.
Scroll buttons displayed at the top or bottom of the time ruler indicate if additional tasks exist in any non-visible area of the Day View. Those buttons can be clicked to scroll to the next/previous tasks. If there are no tasks available on the current timeline, the **Next Task** and **Previous Task** buttons displayed on the timeline are used for navigation.

**Work Week**

The **Work Week** button from the **View Mode** Ribbon group on the contextual **Presentation** page from the **Tasks and Schedule Tools** category and on the status bar should be used to switch the **Scheduling** area to the Work Week View. If the Work Week View is already chosen, this button is highlighted.

The Work Week View is similar to the Day View and shows the days chosen as working days in the **Calendar Options**. The **Calendar Options** enables you to specify both the working days and the working hours; hence you can configure this view to fully fit your working schedule.
This view is specially designed for users who want to work with Remote Shutdown and see the same level of detail as for the Day View for the whole work week.

**Week**

The **Week** button from the **View Mode** Ribbon group on the contextual **Presentation** page from the **Tasks and Schedule Tools** category and on the status bar should be used to switch the **Scheduling** area to the Week View. If the Week View is already chosen, this button is highlighted.

The Week View displays tasks for any given weekly period. The start time is displayed using digits, and the current date is indicated by highlighting the corresponding date header.

![Pic 4. The Scheduling area in the Week View](image)
If there are any existing tasks that do not fit into the screen area, the down arrow button is displayed. Clicking this button switches the representation to the corresponding date in the Day View.

The **Month** button from the **View Mode** Ribbon group on the contextual **Presentation** page from the **Tasks and Schedule Tools** category and on the status bar should be used to switch the **Scheduling** area to the Month View. If the Month View is already chosen, this button is highlighted.

The Month View is designed to allow you to browse and analyze long-term plans. This view positions days one after another horizontally so that they constitute weeks, while individual weeks are placed one under another. The dates belonging to different months are automatically colored and the weekends are compressed. The start time is displayed using digits, and the current date is indicated by highlighting the corresponding date header.
If there are any existing tasks that do not fit into the screen area, the down arrow button is displayed. Clicking this button switches the representation to the corresponding date in the Day View.

**Timeline**

The **Timeline** button from the View Mode Ribbon group on the contextual **Presentation** page from the **Tasks and Schedule Tools** category and on the status bar should be used to switch the **Scheduling** area to the Timeline View. If the Timeline View is already chosen, this button is highlighted.

The Timeline View is the most customizable one. This view type arranges tasks on horizontal timelines representing the time scales chosen from the pop-up menu.

This view can be used to navigate throughout the **Scheduling** area without any limitations and change of the level of detail if needed.

**Navigation within the Scheduling area**

Remote Shutdown provides you with easy-to-use tools for navigating the **Scheduling** area. The **Navigation** group on the **Ribbon** bar contains actions that can help you to quickly navigate within the currently selected view. By using those actions, you can move forward, or backward, or jump to the today's date.

**Backward**

The **Backward** button from the **Navigation** Ribbon group on the contextual **Management** page from the **Tasks and Schedule Tools** category should be used to navigate backward in the currently selected view within the **Scheduling** area.

**Forward**

The **Forward** button from the **Navigation** Ribbon group on the contextual **Management** page from the **Tasks and Schedule Tools** category should be used to navigate forward in the currently selected view within the **Scheduling** area.
Today
The *Today* button from the *Navigation* Ribbon group on the contextual *Management* page from the *Tasks and Schedule Tools* category enables you to quickly navigate to the today's date within the *Scheduling* area.

Go to Date
The *Go to Date* button from the *Navigation* Ribbon group on the contextual *Management* page from the *Tasks and Schedule Tools* category should be used to navigate to a specific date within the *Scheduling* area.

Another noteworthy feature ensures that any required date chosen within the *Date Navigator* is also shown within the Scheduling area. Besides, when a range of dates is chosen within the date navigator, the view is automatically switched to the appropriate one to cover the chosen range of days. Furthermore, in each view you can jump to any date using the *Go to Date* option from the pop-up menu.

**Grouping by Type and Date**

The tasks displayed in the *Scheduling* area can be grouped by type or by date enabling you to manage only the tasks of a certain type. You can increase or decrease the number of the visible task types and navigate through the visible task types using the navigator in the bottom right corner of the *Scheduling* area next to the scroll bar.

![The Scheduling area grouped by task type](image)

The grouping options should be configured on the *Scheduler Configuration* preference page.
Date Navigator

The Date Navigator pane is displayed in the right of the Scheduling area. It should be used to select the dates to be displayed within the Scheduling area. The view type used for the Scheduling area is automatically adjusted to accommodate to the dates selected in the Date Navigator pane.

![Pic 1. The Date Navigator pane](image)

The Date Navigator can be configured to help you find scheduled tasks and perform weekly planning.

💡 It is possible to drag a task from the Scheduling area and drop it on any date in the Date Navigator to schedule that task or its copy on that date.

You can configure the view to display the dates with tasks in bold font, and turn on the week numbering on the Calendar Options preference page.
Machine Queue Pane

The **Machine Queue** pane is displayed on the right of the **Tasks and Schedule** view. It displays the Collections from the **Machine Queue** of the task selected within the **Scheduling** area or the **Tasks** area. You can add Collections to the task's Machine Queue and remove them anytime you want.

You can drag Collections from the **Network** view and drop them on the **Machine Queue** pane – the Collections dropped are added to the task's Machine Queue. The same result can be achieved using the Copy/Paste technique. Besides, you can drag/drop and copy/paste standalone Machines and Queries. In case Machines and Queries are dropped/pasted to a Collection, they are added to that collection, otherwise embedded Collections containing those entries are created within the Machine Queue.

The **Machine Queue** pane allows you to review and edit the Machine Queue for particular tasks quickly and easily while navigating between the tasks.

![Machine Queue pane](image)

By default, the Machine Queue tree displays only a limited number of available properties for every item, but you can also add columns that display other properties using the **column chooser**. Do not hesitate to change the visible columns and the filtering principles the way you want. By the way, you can always reset the view layout to the default settings using the **Reset Layout** command from the view menu.

Toolbar Overview

- **Link**
  - The **Link** button from the **Machine Queue** pane toolbar can be used to add Collections from those defined in the program scope to the currently displayed Machine Queue.

- **Edit**
  - The **Edit** button from the **Machine Queue** pane toolbar allows you to edit the selected object.
Delete
The **Delete** button from the **Machine Queue** pane toolbar can be used to delete the selected Collections from the currently displayed Machine Queue or the selected members from the parent Collection.

Full Expand
The **Full Expand** button should be used to expand all nodes in the **Machine Queue** pane.

Full Collapse
The **Full Collapse** button should be used to collapse all nodes in the **Machine Queue** pane.

Choose Columns
The **Choose Columns** button should be used to choose the columns to be displayed in the **Machine Queue** pane.

Filter Editor
The **Filter Editor** button should be used to define the custom filter criteria to be applied to the data displayed within the **Machine Queue** pane.

Configuration
By using the **Configuration** button, you can configure and reset the layout of the **Machine Queue** pane.

For Collections and Queries the **Machine Queue** pane allows to preview the filter conditions without editing those collections and queries. It can be done by enabling the **Show Details** option from the **Configuration** menu. When it is enabled, there is an additional preview row under each node representing a Collection or a Machine Query. From this preview, you can see if there is any condition defined, and if there is one, expand it to review the condition using the arrow on the right.

**Link Collection**
The **Link Collection** button from the **Machine Queue** Ribbon group on the contextual **Management** page from the **Tasks and Schedule Tools** category allows you to add Collections from those defined in the program scope to the currently displayed Machine Queue.

Within the **Machine Queue** pane, it is possible to add the existing Collections defined in the program scope to the displayed Machine Queue, create embedded Collections within the Machine Queue, delete Collections from the Machine Queue, change the properties of any Collection, Query and Machine, etc. All those options are available on the Machine Queue pane toolbar. Those actions, together with collections copying and pasting, are also available in the pop-up menu of the **Machine Queue** pane. The action for adding Collections to **Machine Queue** is also available in the **Machine Queue** Ribbon group on the contextual **Management** page from the **Tasks and Schedule Tools** category. As for the actions for editing item properties and removing collections from the Machine Queue, you can find the **Edit** and **Delete** buttons in the **Organize** Ribbon group on the **Program** page.

In general, the **Machine Queue** pane is a viewer that allows previewing and editing the task's Machine Queue without editing the task itself. In case you are not interested in this pane and would rather save some space on the screen, you can hide the pane by clicking the arrow on the separator to the left of the **Machine Queue** pane.
Task Details Pane

The **Task Details** pane is located at the bottom of the **Tasks and Schedule** view. It displays information on the items selected in the **Scheduling** area or the **Tasks** area. The behavior of this pane is similar to that of the Windows Explorer information pane. When an item is selected, detailed information on it is displayed including its name, comment, type and execution statistics.

Pic 1. The Task Details pane

The **Task Details** pane is very useful if you want to review brief statistics on the task execution such as the results of the last execution, the number of stored execution results, etc. Thus, you can navigate among the tasks and review their executions statistics in real time.
Network View

The Network view is located by default on the left of the main program window. It displays the results of the automatic network scan, the Machines added manually, Collections and Collection Snapshots. 

Pic 1. The Network view

The icon next to every item is used to describe of the item's type and state. The state icons are intended to help you understand what is happening in the program at the moment. You can always see if the item is currently being processed by some operation and if it can be removed.

Below is a list of the icons used for different items and the item processing states:

- the network root;
- the network root is being processed, e.g. a network enumeration process is running;
- a Group (may be both a domain and a workgroup);
- the Group is being processed;
- the Group is being processed and not operable from this view;
- an Active Directory Container (such as default Computers);
- the Active Directory Container is being processed;
- the Active Directory Container is being processed and not operable from this view;
- an Organization Unit;
- the Organization Unit is being processed;
- the Organization Unit is being processed and not operable from this view;
- a Machine;
- the Machine is being processed;
- the Machine is being processed and not operable from this view;
- the grouping node for the Collections defined in the program scope;
- the Collection that describes a set of Machines to operate;
- the Collection is being processed;
- the Machine Query used to retrieve a scope of Machines;
- the Machine Query is being processed;
- a grouping node for static Machines within a Collection;
- a grouping node for Machine Queries within a Collection;
- a grouping node for Collection Snapshots;
- a Collection Snapshot.

For Collections, a filter decorator is painted over the item icon if the Machines Filter is defined for such an item (谤). The same approach is used for Machine Queries (禄). On the Machine Queries node within each Collection, you can see if the Machines are retrieved from the entire network (禄) or from the program database (禄), and for the Groups, Machines and Containers within the Collection Snapshot, a snapshot decorator is painted (禄)，so that you can see that this is a snapshot content.

Beside showing the item name, type and state icon, the Network view allows you to review the comment for every item retrieved during a network scan and the description defined in the object properties. The comment field value retrieved depends on the network scan method chosen in the enumeration options. If the Active Directory Only type is chosen, the comment value is the description for the object in the Active Directory data, whereas for the Computer Browser Only method the comment value is the Computer Description defined in every Machine's OS settings. If the Both Active Directory and Computer Browser method is chosen, the comment is filled with the description defined in Active Directory only if it is available, otherwise the computer description defined in the Machine's OS is displayed. When adding machines manually, you can provide a comment for the Machine being added in the Comment field. The view also contains other columns displaying additional Machine properties such as the IP address, the platform, the operating system, etc.

For each Machine in the Network view, the respective Machine's icon can be decorated with one of the machine status icons to show the latest access status:

- the Machine is accessible, i.e. it satisfies the requirements for remote Machines and can be operated;
- the Machine is accessible and the remote agent is installed but is not running;
- the Machine is accessible, the remote agent is installed and running;
- the Machine is accessible, the remote agent is installed but is not up-to-date;
- the Machine is accessible, but the remote agent is unreachable: either it is impossible to check the state of the remote agent or it fails to start;
- it is currently impossible to connect to this Machine, i.e. the Machine is offline;
- the Machine is inaccessible, i.e. it is currently impossible to operate this Machine;
- the access to the remote Machine is denied; to operate this Machine, you should provide the administrative credentials in the Credentials view;
- the operating system installed on this Machine is no longer supported.

The number of Machines available in every container is displayed next to the container name in square brackets, so you can always get this information quickly and easily without having to do manual counting. For example, 3 of 5 means that there are 3 Machines in this container within the **Network** view but the program network structure includes 5 machines assigned to this container.

The **Network** node represents the network items found during enumeration. Machines that are not available during the automated network scan process may be removed from this node.

The network enumeration is not required if you are going to operate a local Machine. There is always an item named **Computer** within the **Network** view, which is a shortcut to the local Machine. This is a fully functional item introduced to make your work more comfortable. If you have performed enumeration, this item is also displayed in the network structure within the **Network** node.

The **Collections** node is used to permanently store information on preconfigured sets of Machines and Machine Queries to be used while configuring the **Machine Queue** for any operation. For detailed information on the Collections concept, refer the **Collections** section of the documentation. The Collections mostly consist of Machine Queries and an optional filter applied to Machines. You can also store query results in a special object called the Collection Snapshot. There can be only one snapshot for every Collection. It is identified by the Collection itself and the snapshot creation time. All snapshots are grouped within the **Collections' Snapshots** node.

### Toolbar Overview

| **Enumeration** | The **Enumeration** button from the **Network** view toolbar should be used to scan the selected containers for Machines. If the **Enumerate New** option is used, only new Machines are added to the containers, otherwise, if the **Enumerate** option is used, the Machines from the selected containers that are not available during the scan are removed from the **Network** node. |
| **Collections** | The **Collections** button from the **Network** view toolbar is a multifunctional button that contains the actions for Collections management. It is possible to create new Collections, create snapshots for Collections and add the selected items to existing Collections. |
| **Power** | The **Power** button from the **Network** view toolbar is a multifunctional button that allows you to choose a power management operation to be performed over the selected remote Machines, either immediately or on schedule. |
| **Administration** | The **Administration** button from the **Network** view toolbar is a multifunctional button that allows you to retrieve MAC address of the selected remote Machines or send a message to these Machines, either immediately or on schedule. |
| **Session** | The **Session** button from the **Network** view toolbar is a multifunctional button that allows you to choose a windows session management operation to be performed over the selected remote Machines, either immediately or on schedule. |
## Input Devices
The **Input Devices** button from the **Network** view toolbar is a multifunctional button that allows you to lock and unlock input devices on the selected remote Machines, either immediately or on schedule.

## Check State
The **Check State** button from the **Network** view toolbar should be used to check the access status for the selected Machines or the Machines from the selected Collections.

## Edit
The **Edit** button from the **Network** view toolbar allows you to review and change the selected item's properties.

## Delete
The **Delete** button from the **Network** view toolbar can be used to delete the selected items from the view.

## Full Expand
The **Full Expand** button should be used to expand all nodes in the **Network** view.

## Full Collapse
The **Full Collapse** button should be used to collapse all nodes in the **Network** view.

## Choose Columns
The **Choose Columns** button should be used to choose the columns to be displayed in the **Network** view.

## Filter Editor
The **Filter Editor** button should be used to define the custom filter criteria to be applied to the data displayed within the **Network** view.

## Configuration
The **Configuration** button from the **Network** view toolbar enables you to configure the enumeration options, show/hide the filter conditions preview and reset the view layout.

The main goal of the **Network** view is displaying enumeration results and Collections; thus it allows you to perform all the actions for building the network structure and for managing Collections. You can scan either the entire network or selected containers for Machines, create Collections and add the selected items to existing Collections. Those actions are available on the toolbar and in the pop-up menu of the **Network** view.

From the **Network** view, it is also possible to execute operations on remote Machines. If you select Collections, they are automatically added to the operation's Machine Queue. For the selected standalone Machines and Queries, an appropriate embedded Collection containing the selected objects is added to the Machine Queue.

The **Network** view allows you to review the filter conditions defined by the Queries and Collections without opening the object properties. Simply enable the **Show Details** option in the **Configuration** menu and you will find a row under each Machine Query and Collection node that shows if any condition is defined. In case it is defined, you can double-click this row or use the arrow button on the right of the row to expand/collapse the filter condition preview.

Other useful features of this view are the options to copy/paste, drag/drop and import/export Machines, Queries and Collections. The corresponding actions are available in the pop-up menu, the **Organize** Ribbon group and the **Clipboard** Ribbon group on the **Program** page.
Credentials View

The **Credentials** view is by default located on the left of the main program window. Its purpose is to define the credentials to be used to connect to remote Machines intended for processing. The representation of the **Credentials** view is very similar to that of the **Network** view, but it also contains credentials associated with each network item. This tree is built and maintained automatically using the network structure.

The Credentials used to connect to remote Machines are stored until they are reset, i.e. even if the Machine referenced by the credentials is removed, the credentials will still exist but become inactive. Those credentials items are removed only if they are reset.

![Credentials view](image)

**Item Icon** represents the item type and shows if the credentials defined for this item are currently active or not. The set of icons used to represent all types of the items and their states is described below:

- 🌐 - the root of the **Credentials**, that defines the default credentials to be used;
- 🗂 - the Group (may be either a domain or a workgroup) credentials;
- 🌐 - the Active Directory Container (an organization unit or another container in Active Directory) credentials;
- 🌐 - the Machine credentials;
- the Machine Group (may be either a domain or a workgroup) credentials that are currently inactive;
- the Active Directory Container (an organization unit or another container in Active Directory) credentials that are currently inactive;
- the Machine credentials that are currently inactive.

**Item Name** - the name of the item.

**Credentials Part** – shows the login name to use while connecting to remote Machines or a hint if the credentials are not set. The in-place edit shows the pop-up window to specify the credentials.

For the containers in the **Credentials** view, the number of Machines with active credentials is displayed in square brackets, so that you can always get this information quickly and easily without having to do manual counting. If the container includes both active and inactive Machines credentials, the number of active credentials and the total number of credentials are displayed, e.g. 3 of 5 means that there are 5 Machine credentials in this container and 3 of them are active.

You can review the credentials to be used to connect to the remote Machine from the tool-tip displayed for it. This may be very useful if the credentials you have provided do not explicitly specify the domain or if the network structure is quite complex. You can review the **Credentials** section to get a closer look at the concept used for specifying credentials for connecting to remote Machines.

**Toolbar Overview**

| **Edit** | The **Edit** button from the **Credentials** view toolbar should be used to specify the credentials for the selected network item. |
| **Delete** | The **Delete** button from the **Credentials** view toolbar should be used to delete the credentials from the selected network item. |
| **Delete All** | The **Delete All** button from the **Credentials** view toolbar allows you to delete all credentials stored for network items. |
| **Show Active** | The **Show Active** button from the **Credentials** view toolbar switches the view to the mode that displays only the credentials for the items currently referenced by the program business data. |
| **Show Inactive** | The **Show Inactive** button from the **Credentials** view toolbar switches the view to the mode that displays only the credentials for the items that are currently not referenced by the program business data. |
| **Show All** | The **Show All** button from the **Credentials** view toolbar switches the view to the mode that displays all the available credentials items. |
| **Full Expand** | The **Full Expand** button should be used to expand all nodes in the **Credentials** view. |
| **Full Collapse** | The **Full Collapse** button should be used to collapse all nodes in the **Credentials** view. |
Configuration

The Configuration button provides access to the option of resetting the view layout.

Within the Credentials view, you can define the credentials to be used to access each network resource and reset those credentials when they are no longer needed. In addition, it is possible to switch between different view modes by changing the display filter condition.

To specify the credentials to be used for a network resource, you should select such a resource in the Credentials view and click the button of the credentials part of the in-place edit. Alternatively, you can use the Edit button from the Organize Ribbon group on the Program page, the Edit button on the toolbar or the Edit item from the pop-up menu.

When setting the credentials' user name, pay attention to the domain it will be used for. This information is shown in the Log on to field: this field value should be the domain or the Machine name where the account with the respective user name is present. To access the other domain, see the How do I access another domain? section.

The pop-up window Pic 2 is opened for you to specify the credentials for the selected item. You are offered to provide the user name and password to be used for connection in the appropriate fields of the pop-up window. The password confirmation must exactly match the password input.
When you are ready with the credentials specification, press **OK** to proceed.

If the specified credentials are no longer needed, you can reset them. To reset the credentials for a network resource, select the required resource in the **Credentials** view and click the ![X] button of the credentials part of the in-place edit. Alternatively, you can use the **Delete** button from the **Organize** Ribbon group on the **Program** page, the **Delete** button on the toolbar or the **Delete** item from the pop-up menu.

If you want to display either the active or inactive credentials only or both kinds of the credentials, you can choose the **Credentials** view mode by using the **Choose View** drop-down item from the **Credentials** view pop-up menu or the view switching buttons on the toolbar.

From the **Credentials** view, it is possible to import and export the credentials, as well as copy and paste them. You can use either the pop-up menu or the **Organize** and **Clipboard** Ribbon groups on the **Program** page to reach the goal. It is also possible to reset all the credentials available in the program by using the **Delete All** item and to expand or collapse all the nodes in the **Credentials** view by using the **Full Expand** or **Full Collapse** items on the toolbar and in the pop-up menu.
Execution Results View

The **Execution Results** view shows the results of business operations on remote Machines. If any problems have been detected during the operation execution, troubleshooting advice is displayed next to the result message in the **Execution Results** view to help you solve those problems.

Within the **Execution Results** view, each row contains the result for a remote Machine: such information consists of the event type represented by an icon, the Machine name, the Group name, the event title, the completion date and the event description itself, with or without a troubleshooting hint. The description and the hint for any event are by default wrapped so that you can easily read it. If you would like to have more events visible at the same time, you can configure the Execution Results view to display only one line per event by disabling the Wrap Description option from the Configuration menu, after which a detailed description will only be shown in the event details pane. You can also remove the hint column from the view and review the troubleshooting advice only within the event details pane. It is possible to add the **Error Code** column to the view using the **Column Chooser** if required.

![The Execution Results view](image)

The icons used to display the event type enable you to understand if the operation has succeeded without actually reading the message. The following icons are used to display the event types:

- **i** - the blue icon with the 'i' character means that everything is OK.
- the brown circle icon with a cross-cut line is used to identify that the operation was canceled by user or due to shutdown of the underlying system.

- the yellow icon with an exclamation mark is the warning icon. It means that some errors took place, but they are not critical. In such case, it is not guaranteed that the operation has actually succeeded.

- the red icon with a white cross is the error sign: it means that the operation execution has failed.

The results displayed within the view are grouped by Runs, by Groups the processed Machines are located in, and by the Machines. On each grouping row, you can see the time spent for processing either a single Machine or all Machines from a single Group, or all the Machines. The Run and Group rows also display brief execution statistics in form of numbers of the Machines the operation of which has completed with a specific severity level.

The event details pane is located by default at the bottom of the Execution Results view. It shows detailed information pertaining to the result selected in the table so that you can always see the entire event description and troubleshooting advice, if any. If you are not interested in this pane and do not want it to be displayed at all times, you can hide it by disabling the Show Event Details Pane option from the Configuration menu.

Each Run shows the execution type represented by one of the following icons:

- the run is a result of a scheduled task execution, and the schedule element is still in the scheduling area.

- the run is a result of a scheduled task execution, but there is no schedule element in the scheduling area this run refers to.

- the run is a result of a manual task execution using the Run command.

- the run is a result of an individual operation execution.

**Toolbar Overview**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="last-7-days.png" alt="Last 7 Days" /></td>
<td><strong>Results Range</strong>&lt;br&gt;The <strong>Results Range</strong> button allows you to choose the date range to display the execution results for.</td>
</tr>
<tr>
<td><img src="all-runs.png" alt="All Runs" /></td>
<td><strong>All Runs</strong>&lt;br&gt;The <strong>All Runs</strong> button switches the <strong>Execution Results</strong> view to the mode in which runs for both the tasks and the individual operations for the specified date range are displayed.</td>
</tr>
<tr>
<td><img src="task-runs.png" alt="Task Runs" /></td>
<td><strong>Task Runs</strong>&lt;br&gt;The <strong>Task Runs</strong> button switches the <strong>Execution Results</strong> view to the mode in which only runs of the tasks for the specified date range are displayed.</td>
</tr>
<tr>
<td><img src="individual-runs.png" alt="Individual Runs" /></td>
<td><strong>Individual Runs</strong>&lt;br&gt;The <strong>Individual Runs</strong> button switches the <strong>Execution Results</strong> view to the mode in which only the execution results of individual operations for the specified date range are displayed.</td>
</tr>
<tr>
<td><img src="link-with-selection.png" alt="Link with Selection" /></td>
<td><strong>Link with Selection</strong>&lt;br&gt;The <strong>Link with Selection</strong> button should be used to turn on and off the option of synchronizing the results displayed in the Task Runs mode of the Execution Results view with the tasks selected within the Task and Schedule view.</td>
</tr>
</tbody>
</table>
The execution results set is selected only for the specified date range. This approach is used to optimize the memory usage and performance as there may be many execution results in the entire database. The display range for execution results is set by default to the **Last 7 Days** value and can be changed with the range drop-down button on the view toolbar. The text on the button shows the currently applied range. You can choose among the predefined ranges or provide a custom one.

To prevent continuous growing of the results database, the execution results can be deleted by runs either manually or automatically. You can also delete the results manually whenever you wish taking into account your own conditions. To delete the results manually, select the runs to delete in the **Execution Results** view and press the **Delete** button on the toolbar or choose the **Delete** item from the pop-up menu. An automatic deletion of the execution results is configured on the **Execution Results** preference page.

The layout of the **Execution Results** view, including all the grouping and sorting settings and the details pane visibility, can be easily reset to factory settings by choosing the **Reset Layout** option from the **Configuration** menu.

The **Execution Results** view can be used in three modes, namely **All Runs**, **Task Runs** and **Individual Runs**. Let us take a closer look at each of these modes.
The **All Runs** mode is used by default. In this mode, the **Execution Results** view displays the execution results both for preconfigured tasks from the **Tasks and Schedule** view and for individual operations launched at any time.

The **Execution Results** view in the **Task Runs** mode shows the execution results for the tasks available in the **Tasks and Schedule** view. Linking the **Execution Results** view with the **Tasks and Schedule** view makes the results displayed in the **Execution Results** view reflect the results of the tasks selected in the **Tasks and Schedule** view. If the **Execution Results** view is not linked to the **Tasks and Schedule** view, to review the results for the task you are interested in, you should select it in the **Tasks and Schedule** view and choose the **Show Results** menu item from the task's pop-up menu, otherwise results for all the tasks are displayed. In the **Task Execution Results** mode, results are also grouped by the task they belong to.

The **Individual Runs** mode should be used if you would like to review only the execution results for the standalone operations launched manually. For example, when operating Machines directly from the **All Machines** view.
Log View

The log is designed to store information on the events taking place during the program execution. The larger part of this information consists of events generated by the operations. The purpose of this chapter is to help you understand the log.

![Pic 1. The Log view](image)

The Log view is located by default at the bottom of the Remote Shutdown main window and displays the log in form of a tree and a pane that shows details of a selected event **Pic 1**. The description for any logged event is by default wrapped, so that you can easily read it. If you would like to have more events visible at the same time, you can configure the Log view to display only one line per event by disabling the Wrap Description option from the Configuration menu, after which a detailed description will only be shown in the event details pane. If you do not need the event details pane and would like to review the events only within the tree, you can hide the event details pane by disabling the Show Event Details Pane option from the Configuration menu. Also, it is possible to enable the automatic scrolling feature to always see new log events as soon as they arrive, using the Autoscroll item from the Configuration menu.

Every event in the log is assigned a severity level represented by a certain icon. The icon allows you to see if any problem has occurred without reading the description. The following icons are available:

- **i** - the blue icon with an 'i' character means that everything is OK;
- the brown circle icon with a cross-cut line is used to identify that the operation was canceled by user or due to shutdown of the underlying system;

- the yellow icon with an exclamation mark is the warning sign: it tells you that some errors have occurred, but they are not critical. In such a case, there is no guarantee that the operation has actually succeeded;

- the red icon with a white cross is the error sign: it means that the operation execution has failed.

Analyzing the log can help you a lot in your everyday work with Remote Shutdown, because it contains all the information on the executed tasks and provides you with troubleshooting recommendations in case any problems are detected.

**Toolbar Overview**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>The <strong>Export</strong> button should be used to export the log to a CSV file.</td>
</tr>
<tr>
<td>Clear</td>
<td>The <strong>Clear</strong> button should be used to delete all the logged events from the program database.</td>
</tr>
<tr>
<td>Full Expand</td>
<td>The <strong>Full Expand</strong> button from the <strong>Log</strong> view toolbar should be used to expand all nodes in the table of logged events.</td>
</tr>
<tr>
<td>Full Collapse</td>
<td>The <strong>Full Collapse</strong> button from the <strong>Log</strong> view toolbar should be used to collapse all nodes in the table of logged events.</td>
</tr>
<tr>
<td>Choose Columns</td>
<td>The <strong>Choose Columns</strong> button should be used to choose the columns to be displayed in the table of logged events.</td>
</tr>
<tr>
<td>Filter Editor</td>
<td>The <strong>Filter Editor</strong> button should be used to define the custom filter criteria to be applied to the data displayed within the table of logged events.</td>
</tr>
<tr>
<td>Configuration</td>
<td>The <strong>Configuration</strong> button enables you to configure the <strong>Log</strong> view, manage the visibility of the event details pane and reset the view layout.</td>
</tr>
</tbody>
</table>

The options of clearing the log, expanding nodes in the tree of logged events and collapsing them are also available from the pop-up menu of the Log view.

The layout of the **Log** view, including the visible columns, the column widths, the sorting settings, the descriptions wrapping and the details pane visibility, can be easily reset to the initial defaults by choosing the **Reset Layout** option from the view menu.
All Machines View

The **All Machines** view is by default located at the bottom of the program main window. This view displays information on all Machines available in the program. Using this view, you can review the available Machines.

![Image of All Machines view](image)

**Pic 1. The All Machines view**

 Toolbar Overview

- **Power**
  The **Power** button from the **All Machines** view toolbar is a multifunctional button that allows you to choose a power management operation to be performed over the selected remote Machines, either immediately or on schedule.

- **Administration**
  The **Administration** button from the **All Machines** view toolbar is a multifunctional button that allows you to retrieve MAC address of the selected remote Machines or send a message to these Machines, either immediately or on schedule.

- **Session**
  The **Session** button from the **All Machines** view toolbar is a multifunctional button that allows you to choose a windows session management operation to be performed over the selected remote Machines, either immediately or on schedule.
| **Input Devices** | The **Input Devices** button from the **All Machines** view toolbar is a multifunctional button that allows you to lock and unlock input devices on the selected remote Machines, either immediately or on schedule. |
| **Check State** | The **Check State** button from the **All Machines** view toolbar should be used to check the access status for the selected Machines. |
| **Edit** | The **Edit** button from the **All Machines** view toolbar allows you to review and change the selected item’s properties. |
| **Delete** | The **Delete** button from the **All Machines** view toolbar can be used to delete the selected Machines together with the all data referenced by those Machines. |
| **Add to Collection** | The **Add to Collection** button from the **All Machines** view toolbar should be used to add the selected Machines to a new or an already existing Collection. |
| **Full Expand** | The **Full Expand** button should be used to expand all the grouping rows in the table. |
| **Full Collapse** | The **Full Collapse** button should be used to collapse all the grouping rows in the table. |
| **Group By Box** | The **Group By Box** button should be used to configure the data grouping for the table. |
| **Choose Columns** | The **Choose Columns** button should be used to choose the columns to be displayed in the table. |
| **Filter Editor** | The **Filter Editor** button should be used to define the custom filter criteria to be applied to the data displayed within the table. |
| **Configuration** | The **Configuration** button provides access to the option of resetting the view layout. |

The functions of retrieving Machines’ MAC addresses, performing power management and administrative actions for selected Machines, viewing Machines’ properties and other useful options are available on the toolbar and from the **All Machines** view pop-up menu. In the pop-up menu and on the toolbar, you can also find the **Configuration** item that allows resetting the view layout and opening the **WOL Configuration** and **MAC Address Scan** preferences.

By default, the Machines in the **All Machines** view are grouped by the sign if the MAC address is retrieved, but you can easily reset this grouping or customize it to fit your needs by choosing other columns and filter data – see the **Grouping and Filtering Data** topic for details. You can then always roll back to the default pane layout using the **Reset Layout** item from the view configuration menu.
Access Control View

The Access Control view is by default located at the bottom of the main program window. Its purpose is to define user roles and assign those roles to users and groups thus allowing granting or denying specific privileges to clients. For detailed information on configuring the privileges, refer to the Access Control section of this document.

Pic 1. The Access Control view

The Access Control view is split in two parts, which are Permissions and Roles. Within the Permissions part, you can review and manage the currently effective associations between accounts and roles. The following icons are used within the Permissions group for displaying the type of the principal:

- the role is assigned to a user;
- the role is assigned to a group.

Toolbar Overview

Assign Permissions

The Assign Permissions button allows you to assign roles to users and groups thus defining their privileges when they access the Remote Shutdown server.

Edit

The Edit button is used to reassign the access role for a selected user or group.
Delete
The **Delete** button allows you to delete the selected access role assignments.

Full Expand
The **Full Expand** button should be used to expand all the grouping rows in the table.

Full Collapse
The **Full Collapse** button should be used to collapse all the grouping rows in the table.

Group By Box
The **Group By Box** button should be used to configure the data grouping for the table.

Choose Columns
The **Choose Columns** button should be used to choose the columns to be displayed in the table.

Filter Editor
The **Filter Editor** button should be used to define the custom filter criteria to be applied to the data displayed within the table.

Configuration
The **Configuration** button provides access to the option of resetting the view layout.

The **Roles** part is used for reviewing and managing roles. For the **Roles** part, the following icons are used to define the type of the role:

- - a build-in role;
- - a user-defined role.

**Toolbar Overview**

Add Role
The **Add Role** button is used to create a new Remote Shutdown server access role to be assigned to users and groups.

Edit
The **Edit** button allows you to change the name and/or the set of enabled privileges for the selected user-defined access role.

Delete
The **Delete** button is used to delete the selected user-defined access roles.

Full Expand
The **Full Expand** button should be used to expand all the grouping rows in the table.

Full Collapse
The **Full Collapse** button should be used to collapse all the grouping rows in the table.

Group By Box
The **Group By Box** button should be used to configure the data grouping for the table.

Choose Columns
The **Choose Columns** button should be used to choose the columns to be displayed in the table.
<table>
<thead>
<tr>
<th>Filter Editor</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Filter Editor</strong> button should be used to define the custom filter criteria to be applied to the data displayed within the table.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Configuration</strong> button provides access to the option of resetting the view layout.</td>
</tr>
</tbody>
</table>

You can regroup the layout of this view any way you want it using the **Group Layout** item from the **Configuration** menu. Both parts of this view fully support all the grouping and filtering features.
Operations View

The Operations view shows the detailed progress of each operation being performed at the moment and allows canceling a particular operation or all running operations. By default, it is located at the bottom of the Remote Shutdown main window.

![Operations View](image)

Pic 1. The Operations view

Progress information for every operation is shown in the pane with the progress bar, the operation information text and the Cancel button. The Cancel button is used to cancel individual running operations, whereas if the grouping operation is canceled, all the sub-operations are also canceled.

**Cancel All**

The Cancel All button from the Operations view toolbar can be used to cancel all the operations running in the application.

You can cancel all the running operations by clicking the Cancel All button on the toolbar of the Operations view.
Graphical User Interface features

EMCO Software provides you with a modern and intuitive graphical user interface, because we appreciate the users of our products and would like them to feel glad that they have EMCO programs installed on their PCs. Lots of resources were involved in creating this kind of an interface for you, and now we are proud we have done it. Custom DPI settings are fully supported, so that you can use EMCO programs on any display with any resolution you like. The ‘Microsoft User Interface Guidelines on Layout, Icons and Sizing’ have been a powerful base for this work, and we are glad to tell you that they are fully complied with and supported. With the help of the skinning support and the Ribbon UI interface, every customer can configure the program UI to feel comfortable during each working day. EMCO also provides you with the **High Contrast** skin along with the bonus skins pack, which is an accessibility feature designed for people with vision impairment. The High Contrast color scheme can increase legibility for some users by heightening the screen contrast with alternative color combinations.

This chapter gives you a detailed description of how to fully enjoy the graphical user interface features, the skinning mechanism and the Ribbon bar features.
Skinning

Remote Shutdown provides you with a wide range of custom skins with unique look and feel, so that you can choose any skin you like most. If you are a fan of the Microsoft Office interface, you have no reason to complain either, since Remote Shutdown also gives you an option of choosing this type of skin. There are not only formal skins but also some informal ones.

All the skins can be divided into four groups: Office Skins, Custom Design Skins, Bonus Skins and Skins for Fun. The following skins are available:

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Skins for Fun:</td>
<td>&quot;Christmas&quot;, &quot;Valentine&quot;, &quot;Summer&quot;, &quot;Springtime&quot;.</td>
</tr>
</tbody>
</table>

Let us take a brief look at some of the skins:

**Office 2010 Skin look and feel example**
Custom Design Skin look and feel example
Skins for Fun look and feel example
High Contrast Skin look and feel
Ribbon

Ribbon is a tool that presents commands organized into a set of tabs. The tabs on the Ribbon represent commands that are most relevant for each of the task areas in the program [Pic 1]. For example, in Office Word the tabs group commands by activities such as inserting objects like pictures and tables, doing page layout, working with preferences, doing mailings, and reviewing. The Home tab provides an easy access to the most frequently used commands. Office Excel has a similar set of tabs that make sense for spreadsheet work including tabs for working with formulas, managing data, and reviewing. Those tabs simplify access to the program features, because they organize the commands in a way that reflects the tasks people perform in those programs.

![Pic 1. The Ribbon bar](image)

We are delighted to let you know that we fully conform with Microsoft® Ribbons Guidelines and would like to introduce some Ribbon features to you. To learn more about Ribbon, the story of its development and its usability features, you may visit 'The Story of the Ribbon' article from the MSDN blogs.

Application Menu

The Application Menu invoked using the Application button [Pic 2] is somewhat similar to the File menu in most programs that use a classic user interface, but it gives you more.

![Pic 2. Application Menu](image)

It contains links to the most helpful actions located under different tabs but made available from one access point.
Quick Access Toolbar

The **Quick Access Toolbar** [Pic 3] is an end-user customizable bar located near the **Application Menu** or below the Ribbon bar depending on the configuration. It can contain links to both Ribbon items and Ribbon groups.

![Pic 3. Quick Access Toolbar](image)

To add an action link to the quick access toolbar, right click this action and select **Add to Quick Access Toolbar** from the pop-up menu. The groups can be added in the same way, the only difference being that to add a group you should right click its caption.

Representation and Navigation Features

The representation of the Ribbon bar can also be configured to make your work more comfortable. You can minimize Ribbon so that the tab's content is only shown when the tab is clicked on, thus extending the program workspace. Also, if it is not convenient for you to have the **Quick Access Toolbar** next to the **Application Menu**, you may place it below the Ribbon bar, so that it will look just like a simple toolbar. This configuration can be accessed from the pop-up menu of the Ribbon bar [Pic 4].

![Pic 4. The Ribbon customization menu](image)

Navigation between the Ribbon tabs can be performed not only with a mouse click on a tab but also with the help of the mouse wheel. Just place the cursor over any tab and scroll the wheel – scrolling up will switch the tabs from right to left, and scrolling down will switch the tabs in the opposite direction.
UI Elements' main features

The graphics shell used for Remote Shutdown is aimed at providing a high level of usability to everyone. This topic covers main features of the graphical elements used in this program, and here you can find what puts EMCO GUI a step ahead of the others.

Docking

The Remote Shutdown user interface is built using the ultimate docking technology which provides for the maximum use of the program working area. It allows docking the windows that are used less often than the main one to the sides, auto hide them or even close and then open again when required. The dock panels can be docked both to the main window and to each other, thus enabling you to build such a subsidiary window layout that makes you feel comfortable while working with Remote Shutdown (Pic 1).

To change the position of any dock window, you should click its header and move the mouse pointer while holding the left mouse button down. Hint windows are shown to help you understand where you can drop the window dragged. When you are dragging it over another dock window, it is possible to dock both windows to each other or display them in different tabs of the same dock window.

To enable the auto hide feature for a window attached to any side of a main window, click the pin button in the dock window header. Clicking the cross button results in closing of the dock window. Each view can also be closed and opened again using the checkboxes in the Show Ribbon group accessible from the View page.
Grouping and Filtering Data

The Remote Shutdown user interface is designed so as to make its usage as flexible as possible. The tables available in every EMCO program provide you with an easy-to-use data filtration and grouping mechanism. To group data by one of the columns, you should drag its header to the grouping box displayed over the table or choose an appropriate item from the column header pop-up menu [Pic 2].

To group or ungroup data by any column when Group By Box [Pic 2] is not visible, you can have it displayed by selecting the Show Group By Box item from the pop-up menu of any column header.

Data filtration can be performed in two ways: by using the quick filter or the filter editor. To use the quick filter feature, just click on the glyph in the right top corner of any column header. A drop-down list appears offering you to choose one of the predefined filters or select the custom one from the filtering dialog [Pic 3].
The **Filter Editor** shipped with Remote Shutdown is easy to use and allows you to build your own complex filters quickly and easily [Pic 4]. To open the filter editor, choose the **Filter Editor** item from the column's pop-up menu.

![Pic 4. Using the filter editor](image)

You can enable and disable the currently applied filter condition using the checkbox displayed next to the filter condition in the bottom of the view, inside the filter info pane [Pic 5].

![Pic 5. The filter info pane](image)

To reset the currently applied filter use the button from the filter info pane, and to customize it use the **Edit Filter** button from this pane.
Managing Columns in Trees and Tables

You can customize almost every table and tree in EMCO programs by moving and removing columns to make the control most informative for you. To move a column, drag it over the control’s header and drop between other columns to its new position [Pic 6].

To remove a column that is of no use for you, right click the control’s header and select the Remove This Column item from the pop-up menu. Also, you can control columns availability using the column chooser [Pic 7].

To show the column chooser, right click the control’s header and select the Column Chooser menu item. After that, you can drag and drop columns from the header to the column chooser and backwards.

Automatic Saving and Restoring of Windows Layout

One of the service functions of Remote Shutdown user interface is its ability to save and restore the windows layout. All the changeable parameters like the windows sizes and positions; the table columns order, sizes and positions; the grouping and filtering options; the dock windows configuration, etc. are saved between sessions. Thus, you do not need to configure the program’s user interface layout every time you start this program.
Chapter 4: Configuring Machines' hardware for Wake-on-LAN

We would like to draw your attention to the fact that Wake-on-LAN features are by default disabled both in the Machine's BIOS and Operating System settings, so Remote Shutdown will not wake your Machines up until they are configured properly. This chapter is intended to help you with configuring the Machines' hardware to meet the requirements and prerequisites for performing Wake-on-LAN. We will guide you through the process of setting up the Machines' BIOS for Wake-on-LAN and configuring the network adapter in the Microsoft® Windows operating systems.

If the Machine already meets the requirements described below or has been reconfigured to meet them, it is ready to be turned on by Remote Shutdown.

Setting up Machines' BIOS

In this part of the document, we will tell you how to configure the Machine's BIOS to meet the requirements for the Wake-on-LAN operation by Remote Shutdown to succeed. All relevant settings are usually found in the BIOS section called Power Management. They may also be located in a different place – refer to the motherboard manual to locate them. The following motherboard settings will enable WOL.

Power Management

Please note that power management features, such as WOL, are closely related to power management itself. Thus, you will most likely need to enable the ACPI or APM support for the motherboard. ACPI and APM are the two main industry standards for power management (with ACPI being the newest and more advanced one). If your motherboard supports WOL, this implies support of either ACPI or APM. You should make sure that whichever one is supported by your motherboard is enabled in the BIOS settings.

If the WOL and power-off state options are not there or not accessible, try enabling ACPI/APM. In some BIOS setups, the ACPI option is called IPCA.

Power-Off State

Some BIOS setups have the following names for this option:

- Power-off state/method
- ACPI suspend type
- ACPI standby state

Most likely, you will need to set this to S3/STR for the motherboard to be able to wake up on various events. STR (Suspend To RAM) is a special power-off state which leaves certain parts of the machine in a "sleeping" state but still aware of their surroundings. You could say that the machine is "sleeping with one eye open".
WOL Support

Finally, look for the WOL option. Usually, it is named **WOL** and found in the **Power Management** section. However, it may also be labeled **PME** or **Wake (up) on LAN/Ethernet/PME#** and found under a different BIOS section.

Most of modern motherboards do not have the **WOL** option – in such case, **Power On By PCI Devices (Power On By PCIE Devices)** from the **APM Configuration** section found on the **Power** tab should be enabled instead.

After you have completed the steps described above, the Machine BIOS is configured to support Wake-on-LAN.

Configuring Machines' Network Adapter

For the Wake-on-LAN operation performed by Remote Shutdown to succeed, Wake-on-LAN must be enabled in the Network Adapter settings of the underlying operating system. This can be done from the Properties of the network adapter in the Device Manager. Follow the below steps to enable Wake-on-LAN for Microsoft® Windows:

1. Open the **Device Manager**.
2. In the window that opens, expand the **Network** adapters node.
3. Select the adapter you want to configure to receive WOL packets, right-click it and select the **Properties** item in the drop-down menu.

4. In the dialog that opens, switch to the **Advanced** tab.
5. Change the **Wake on Magic Packet** property to **Enabled**.

6. Press OK to proceed.

If you want to wake the Machines up from Sleep or Hibernate, you must make a few additional Network Adapter settings. For Microsoft® Windows, these settings are described below:

1. Open the **Device Manager**.

2. In the window that opens, expand the **Network** adapters node.
3. Select the adapter you want to configure to receive WOL packets, right-click it and select the **Properties** item in the drop-down menu.

4. In the dialog that opens, switch to the **Power Management** tab.
5. Check the **Allow this device to wake the computer** option.

![Configuring Machines' hardware for Wake-on-LAN](image1)

6. Check the **Only allow management stations to wake the computer** option to make sure it does not wake up on every single network activity that may take place.

![Configuring Machines' hardware for Wake-on-LAN](image2)
7. Press **OK** to proceed.
Chapter 5: Operating Remote Machines

The main purpose of Remote Shutdown is to provide you with an easy-to-use power management tool that allows you to operate Machines over your network. Using the program, you can perform Wake-on-LAN, shutdown, restart, hibernate, sleep, sign out and lock session operations; lock and unlock input devices on remote Machines; send messages to users on remote Machines. You can either execute each and every operation immediately, or create and schedule a preconfigured tasks to launch the operation in future. Remote Shutdown comes with a wide range of configuration options that allow you to set up the program to operate Machines from any network segment without any difficulties with just a single click. This chapter is aimed at introducing you to the main features of Remote Shutdown and helping you to configure the program and the remote Machines' hardware for using the program features. After reading this part, you will gain a better understanding of the concept used in the program and be able to use it in the future without any problems.
Shutting Down and Restarting Machines

With Remote Shutdown, you can either shut down and restart remote Machines immediately, or create a preconfigured task to perform shutdown or restart in the future, or schedule preconfigured tasks to be executed once or on a regular basis – this section will show you how to reach all these goals.

Performing Shutdown and Restart

The process of performing restart and shutdown operations is absolutely the same, the only difference is the initiated operation type. Let us take a closer look at this process using the shutdown operation as a reference.

<table>
<thead>
<tr>
<th></th>
<th>Shut Down</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The <strong>Shut Down</strong> button from the <strong>Power</strong> Ribbon group on the <strong>Remote Actions</strong> page should be used to shut down the remote Machines selected in the <strong>Network</strong> view or the <strong>All Machines</strong> view.</td>
</tr>
<tr>
<td></td>
<td><strong>Restart</strong></td>
</tr>
<tr>
<td></td>
<td>The <strong>Restart</strong> button from the <strong>Power</strong> Ribbon group on the <strong>Remote Actions</strong> page should be used to restart the remote Machines selected in the <strong>Network</strong> view or the <strong>All Machines</strong> view.</td>
</tr>
</tbody>
</table>

To turn off remote Machines by initiating the operating system shutdown, use the **Shut Down** button from the **Power** Ribbon group on the **Remote Actions** page. If the **Network** or the **All Machines** view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the **Power** group from the **Home** Ribbon page and the corresponding group in pop-up menus and on toolbars of the **Network** and **All Machines** views. The wizard will appear on the screen and guide you through the operation configuration process. 

---

![Pic 1]
Pic 1. Configuring a shutdown operation
When configuring a shutdown operation, you can specify the shutdown reason, define if you would like to wait for a specific period of time before performing the shutdown, choose if the notification should be displayed to a remote user and if it is allowed to cancel the shutdown. The next step is to define a set of Machines to be turned off. For the information on configuring a scope of Machines, refer to the Defining Machines to Operate section of this document. Once you are done with configuring the operation, press Finish to proceed. The shutdown operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Creating a new Shutdown or Restart Task

If you do not want to shut down or restart Machines right now, with Remote Shutdown you can create a preconfigured task to perform such power management operations in future, any time you want. To create a new Shut Down task for further execution, you should choose the New Task > Shut Down item from the Tasks area pop-up menu. For the restart tasks, use the New Task > Restart item. Alternatively you can use the New Task button from the Tasks area toolbar or the Regular Task button from the New Ribbon group on the Management contextual page from the Tasks and Schedule Tools category. The New Task wizard will appear on the screen and guide you through the process of creating a new task. Once you are done with configuring the task, press Create to create it. The newly created task will be added to the Tasks area. A created task can be executed manually any time using the Run menu item from the Tasks area or scheduled for automatic execution. Remote Shutdown will store the results for all runs of this task, and you can review all of them in the Execution Results view.

Performing Shutdown and Restart on schedule

As it has already been mentioned, with Remote Shutdown you can run a preconfigured power management task any time you want. However, manual task execution may not be convenient for you since in such a case you would always have to remember when you should perform this or that task. The scheduling engine built into Remote Shutdown can always keep this in mind for you, so that you can concentrate on your other everyday tasks.

To schedule a new Shut Down task, you should choose the Scheduled Task > Shut Down item from the New Ribbon group on the Home page. This option is also available in the Scheduling area pop-up menu and on the toolbar. Alternatively, you can select the Machines you want to turn off in the Network or the All Machines view and choose the New > Scheduled Shut Down Task menu item from the pop-up menu to initialize the Machine Queue with the selected Machines. For scheduling a new Restart task, use the Scheduled Task > Restart item from the New Ribbon group on the Home page and the appropriate items in the pop-up menu. The same way, as for Shut Down tasks, you can use the New > Scheduled Restart Task item in the pop-up menu of the Network or the All Machines view.

When scheduling a task, you can provide the operation configuration options, and specify a set of Machines to operate. Once you are done with configuring the task, press Schedule for the task to be put on schedule. The scheduled task will be added to the Scheduling area. A scheduled task is executed automatically when its start time comes. Remote Shutdown stores the results for all runs of such a task, and you can review all of them in the Execution Results view.
Waking Machines Up

With Remote Shutdown, you can either wake up remote Machines immediately, or create a preconfigured task to run Wake-on-LAN in the future, or schedule preconfigured tasks to be executed once or on a regular basis – this section will show you how to reach all these goals.

Performing Wake-on-LAN

To send a Wake-on-LAN packet to a remote Machine, Remote Shutdown firstly should be introduced to its MAC address. In case if the Wake-on-LAN operation is initiated for Machines that has no MAC address retrieved, Remote Shutdown will try to retrieve it automatically for each Machine before sending a magic packet, but as a Machine is turned off, the operation will be able to use only the Neighbor Discovery, IPv6 EUI-64 and DHCP methods. Thus, it is recommended to refresh MAC addresses manually or on schedule; refer the Retrieving MAC Addresses section for details.

Wake on LAN

The Wake on LAN button from the Power Ribbon group on the Remote Actions page should be used to wake up the remote Machines selected in the Network view or the All Machines view.

To turn on remote Machines by sending them a Wake-on-LAN package, use the Wake on LAN button from the Power Ribbon group on the Remote Actions page. If the Network or the All Machines view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the Power group from the Home Ribbon page and the corresponding group in pop-up menus and on toolbars of the Network and All Machines views. The wizard will appear on the screen and guide you through the operation configuration process.
Pic 1. Configuring a Wake-on-LAN operation
When configuring a Wake-on-LAN operation you can override the WOL and MAC address scan settings defined in the program preferences, if required, and define a set of Machines to be turned on. To learn more about the Wake-on-LAN packets transmission methods, refer to the WOL Packets Transmission Methods section. The MAC address scan methods are described within the MAC Address Retrieving Methods section. For the information on configuring a scope of Machines, refer to the Defining Machines to Operate section of this document. Once you are done with configuring the operation, press Finish to proceed. The Wake-on-LAN operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Creating a new Wake on LAN Task

If you do not want to wake Machines up right now, with Remote Shutdown you can create a preconfigured task to perform Wake-on-LAN in future, any time you want. While creating a new task, you can override a configuration to be used for performing Wake-on-LAN, if required. To create a new Wake on LAN task for further execution, you should choose the New Task > Wake on LAN item from the Tasks area pop-up menu. Alternatively you can use the New Task button from the Tasks area toolbar or the Regular Task button from the New Ribbon group on the Management contextual page from the Tasks and Schedule Tools category. The New Task wizard will appear on the screen and guide you through the process of creating a new task. Once you are done with configuring the task, press Create to create it. The newly created task will be added to the Tasks area. A created task can be executed manually any time using the Run menu item from the Tasks area or scheduled for automatic execution. Remote Shutdown will store the results for all runs of this task, and you can review all of them in the Execution Results view.

Performing Wake-on-LAN on schedule

As it has already been mentioned, with Remote Shutdown you can run a preconfigured Wake-on-LAN task any time you want. However, manual task execution may not be convenient for you since in such a case you would always have to remember when you should perform this or that WOL. The scheduling engine built into Remote Shutdown can always keep this in mind for you, so that you can concentrate on your other everyday tasks.

To schedule a new Wake on LAN task, you should choose the Scheduled Task > Wake on LAN item from the New Ribbon group on the Home page. This option is also available in the Scheduling area pop-up menu and on the toolbar. Alternatively, you can select the Machines you want to turn on in the Network or the All Machines view and choose the New > Scheduled Wake on LAN Task menu item from the pop-up menu to initialize the Machine Queue with the selected Machines.

When scheduling a task, you can override the Wake-on-LAN operation settings, if required, and specify a set of Machines to turn them on. Once you are done with configuring the task, press Schedule for the task to be put on schedule. The scheduled task will be added to the Scheduling area. A scheduled task is executed automatically when its start time comes. Remote Shutdown stores the results for all runs of such a task, and you can review all of them in the Execution Results view.
WOL Packets Transmission Methods

Wake-on-LAN (or WOL in short) is a feature provided by network adapters and motherboards that allows the computer to be powered up a certain activity in the network is detected. Making use of WOL decreases security risks, since the computer is not left on connected and unattended for prolonged periods of time; it saves power and thus reduces your bills; ultimately, it extends the life of the components.

EMCO Remote Shutdown Enterprise uses the following transmission methods for sending wake-up packets:

- IPv4 Link-Local Broadcasts
- IPv6 Link-Local Multicast
- Unicast
- IPv4 Directed Broadcast
These methods are described in detail below.

**IPv4 Link-Local Broadcast**

IPv4 Link-Local Broadcast, as a transmission method for sending wake-up packages to a Machine in Remote Shutdown, uses the special IPv4 broadcast address that stands for all machines in the local subnet, and it uses the Media Access Control (MAC) address of the target Machine from the database to generate a wake-up packet. The packet never leaves the local subnet of the Remote Shutdown server and reaches the Machine only if it resists in the same subnet.

**IPv6 Link-Local Multicast**

IPv6 Link-Local Multicast, as a transmission method for sending wake-up packages to a Machine in Remote Shutdown, uses the special IPv6 address to transmit the packets to all nodes that are registered to a specific multicast group that stands for all nodes on a local link, and it uses the Media Access Control (MAC) address of the target Machine from the database to generate a wake-up packet. The packet never leaves the local link-layer of the Remote Shutdown server and reaches the Machine only if it resists on the same link.

**Unicast**

Unicast, as a transmission method for sending wake-up packets to a Machine in Remote Shutdown, uses the IP address of the target computer from the program database to route the packets to the target computer's subnet, and it uses the Media Access Control (MAC) address of the target Machine from the database to generate a wake-up packet. When a wake-up transmission reaches the target Machine's subnet, the wake-up packet is sent directly to the target Machine.

If the target Machine has changed its IP address since it last sent its inventory information, the wake-up packet will reach a wrong Machine but will not wake it up because the MAC address in the wake-up packet transmission will not match the actual one.

**IPv4 Directed Broadcast**

IPv4 Directed Broadcasts, as a transmission method for sending wake-up packets to a Machine in Remote Shutdown, uses the Media Access Control (MAC) address and IP subnet address of the target Machine from the program database. A wake-up packet is sent to the Machine's last known subnet and is then broadcast to all Machines on that subnet. For this method to be successful, all intervening routers must be configured to forward directed broadcasts. During such broadcast transmission, the Machine with the MAC address specified in the wake-up packet will respond.

Since this transmission method uses the subnet address rather than the IP address, it will succeed even if the target Machine has changed its IP addresses but remained in the same subnet. Please note that subnet-directed broadcasts are not supported by IPv6 and are often disabled on routers.

### Methods Comparison

<table>
<thead>
<tr>
<th>Transmission Method</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 Link-Local Broadcast</td>
<td>No need to resolve the remote Machine's IP address.</td>
<td>Can wake-up only Machines from the local subnet.</td>
</tr>
<tr>
<td>IPv6 Link-Local Multicast</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unicast</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv4 Directed Broadcast</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Copyright © 2001-2019 EMCO. All rights reserved.
<table>
<thead>
<tr>
<th>Transmission Method</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv6 Link-Local Multicast</td>
<td>No need to resolve the remote Machine’s IP address.</td>
<td>Can wake-up only Machines on the local link.</td>
</tr>
<tr>
<td></td>
<td>Reconfiguration of routers is not required.</td>
<td>Supported by IPv6 only; IPv4 is not supported.</td>
</tr>
<tr>
<td>Unicast</td>
<td>More secure solution than directed broadcasts, because the packet is sent</td>
<td>Wake-up packets will not be able to find the target computers that have changed their subnet address since the last scheduled hardware inventory.</td>
</tr>
<tr>
<td></td>
<td>directly to the required computer rather than to all computers in the subnet.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reconfiguration of routers is not required.</td>
<td>Switches may need to be configured to forward UDP packets.</td>
</tr>
<tr>
<td></td>
<td>Consumes less network bandwidth than directed broadcast transmissions.</td>
<td>Some network adapters may not respond to wake-up packets in all sleep states when unicast is used as the transmission method.</td>
</tr>
<tr>
<td></td>
<td>Supported by IPv4 and IPv6.</td>
<td></td>
</tr>
<tr>
<td>IPv4 Directed Broadcast</td>
<td>Higher success rate than unicast with computers that frequently change their</td>
<td>Less secure solution than unicast, because an attacker could send continuous streams of ICMP echo requests from a falsified source address to the directed broadcast address causing all of the hosts to reply to that source address. This type of denial-of-service attack is commonly called a smurf attack and is usually mitigated by not allowing directed broadcasts. If your routers are configured to allow directed broadcasts, the following additional configuration is recommended for security reasons: The routers should be configured to allow only IP-directed broadcasts from the Remote Shutdown site server using the UDP port number specified on the WOL Configuration preference page. Reconfiguration of all intervening routers may be required to enable directed broadcasts. Consumes more network bandwidth than unicast transmissions. Supported by IPv4 only; IPv6 is not supported.</td>
</tr>
<tr>
<td></td>
<td>IP addresses within the same subnet.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No switch reconfiguration is required.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>High compatibility with computer adapters in all sleep states, because</td>
<td></td>
</tr>
<tr>
<td></td>
<td>directed broadcast was the original transmission method for sending wake-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>up packets.</td>
<td></td>
</tr>
</tbody>
</table>
Prerequisites of Wake-on-LAN

The following requirements should be met for the Wake-on-LAN operation to succeed:

- The Machines must be configured to respond to wake-up packets received by the network adapter and in the Machine's BIOS. See the Configuring Machines' hardware for Wake-on-LAN for details on the network adapter and BIOS configuration.

- The network adapters must support the standard Magic Packet format. See the Configuring remote Machines' Network Adapter for details on the network adapter configuration.

- Older motherboards must have a WAKEUP-LINK header onboard connected to the network adapter via a special 3-pin cable; however, systems supporting the PCI 2.2 standard and having a PCI 2.2 compliant network adapter do not usually require a Wake-on-LAN cable as the required standby power is relayed through a PCI bus. PCI version 2.2 supports PME (Power Management Events). PCI adapters send and receive PME signals via a PCI socket directly, without the need for a Wake-on-LAN cable.

- The Machines should use an ATX power supply meeting the ATX 2.01 specifications.

- The target Machine must be in the Shut Down state. That means that the AC adapter should not be turned off after the last Shut Down. For example, if the machine was switched off due to a power outage, WOL will not work. If you want to wake the Machines up from Sleep or Hibernate, you must make some additional network adapter settings. See the Configuring remote Machines' Network Adapter for details.
Prerequisites of Wake-on-LAN across different subnets (or VLANs)

You may wake up remote Machines from different subnets using Remote Shutdown with the help of each of the transmission methods (Directed Broadcast and Unicast), provided a specific set of requirements is met for at least one of the methods.

Directed Broadcast transmission method prerequisites

All routers/gateways/switches between the Remote Shutdown site server and the target Machines must allow Directed Broadcasts and must support the IPv4 protocol. This ensures that the WOL packets are not blocked.

Allowing any type of Directed Broadcast on routers/gateways/switches makes the network vulnerable to "smurf" attacks though the Internet. In a "smurf" attack, the attacker sends ICMP echo requests from a falsified source address to a directed broadcast address causing all the hosts in the target subnet to send replies to the falsified source. By sending a continuous stream of such requests, the attacker can create a much larger stream of replies, which can completely inundate the host whose address is being falsified.

To protect your network from "smurf" attacks, you may allow only certain types of Directed Broadcasts to go through the routers/gateways/switches (i.e. configure the access list). In case with Remote Shutdown Wake-on-LAN packets, you should only allow receiving UDP packets from the machine running Remote Shutdown through the port specified on the WOL Configuration preference page. The access list should be configured on all routers/gateways/switches along the Wake-on-LAN packet path.

For detailed information on configuring the access list on routers/gateways/switches, refer to the user manual provided by the hardware manufacturer.

To wake up a Machine over the Internet, an appropriate port needs to be forwarded from the WAN side to the LAN side of the router. Since a Machine that is not turned on doesn't have an IP address, the packet sent to wake the Machine needs to be forwarded to all Machines on the LAN side of the router in order to ensure it gets to the Machine it is intended for. The protocol that needs to be forwarded is UDP; it is not necessary to forward the TCP protocol. The IP address the packet needs to be forwarded to changes depending on the network mask you are using on your LAN. The default network mask is 255.255.255.0. If you are using this mask, you should forward traffic destined to your WOL port to xxx.xxx.xxx.255. If you are using the default settings of the router, this address would probably be 192.168.1.255. 255 in the address using the default network mask signifies that the router should forward any information sent to the indicated port to all computers on the LAN side. If you are using the default router settings with Remote Shutdown, simply forward all UDP traffic to the port specified on the WOL Configuration preference page to 192.168.1.255. If there is an option of specifying external and internal ports, the same port number should be used for both external and internal ports.

Unicast transmission method prerequisites
For a Wake-on-LAN operation with the help of the Unicast transmission method to succeed, the routers should have a sufficient APR (Address Resolution Protocol) cache life time, or the IP addresses of the Machines you want to wake up should be defined as static entries in the ARP cache. If they are defined as static they will never be removed from the cache. As long as the target Machine's IP address is available in the router's ARP cache, Wake-on-LAN packets are delivered successfully and the Machine can be woken up. If the IP address entry is removed from the ARP cache, it is no longer possible to deliver Wake-on-LAN packets to the target Machine using the Unicast transmission method.

Please be aware that a significant increase of the ARP cache may cause unexpected errors in the network.

Get detailed information about Wake-on-LAN using the Unicast transmission method
Retrieving MAC Addresses

To send a Wake-on-LAN package to a remote Machine, Remote Shutdown firstly should be introduced to its MAC address. Although it is possible to provide a MAC address manually while editing Machine's properties, the program provides you with a techniques of retrieving the MAC address automatically.

In case if the Wake-on-LAN operation is initiated for Machines that has no MAC address retrieved, Remote Shutdown will try to retrieve it automatically for each Machine before sending a magic packet. Only the Neighbor Discovery, IPv6 EUI-64 and DHCP methods for retrieving MAC addresses are used when getting the MAC address in a scope of the Wake-on-LAN operation, as the Machine should be turned on to be able to use the NetBIOS, WinAPI and WMI methods.

With Remote Shutdown, you can either retrieve MAC addresses for remote Machines immediately, or create a preconfigured task to run MAC addresses scan in the future, or schedule such tasks to be executed once or on a regular basis – this section will show you how to reach all these goals.

Performing MAC Address Scan

The MAC addresses are retrieved automatically for the Machines being added during the network enumeration process. If there is no access to DHCP server or the Machines retrieved are turned off, the MAC address is not retrieved, but you can retrieve it manually any time you want.

Retrieve MAC

The Retrieve MAC Address button from the Administration Ribbon group on the Remote Actions page should be used to retrieve MAC addresses for the remote Machines.

To retrieve the MAC addresses that have not been retrieved or update the already retrieved addresses, use the Retrieve MAC Address button from the Administration Ribbon group on the Remote Actions page. If the Network or the All Machines view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the Administration group from the Home Ribbon page and the corresponding group in pop-up menus and on toolbars of the Network and All Machines views. The wizard will appear on the screen and guide you through the operation configuration process.
Pic 1. Configuring a MAC address scan operation
When configuring a MAC address scan operation you can override a set of methods used for fetching MAC addresses, if required, and define a set of Machines to be operated. To learn more about the MAC address scan methods, refer to the MAC Address Retrieving Methods section. For the information on configuring a scope of Machines, refer to the Defining Machines to Operate section of this document. Once you are done with configuring the scan, press Finish to proceed. The MAC address scan operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Creating a new Retrieve MAC Address Task

If you do not want to scan Machines for their MAC addresses right now, with Remote Shutdown you can create a preconfigured task to perform scan in future, any time you want. While creating a new task, you can override a set of methods used for fetching MAC addresses, if required. To create a new Retrieve MAC Address task for further execution, you should choose the New Task > Retrieve MAC Address item from the Tasks area pop-up menu. Alternatively you can use the New Task button from the Tasks area toolbar or the Regular Task button from the New Ribbon group on the Management contextual page from the Tasks and Schedule Tools category. The New Task wizard will appear on the screen and guide you through the process of creating a new task. Once you are done with configuring the task, press Create to create it. The newly created task will be added to the Tasks area. A created task can be executed manually any time using the Run menu item from the Tasks area or scheduled for automatic execution. Remote Shutdown will store the results for all runs of this task, and you can review all of them in the Execution Results view.

Performing a MAC address scan on schedule

As it has already been mentioned, with Remote Shutdown you can run a preconfigured Retrieve MAC Address task any time you want. However, manual task execution may not be convenient for you since in such a case you would always have to remember when you should perform this or that scan. The scheduling engine integrated into Remote Shutdown can always keep this in mind for you, so that you can concentrate on your other everyday tasks.

To schedule a new Retrieve MAC Address task, you should choose the Scheduled Task > Retrieve MAC Address item from the New Ribbon group on the Home page. This option is also available in the Scheduling area pop-up menu and on the toolbar. Alternatively, you can select the Machines you want to scan for their MAC addresses in the Network or the All Machines view and choose the New > Scheduled Retrieve MAC Address Task menu item from the pop-up menu to initialize the Machine Queue with the selected Machines.

When scheduling a task, you can override the MAC address scan options, if required, and specify a set of Machines to scan for MAC addresses. Once you are done with configuring the task, press Schedule for the task to be put on schedule. The scheduled task will be added to the Scheduling area. A scheduled task is executed automatically when its start time comes. Remote Shutdown stores the results for all runs of such a task, and you can review all of them in the Execution Results view.
MAC Address Retrieving Methods

Remote Shutdown supports six methods of retrieving MAC addresses from remote Machines. The methods to be used should be specified on the MAC Address Scan preference page. It is also possible to override the methods used to retrieve MAC addresses for each standalone operation. Each method has its pros and cons and is described in detail below.

Neighbor Discovery

The Neighbor Discovery method is based on the local subnet communication protocols. Those are the Address Resolution Protocol (ARP) for IPv4 networks and the Neighbor Discovery Protocol (NDP) for IPv6 networks.

ARP is used to identify the MAC address associated with a certain IPv4 address. If a machine has a packet bound for another IP on a locally connected Ethernet network, it sends a broadcast Ethernet frame containing an ARP request to the Ethernet. That packet will be received by all machines with the same Ethernet broadcast address. If a machine receiving the ARP request hosts the requested IP, it will respond with the link layer address, at which it will receive packets for that IP address. Once the requester receives the response packet, it will start associating the MAC address with the respective IP address. That information is stored in the ARP cache, which is available on individual network adapters as well as on IP routers.

NDP is a protocol in the Internet protocol suite used with IPv6. It operates at the Network Layer of the Internet model, and is responsible for gathering various information required for internet communication, including the configuration of local connections and the domain name servers and gateways used to communicate with more distant systems.

The protocol defines different ICMPv6 packet types to perform functions for IPv6 similar to the Address Resolution Protocol (ARP) and Internet Control Message Protocol (ICMP) Router Discovery and Router Redirect protocols for IPv4. However, it provides many improvements over its IPv4 counterparts. For example, it includes Neighbor Unreachability Detection (NUD), thus improving robustness of packet delivery in the presence of failing routers or links, or mobile nodes.

IPv6 EUI-64

The IPv6 EUI-64 method is based on extracting the Machine MAC address from the IPv6 address that is generated using the Extended Unique Identifier algorithm.

NetBIOS

NetBIOS (Network Basic Input/Output System) provides services related to the session layer of the OSI model allowing applications on separate computers to communicate over a local area network.

WinAPI

Windows API is Microsoft’s core set of application programming interfaces (APIs) available in the Microsoft Windows operating systems.
WMI

Windows Management Instrumentation (WMI) is a set of extensions to the Windows Driver Model that form an operating system interface through which instrumented components provide information and notification. WMI is used to access and manage data on remote computers. Remote connections in WMI are affected by Windows Firewall and Distributed Component Object Model (DCOM) settings. Windows Firewall is enabled by default and set to block any data requests from remote Machines and callbacks resulting from asynchronous calls. The firewall and DCOM settings must be configured to allow such connections. For Windows Vista and later OS, it is also required to configure User Account Control (UAC).

⚠️ Changing DCOM settings may allow remote access to the Machine for low-rights users. Refer to the Setting DCOM Security to Allow a User to Access a Computer Remotely document for the instructions on DCOM security configuration.

DHCP

The Dynamic Host Configuration Protocol (DHCP) is an automatic configuration protocol used in IP networks. Computers that are connected to non-DHCP equipped IP networks must be configured before they can communicate with other computers in the network. DHCP allows a computer to be configured automatically thus eliminating the need for intervention by a network administrator. It also provides a central database for keeping track of computers that have been connected to the network. This prevents two computers from accidentally being configured with the same IP address. Also, this allows obtaining client information using the IP address of the client, thus, it is possible to retrieve MAC address information from the DHCP server.

Remote Shutdown can retrieve MAC addresses from a DHCP server only within network environments that use a Microsoft Windows Server machine as the DHCP server.

The DHCP servers to be used can be configured on the MAC Address Scan preference page. The servers can either be detected automatically or defined manually. The automatic server detection method uses the information about DHCP servers available on the network adapter.

Administrative privileges are required to communicate with the DHCP server. The credentials to be used to connect to the server can be defined together with the other server information when providing the servers manually. If the credentials are not provided or the automatic detection method is used, Remote Shutdown first tries to connect to the DHCP server using the credentials defined for the local domain or the current user credentials, in case the credentials for the local domain are not specified. Then, the credentials defined for other groups within the Alternate Credentials view are used if connection cannot be established due to insufficient access rights.

Methods comparison

<table>
<thead>
<tr>
<th>Method</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Neighbor</td>
<td>High processing speed. Administrative privileges on remote Machines are not required.</td>
<td>Ability to process Machines only within a local subnet.</td>
</tr>
<tr>
<td>Discovery</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPv6 EUI-64</td>
<td>Extremely high processing speed. No network communication is required.</td>
<td>Only the Machines with IPv6 addresses of specific (EUI-64) format can be handled.</td>
</tr>
<tr>
<td>Method</td>
<td>Advantages</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>NetBIOS</td>
<td>High processing speed. Administrative privileges on remote Machines are not required.</td>
<td>Ability to process Machines only within a single physical network. Requires that the NetBIOS protocol should be enabled. A Machine should be turned on for the method to succeed, thus it is not used for retrieving MAC address while performing Wake-on-LAN.</td>
</tr>
<tr>
<td>WinAPI</td>
<td>Ability to process any kind of Machine regardless of its location.</td>
<td>Lower processing speed compared to other methods. Requires administrative privileges on remote Machines. A Machine should be turned on for the method to succeed, thus it is not used for retrieving MAC address while performing Wake-on-LAN.</td>
</tr>
<tr>
<td>WMI</td>
<td>Ability to process any kind of Machine regardless of its location.</td>
<td>Requires administrative privileges on remote Machines. Turned off by default on most Machines. A Machine should be turned on for the method to succeed, thus it is not used for retrieving MAC address while performing Wake-on-LAN.</td>
</tr>
<tr>
<td>DHCP</td>
<td>High processing speed. Ability to process any kind of Machine regardless of its location. Ability to retrieve MAC addresses for Machines that are turned off.</td>
<td>The DHCP server must be available. Administrative privileges are required to connect to the DHCP server. Ability to operate only with Microsoft DHCP servers.</td>
</tr>
</tbody>
</table>
Switching Machines to Power Saving States

Remote Shutdown along with the shutdown and restart operations, allows you to put Machines to such power saving states as Sleep and Hibernate. You can either launch such operations over remote Machines immediately, or create a preconfigured tasks to put Machines to stand-by and hibernation mode in the future, or schedule a preconfigured tasks to be executed once or on a regular basis – this section will show you how to reach all these goals.

Performing Hibernate and Sleep

The process of performing hibernate and sleep operations is absolutely the same, the only difference is the initiated operation type. Let us take a closer look at this process using the hibernate operation as a reference.

<table>
<thead>
<tr>
<th>Hibernate</th>
<th>Sleep</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Hibernate button from the Power Ribbon group on the Remote Actions page should be used to turn off the remote Machines selected in the Network view or the All Machines view saving their states to RAM.</td>
<td>The Sleep button from the Power Ribbon group on the Remote Actions page should be used to switch the remote Machines selected in the Network view or the All Machines view to the stand-by mode for energy saving.</td>
</tr>
</tbody>
</table>

To switch remote Machines to hibernate power saving state, use the Hibernate button from the Power Ribbon group on the Remote Actions page. If the Network or the All Machines view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the Power group from the Home Ribbon page and the corresponding group in pop-up menus and on toolbars of the Network and All Machines views. The wizard will appear on the screen and guide you through the operation configuration process. [Pic 1]
Pic 1. Configuring a hibernate operation
When configuring a hibernate operation, you can define if you would like to wait for a specific period of time before switching to hibernation mode, choose if the notification should be displayed to a remote user and if it is allowed to cancel the hibernate. The next step is to define a set of Machines to be switched to the power saving state. For the information on configuring a scope of Machines, refer to the Defining Machines to Operate section of this document. Once you are done with configuring the operation, press Finish to proceed. The hibernate operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Creating a new Hibernate or Sleep Task

If you do not want to switch Machines to power saving state right now, with Remote Shutdown you can create a preconfigured task to perform such power management operations in future, any time you want. To create a new Hibernate task for further execution, you should choose the New Task > Hibernate item from the Tasks area pop-up menu. For the Sleep tasks, use the New Task > Sleep item. Alternatively you can use the New Task button from the Tasks area toolbar or the Regular Task button from the New Ribbon group on the Management contextual page from the Tasks and Schedule Tools category. The New Task wizard will appear on the screen and guide you through the process of creating a new task. Once you are done with configuring the task, press Create to create it. The newly created task will be added to the Tasks area. A created task can be executed manually any time using the Run menu item from the Tasks area or scheduled for automatic execution. Remote Shutdown will store the results for all runs of this task, and you can review all of them in the Execution Results view.

Performing Hibernate and Sleep on schedule

As it has already been mentioned, with Remote Shutdown you can run a preconfigured task for switching Machines to power saving state any time you want. However, manual task execution may not be convenient for you since in such a case you would always have to remember when you should perform this or that task. The scheduling engine built into Remote Shutdown can always keep this in mind for you, so that you can concentrate on your other everyday tasks.

To schedule a new Hibernate task, you should choose the Scheduled Task > Hibernate item from the New Ribbon group on the Home page. This option is also available in the Scheduling area pop-up menu and on the toolbar. Alternatively, you can select the Machines you want to switch to the power saving state in the Network or the All Machines view and choose the New > Scheduled Hibernate Task menu item from the pop-up menu to initialize the Machine Queue with the selected Machines. For scheduling a new Sleep task, use the Scheduled Task > Sleep item from the New Ribbon group on the Home page and the appropriate items in the pop-up menu. The same way, as for Hibernate tasks, you can use the New > Scheduled Sleep Task item in the pop-up menu of the Network or the All Machines view.

When scheduling a task, you can provide the operation configuration options, and specify a set of Machines to operate. Once you are done with configuring the task, press Schedule for the task to be put on schedule. The scheduled task will be added to the Scheduling area. A scheduled task is executed automatically when its start time comes. Remote Shutdown stores the results for all runs of such a task, and you can review all of them in the Execution Results view.

What's Inside

Hibernate Particular Qualities
Hibernate Particular Qualities

On Windows® computers, hibernation is available only if all hardware is ACPI and Plug-and-play compliant, and additionally all drivers are PnP-compatible. Also Hibernate feature must be turned on in the operating system power configuration. If the Hibernate mode is disabled in the Operating System of the remote Machine it will be switched to a Sleep (Standby) mode, but not into a hibernation. To get to know how to configure the Operating System on the remote Machine to support Hibernate mode refer the documentation on the Operating System itself.
Sending Messages to Remote Machines

With Remote Shutdown, you can either send messages to remote Machines immediately, or create a preconfigured task to send messages in the future, or schedule preconfigured tasks to be executed once or on a regular basis – this section will show you how to reach all these goals.

Sending off messages

The message sent to remote Machines will be displayed for all users currently logged on to remote Machines. If required, you can configure it to be closed automatically after a specific period of time.

To send a message to remote Machines, use the **Send Message** button from the **Administration** Ribbon group on the **Remote Actions** page. If the **Network** or the **All Machines** view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the **Administration** group from the **Home** Ribbon page and the corresponding group in pop-up menus and on toolbars of the **Network** and **All Machines** views. The wizard will appear on the screen and guide you through the operation configuration process [Pic 1].
When configuring a Send Message operation you can specify the message contents, choose if the message should be automatically closed in a specific period of time and provide a set of Machines to send the message to. For the information on configuring a scope of Machines, refer to the Defining Machines to Operate section of this document. Once you are done with configuring the operation, press Finish to proceed. The Send Message operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Creating a new Send Message Task

If you do not want to send a message to remote Machines right now, with Remote Shutdown you can create a preconfigured task to send it in future, any time you want. To create a new Send Message task for further execution, you should choose the New Task > Send Message item from the Tasks area pop-up menu. Alternatively you can use the New Task button from the Tasks area toolbar or the Regular Task button from the New Ribbon group on the Management contextual page from the Tasks and Schedule Tools category. The New Task wizard will appear on the screen and guide you through the process of creating a new task. Once you are done with configuring the task, press Create to create it. The newly created task will be added to the Tasks area. A created task can be executed manually any time using the Run menu item from the Tasks area or scheduled for automatic execution. Remote Shutdown will store the results for all runs of this task, and you can review all of them in the Execution Results view.

Sending off messages on schedule

As it has already been mentioned, with Remote Shutdown you can run a preconfigured Send Message task any time you want. However, manual task execution may not be convenient for you since in such a case you would always have to remember when you should send this or that message. The scheduling engine built into Remote Shutdown can always keep this in mind for you, so that you can concentrate on your other everyday tasks.

To schedule a new Send Message task, you should choose the Scheduled Task > Send Message item from the New Ribbon group on the Home page. This option is also available in the Scheduling area pop-up menu and on the toolbar. Alternatively, you can select the Machines you want to turn on in the Network or the All Machines view and choose the New > Scheduled Send Message Task menu item from the pop-up menu to initialize the Machine Queue with the selected Machines.

When scheduling a task, you can define the operation configuration, and specify a set of Machines to send the message to. Once you are done with configuring the task, press Schedule for the task to be put on schedule. The scheduled task will be added to the Scheduling area. A scheduled task is executed automatically when its start time comes. Remote Shutdown stores the results for all runs of such a task, and you can review all of them in the Execution Results view.
**Sessions Management on Remote Machines**

With Remote Shutdown, on remote Machines, you can perform such user session management operations as sign out and session lock. These operations can be launched immediately, or you can create a preconfigured tasks to perform such operations, or you can schedule preconfigured tasks to be executed once or on a regular basis – this section will show you how to reach all these goals.

**Performing Sign Out and Lock Session**

The process of performing sign out and lock operations is absolutely the same, the only difference is the initiated operation type. Let us take a closer look at this process using the sign out operation as a reference.

<table>
<thead>
<tr>
<th>Sign Out</th>
<th>Lock Session</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Sign Out</strong> button from the <strong>Session</strong> Ribbon group on the <strong>Remote Actions</strong> page should be used to sign out from all user sessions on the remote Machines selected in the <strong>Network</strong> view or the <strong>All Machines</strong> view.</td>
<td>The <strong>Lock Session</strong> button from the <strong>Session</strong> Ribbon group on the <strong>Remote Actions</strong> page should be used to lock the sessions on the remote Machines selected in the <strong>Network</strong> view or the <strong>All Machines</strong> view.</td>
</tr>
</tbody>
</table>

To sign out from user sessions on remote Machines, use the **Sign Out** button from the **Session** Ribbon group on the **Remote Actions** page. If the **Network** or the **All Machines** view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the **Session** group from the **Home** Ribbon page and the corresponding group in pop-up menus and on toolbars of the **Network** and **All Machines** views. The wizard will appear on the screen and guide you through the operation configuration process. 

Pic 1.
Pic 1. Configuring a sign out operation
When configuring a sign out operation, you can specify if the applications should be forced to close, define if you would like to wait for a specific period of time before signing users out, choose if the notification should be displayed to a remote user and if it is allowed to cancel the sign out process. The next step is to define a set of Machines to operate. For the information on configuring a scope of Machines, refer to the Defining Machines to Operate section of this document. Once you are done with configuring the operation, press Finish to proceed. The sign out operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Creating a new Sign Out or Lock Session Task

If you do not want to perform sign out or session lock on remote Machines right now, with Remote Shutdown you can create a preconfigured task to perform such session management operations in future, any time you want. To create a new Sign Out task for further execution, you should choose the New Task > Sign Out item from the Tasks area pop-up menu. For the Lock Session tasks, use the New Task > Lock Session item. Alternatively you can use the New Task button from the Tasks area toolbar or the Regular Task button from the New Ribbon group on the Management contextual page from the Tasks and Schedule Tools category. The New Task wizard will appear on the screen and guide you through the process of creating a new task. Once you are done with configuring the task, press Create to create it. The newly created task will be added to the Tasks area. A created task can be executed manually any time using the Run menu item from the Tasks area or scheduled for automatic execution. Remote Shutdown will store the results for all runs of this task, and you can review all of them in the Execution Results view.

Performing Sign Out and Lock Session on schedule

As it has already been mentioned, with Remote Shutdown you can run a preconfigured session management task any time you want. However, manual task execution may not be convenient for you since in such a case you would always have to remember when you should perform this or that task. The scheduling engine built into Remote Shutdown can always keep this in mind for you, so that you can concentrate on your other everyday tasks.

To schedule a new Sign Out task, you should choose the Scheduled Task > Sign Out item from the New Ribbon group on the Home page. This option is also available in the Scheduling area pop-up menu and on the toolbar. Alternatively, you can select the Machines you want to operate in the Network or the All Machines view and choose the New > Scheduled Sign Out Task menu item from the pop-up menu to initialize the Machine Queue with the selected Machines. For scheduling a new Lock Session task, use the Scheduled Task > Lock Session item from the New Ribbon group on the Home page and the appropriate items in the pop-up menu. The same way, as for Sign Out tasks, you can use the New > Scheduled Lock Session Task item in the pop-up menu of the Network or the All Machines view.

When scheduling a task, you can provide the operation configuration options, and specify a set of Machines to operate. Once you are done with configuring the task, press Schedule for the task to be put on schedule. The scheduled task will be added to the Scheduling area. A scheduled task is executed automatically when its start time comes. Remote Shutdown stores the results for all runs of such a task, and you can review all of them in the Execution Results view.
Locking and Unlocking Input Devices on Remote Machines

Remote Shutdown allows you to lock input devices on remote Machines and subsequently unlock them. These operations can be launched immediately, or you can create a preconfigured tasks to perform such operations, or you can schedule preconfigured tasks to be executed once or on a regular basis – this section will show you how to reach all these goals.

Performing Lock and Unlock of Input Devices

Let us take a closer look at the process of initiating the lock of input devices on remote Machines.

To lock devices on remote Machines, use the Lock Devices button from the Input Devices Ribbon group on the Remote Actions page. If the Network or the All Machines view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the Input Devices group from the Home Ribbon page and the corresponding group in pop-up menus and on toolbars of the Network and All Machines views. The wizard will appear on the screen and guide you through the operation configuration process [Pic 1].

Pic 1. Configuring a lock devices operation
When configuring a lock devices operation, you can define if you would like to wait for a specific period of time before locking devices, choose if the notification should be displayed to a remote user and if it is allowed to cancel the locking process. The next step is to define a set of Machines to operate. For the information on configuring a scope of Machines, refer to the Defining Machines to Operate section of this document. Once you are done with configuring the operation, press Finish to proceed. The lock devices operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Unlock Devices

The Unlock Devices button from the Input Devices Ribbon group on the Remote Actions page should be used to unlock the previously locked input devices on the remote Machines selected in the Network view or the All Machines view.

To unlock input devices previously locked by Remote Shutdown, use the Unlock Devices button from the Input Devices Ribbon group on the Remote Actions page. If the Network or the All Machines view is active, the selected Machines and Collections are automatically added to the operation's Machine Queue. This action is also available from the Input Devices group from the Home Ribbon page and the corresponding group in pop-up menus and on toolbars of the Network and All Machines views. The wizard will appear on the screen and guide you through the operation configuration process. During the unlock devices operation configuration, you should simply specify the scope of Machines to operate. Once you are done with configuring the operation, press Finish to proceed. The unlock devices operation will start automatically, and as soon as it is completed, you will be able to see the execution results in the Execution Results view.

Creating a new Lock Devices or Unlock Devices Task

If you do not want to lock or unlock devices on remote Machines right now, with Remote Shutdown you can create a preconfigured task to perform such input devices management operations in future, any time you want. To create a new Lock Devices task for further execution, you should choose the New Task > Lock Devices item from the Tasks area pop-up menu. For the Unlock Devices tasks, use the New Task > Unlock Devices item. Alternatively you can use the New Task button from the Tasks area toolbar or the Regular Task button from the New Ribbon group on the Management contextual page from the Tasks and Schedule Tools category. The New Task wizard will appear on the screen and guide you through the process of creating a new task. Once you are done with configuring the task, press Create to create it. The newly created task will be added to the Tasks area. A created task can be executed manually any time using the Run menu item from the Tasks area or scheduled for automatic execution. Remote Shutdown will store the results for all runs of this task, and you can review all of them in the Execution Results view.

Locking and unlocking input devices on schedule

As it has already been mentioned, with Remote Shutdown you can run a preconfigured input devices management task any time you want. However, manual task execution may not be convenient for you since in such a case you would always have to remember when you should perform this or that task. The scheduling engine built into Remote Shutdown can always keep this in mind for you, so that you can concentrate on your other everyday tasks.
To schedule a new Lock Devices task, you should choose the Scheduled Task > Lock Devices item from the New Ribbon group on the Home page. This option is also available in the Scheduling area pop-up menu and on the toolbar. Alternatively, you can select the Machines you want to operate in the Network or the All Machines view and choose the New > Scheduled Lock Devices Task menu item from the pop-up menu to initialize the Machine Queue with the selected Machines. For scheduling a new Unlock Devices task, use the Scheduled Task > Unlock Devices item from the New Ribbon group on the Home page and the appropriate items in the pop-up menu. The same way, as for Lock Devices tasks, you can use the New > Scheduled Unlock Devices Task item in the pop-up menu of the Network or the All Machines view.

When scheduling a task, you can provide the operation configuration options, and specify a set of Machines to operate. Once you are done with configuring the task, press Schedule for the task to be put on schedule. The scheduled task will be added to the Scheduling area. A scheduled task is executed automatically when its start time comes. Remote Shutdown stores the results for all runs of such a task, and you can review all of them in the Execution Results view.

**Overriding Operation Settings**

Remote Shutdown provides you with an option to configure the MAC Address Scan options and the WOL Configuration settings to be used for operating remote Machines. These options are available in the program preferences. But what if you would like to use different settings for handling specific set of Machines? The fact is that you do not need to modify the program preferences to reach this goal; hence the behavior of the scheduled tasks remains the same, you can just override the common settings for specific tasks and operations. Let us take a closer look at the settings overriding process using the WOL Configuration settings as an example.

The option of overriding the WOL Configuration settings is available on the Wake-on-LAN tab while editing task properties. To override the WOL configuration, you should check the Override WOL packets configuration option, then perform the required changes. To reset the settings to common, you can use the Reset to common link. In addition to overriding the Wake-on-LAN configuration options, it is also possible to change the default settings using the Change common configuration link. The same concept is used to override the MAC Address Scan settings both for Wake-on-LAN and MAC address scan operations. As you can see, the approach is easy and can be used to reach maximum flexibility during the operations configuration process.
Remote Agent Management

Remote Shutdown installs the agent on each remote Machine to be able to work with it in the future. This agent is a Windows service that is installed automatically when required, but you can also install it manually, control its state and uninstall it when you are sure it is no longer needed. All these options are available from the Remote Agent menu in the Network and All Machines views.

If you want to ensure the remote agent that is already installed on remote Machines is up-to-date, you can use the Update menu item from the Remote Agent menu. An update is executed only for the Machines that have the remote agent installed but it is not up-to-date. The agent won't be updated by default on Machines that have clients connected to them, therefore if you definitely want to update it anyway, you should check the Force the remote agent update option within the displayed confirmation dialog.

Another option available from the Remote Agent menu is manual agent installation. To install the remote agent, you should select the Machines you want to install the agent onto and choose the Install menu item from the Remote Agent menu.

Just as you can install the remote agent, you can also uninstall it when there is no need for it to be installed. To uninstall the remote agent, you should select the Machines you want to uninstall the agent from and choose the Uninstall menu item from the Remote Agent menu. By default, the remote agent will not be uninstalled from Machines that have clients connected to them, therefore, if you definitely want to uninstall it anyway, you should check the Force the remote agent uninstall option within the displayed confirmation dialog.

Along with installing and uninstalling, it is possible to reinstall the remote agent by choosing the Reinstall menu item from the Remote Agent menu. By default, the remote agent will not be reinstalled on Machines that have clients connected to them, therefore, if you definitely want to reinstall it anyway, you should check the Force the remote agent reinstall option within the displayed confirmation dialog.

When working with remote Machines, Remote Shutdown always starts the remote agent, but it is also possible to start it manually as well as stop it when there is no need for it to be running. To start the remote agent manually, you should select the Machines you want to start the agent on in the Network view or the All Machines view and choose the Start menu item from the Remote Agent menu. To stop the remote agent manually, you should choose the Stop menu item from the Remote Agent menu. By default, the remote agent will not be stopped if it is running on Machines that have clients connected to them, therefore, if you definitely want to stop it anyway, you should check the Force the remote agent to stop option within the displayed confirmation dialog.

The last one of the available options is the ability to restart the remote agent. To restart the remote agent, select the Machines you would like to restart the remote agent on and choose the Restart menu item from the Remote Agent menu. By default, the remote agent will not be restarted if it is running on Machines that have clients connected to them, therefore, if you definitely want to restart it anyway, you should check the Force the remote agent to restart options.

Forcing the remote agent to update, restart, stop, reinstall or uninstall will cause disconnection of all the clients working with the agent, that may lead to inconsistent operations over remote Machines.

We have done our best to cover all the aspects of the remote agent management and hope that those options will help you solve the tasks you will face while using Remote Shutdown.
Chapter 6: Tasks and Schedule

With Remote Shutdown, you can easily create a prefigured task for future execution. Furthermore, the program is provided with a powerful engine for executing tasks and scheduling their execution using the mechanism similar to that of Microsoft® Office Outlook Calendar. This ensures the same scheduling functionality that you are used to work with. The set of features connected with scheduling includes the options of scheduling both one-time and recurrent tasks, switching between different views, zooming views, a convenient navigation and the possibility of reviewing a detailed report on every task execution regardless of whether the task is scheduled or not.

Creating Tasks

Along with simply launching operations over remote Machines, Remote Shutdown provides you with an option of creating preconfigured tasks to be used in the future. Such tasks are displayed within the Tasks area and can then be scheduled for an automatic execution or executed manually. The results of such tasks execution are displayed in the Execution Results view.

You can create the following tasks:

- **Shut Down** – should be used to turn remote Machines off by performing the operating system shutdown;
- **Wake on LAN** – allows you to turn remote Machines on by sending a magic packet;
- **Restart** – should be used to restart the operating system on remote Machines;
- **Hibernate** – allows you to turn off the remote Machines saving RAM content to disk;
- **Sleep** – should be used to switch remote Machines to stand-by mode for energy saving;
- **Retrieve MAC Address** – should be used to scan remote Machines for their MAC addresses;
- **Send Message** – allows you to display a message dialog on remote Machines;
- **Sign Out** – should be used to sign out from user sessions on remote Machines;
- **Lock Session** – allows you to lock the operating system sessions on remote Machines;
- **Lock Devices** – should be used to lock the input devices on remote Machines;
- **Unlock Devices** – allows you to unlock the input devices on remote Machines previously locked by Remote Shutdown.
It is possible to create a task directly from the Tasks area using the New Task menu item from the pop-up menu or on the toolbar. The New Task Wizard will appear on the screen to guide you through the process [Pic 1].

Pic 1. Creating a new Wake on LAN task
For each task, you can provide the task name, comment and description. Providing the comment and description values can help you to mark the task as the one to be executed in the future. The other wizard steps are used to configure additional task properties, which vary depending on the task type, along with the scope of Machines to operate.

You can proceed to creating a new task on any step of the New Task Wizard by pressing Create. Any aspect of the task configuration can be changed in future by editing the created task.

Detailed information on overriding common operation settings for specific tasks is available in the Overriding Operation Settings section of this document; and for information on editing the Machine Queue, refer to the Defining Machines to Operate section.

Once you are done with configuring the task, press Create for the task to be created. The newly created task will be added to the Tasks area.

A created task can either be executed manually using the Run menu item from the Tasks area pop-up menu or scheduled for execution using the Schedule Task menu item. Both actions are also available from the Tasks area toolbar.

**Scheduling Tasks**

Along with the option of creating preconfigured tasks for operating remote Machines, Remote Shutdown comes with a range of features targeted at automated execution of preconfigured tasks on schedule. The tasks can be scheduled to be executed either once or on a regular basis. The results of such tasks execution are displayed in the Execution Results view.

You can schedule the following tasks:

- **Shut Down** – should be used to turn remote Machines off by performing the operating system shutdown;
- **Wake on LAN** – allows you to turn remote Machines on by sending a magic packet;
- **Restart** – should be used to restart the operating system on remote Machines;
- **Hibernate** – allows you to turn off the remote Machines saving RAM content to disk;
- **Sleep** – should be used to switch remote Machines to stand-by mode for energy saving;
- **Retrieve MAC Address** – should be used to scan remote Machines for their MAC addresses;
- **Send Message** – allows you to display a message dialog on remote Machines;
- **Sign Out** – should be used to sign out from user sessions on remote Machines;
- **Lock Session** – allows you to lock the operating system sessions on remote Machines;
- **Lock Devices** – should be used to lock the input devices on remote Machines;
- **Unlock Devices** – allows you to unlock the input devices on remote Machines previously locked by Remote Shutdown.

It is possible to schedule a task directly from the **Scheduling** area using the **New Task** or **New Recurring Task** menu item from the pop-up menu or on the toolbar. Another way of scheduling tasks is using the **Scheduled Task** and the **Recurring Task** buttons from the **New** Ribbon group on the **Home** page. For example, if you would like to schedule a **Wake on LAN** task, you should use the **Wake on LAN** item from the **Scheduled Task** button drop-down list. Also, it is possible to schedule a new task from any view that displays available Machines, i.e. the **Network** view or the **All Machines** view. The actions for scheduling tasks of specific types are available from the **New** pop-up menu item; so to create a new **Wake on LAN** task, you should choose the **New > Scheduled Wake on LAN Task** menu item.

Along with scheduling a new task, you can schedule the task from those already created but still not scheduled. To schedule such task, select it in the **Tasks** area and choose the **Schedule Task** menu item or press the corresponding button on the view toolbar.

In any case the wizard will appear on the screen to guide you through the process [Pic 1].
For each task you can provide a task name, comment and description. Providing the comment and description values can help you to mark the task as the one to be executed in the future. You can schedule the task to run once or on a regular basis. The task recurrence is configured using the **Recurrence** button on the same page of the wizard. The other wizard steps are used to configure additional task properties, such as the WOL settings, MAC address scan settings and the Machines to operate.

You can proceed to task scheduling on any step of the wizard by pressing **Schedule**. Any aspect of the task configuration can be changed in the future by editing the scheduled task.

To get more information on the recurrence options, refer to the **Configuring Recurrence** section. Detailed information on overriding common operation settings for specific tasks is available in the **Overriding Operation Settings** section of this document; and for information on editing the Machine Queue, refer to the **Defining Machines to Operate** section.

Once you are done with configuring the task, press **Schedule** to proceed to its scheduling. The scheduled task will be added to the **Scheduling** area [Pic 2].

![Pic 2. The Wake on LAN task in the Scheduling area](image)

A scheduled task is executed when its start time comes. It can also be executed manually using the **Run** menu item from the **Scheduling** area pop-up menu.
Configuring Recurrence

The scheduling engine of Remote Shutdown allows you to schedule recurring tasks quickly and easily. The purpose of this chapter is to introduce you to the range of the recurrence types to be used and describe each of them. The recurrence options are available from the Edit Task Recurrence dialog while the task is being scheduled.

There are four recurrence types available: Daily, Weekly, Monthly and Yearly. Let us take a closer look on each one of them.

**Daily Recurrence Type**

The Daily recurrence type should be used if the recurrence condition is based on the number of days between the task execution instances. You can choose to execute the task every N days, where N is the number of days constituting the task execution interval, or every weekday.

Example
Weekly Recurrence Type

The Weekly recurrence type should be used if the recurrence condition is based on a particular day of the week and the interval in weeks. You can choose to execute the task, for example, on Mondays and Wednesdays every second week.

Example

![Weekly Recurrence Type Example]

Monthly Recurrence Type

The Monthly recurrence type should be used if the recurrence condition is based on a particular day of the month and the interval in months. You can choose to execute the task, for example, every second Friday of every month or every sixteenth day of every third month, etc.

Example

![Monthly Recurrence Type Example]

Yearly Recurrence Type

The Yearly recurrence type should be used if the recurrence condition is based on a yearly range. You can choose to execute the task, for example, every November the sixteenth, every third Wednesday in July, etc.

Example

![Yearly Recurrence Type Example]
Task Execution Confirmations

There are three types of tasks that require confirmation before execution. Those are Past Tasks, the tasks created in the past, or those moved to the past, or the ones that have already been postponed by snooze. The execution of the first three types of tasks should be confirmed because it might be unexpected. As for snoozing, it is the process initiated when you request the scheduling engine to remind you again of the need to confirm the task execution in a defined period of time. In all these cases the Confirm Execution dialog is displayed.

Within the Confirm Execution dialog, you can choose which task to run, which task to skip and which task to snooze. Snoozing is the process that allows you to receive a reminder again in a defined period of time. The snoozed tasks are displayed with a red reminder icon over them.

The reason for the Confirm Execution dialog being displayed before the task execution is represented by one of the following icons:

- the task is either created in the past of moved to the past and is configured to ask for a confirmation before being executed.
- the task is a Past Task. It should have been executed on schedule but the program was not running, and it is configured to ask for a confirmation before being executed.
- the decision regarding the task execution was postponed by snooze and the snooze interval has elapsed.

It is possible to open each task for edit, run, skip or snooze by using the table pop-up menu in the Confirm Execution dialog.

You can change the confirmations configuration right from this dialog by choosing the Configure Execution Confirmations item from the Configuration menu. Also, it is possible to open each task for review or editing.
Importing and Exporting Tasks

With Remote Shutdown, you can easily import and export Tasks any time you want. Exported Tasks include the whole Task configuration except the scheduling data. You can export one or all of the available Tasks to use the exported data as a backup, to share data with your colleagues or simply to import the Tasks to another instance of the program.

**Import**

The **Import** button from the **Organize** Ribbon group on the **Program** page can be used to import **Tasks** from an XML file with the help of the wizard.

If you want to import **Tasks** into Remote Shutdown, press the **Import** button from the **Organize** Ribbon group on the **Program** page when the **Tasks** area is focused. Optionally, you can use the **Import** button from the pop-up menu of the **Tasks** area. The import wizard will appear on the screen to guide you through the import process [Pic 1].

![Pic 1. The Import Tasks wizard welcome page](image)
The first page of the **Import Tasks** wizard is the welcome page used to introduce you to the feature the wizard is supposed to help you with. After reading the welcome information, press **Next** to continue with import.

On the next page of the **Import Tasks** wizard, you are offered to choose the file you are going to import **Tasks** from [Pic 2]. The file path should be provided to the **Import From** field. The encoding of the XML file with Tasks is detected automatically.

[Pic 2. Choosing import source file]
After the path to the required file is provided, press **Next**. The program will check if the file contains valid Tasks data and display the parsed Tasks to choose from. In case the file contains the same Tasks that are already present in the program, they won’t be checked for import automatically. However, if you still wish to import those Tasks, you can check them manually and choose the conflicts resolution mode. If Use existing items for conflicting entries is chosen, the existing Tasks are used. Thus, when you import Tasks into the program, conflicting entries are skipped. In case Create new items for conflicting entries is chosen, conflicting entries are imported as new items. The conflicts resolution mode is also taken into account when importing the Task’s configuration data, e.g. the Collections included into the Task’s Machine Queue.

![Image of Import Tasks Wizard]

When the Tasks to import and the conflicts resolution mode have been chosen, press the **Finish** button to proceed with import. As soon as the import has been completed, the imported Tasks are added to the **Tasks** area.

**Export**

The **Export** button from the **Organize** Ribbon group on the **Program** page can be used to export the Tasks from the program to an XML file that can be used in the future for import.
To perform export, select the **Tasks** to export and press the **Export > Export Selected** button from the **Organize** Ribbon group on the **Program** page. Alternatively, you can use the **Export** item from the **Tasks** area pop-up menu. To export all tasks, you can use the **Export All** items. The **Export Tasks** wizard appears on the screen **Pic 4**.

**Pic 4. The Export Tasks wizard welcome page**
The first page of the export wizard is the welcome page used to introduce you to the feature the wizard is supposed to help you with. After reading the welcome information, press **Next** to continue with export.

On the next page of the **Export Tasks** wizard, you are offered to choose the file you are going to save the **Tasks** to and the file format options [Pic 5]. The file path should be provided to the **Export** To field. You can choose the encoding to be used for saving the **Tasks**.

![Pic 5. Configuring the export options](image)

When the file path and the export format have been chosen, press **Finish** to proceed with export. A file containing the exported Tasks will be created in the specified path. The file created during export can be used in the future to import the Tasks back to the program.

Now you are fully introduced to the Tasks export and import options available in Remote Shutdown and can use them to solve your tasks.

**Notification E-mails**

Remote Shutdown can send notification messages to a preset e-mail address on tasks start and/or finish. These messages are sent using the mailbox configuration defined on the **E-mail Options** preference page to the specified addresses. This part of the guide describes the placeholders that can be used in the templates for notification messages sent by e-mail on task start and finish, if defined on the **Notifications** preference page. The following placeholders can be used in notification e-mail messages templates defined on the **Notification Templates** preference page.

**Notification On Task Start**

The following placeholders can be used for notification messages sent on task start:

- **%TASK_NAME%** the name of the started task.
- **%LOCAL_HOST%** the name of the machine hosting the program.
- **%RUNNING_PRODUCT%** the running program name.
Tasks and Schedule

Notification On Task Finish

The following placeholders can be used for notification messages sent on task finish and containing brief information on the task execution results:

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%TASK_NAME%</td>
<td>the name of the started task.</td>
</tr>
<tr>
<td>%SUCCEEDED%</td>
<td>the number of machines processed successfully.</td>
</tr>
<tr>
<td>%WARNINGS%</td>
<td>the number of machines processed with warnings.</td>
</tr>
<tr>
<td>%ERRORS%</td>
<td>the number of machines not processed due to errors.</td>
</tr>
<tr>
<td>%CANCELED%</td>
<td>the number of machines with canceled processing.</td>
</tr>
<tr>
<td>%PROCESSED%</td>
<td>the number of machines that took part in the operation.</td>
</tr>
<tr>
<td>%SUCCEEDED_LIST%</td>
<td>the list of machines processed successfully.</td>
</tr>
<tr>
<td>%WARNINGS_LIST%</td>
<td>the list of machines processed with warnings.</td>
</tr>
<tr>
<td>%ERRORS_LIST%</td>
<td>the list of machines not processed due to errors.</td>
</tr>
<tr>
<td>%CANCELED_LIST%</td>
<td>the list of machines with canceled processing.</td>
</tr>
<tr>
<td>%PROCESSED_LIST%</td>
<td>the list of machines that took part in the operation.</td>
</tr>
<tr>
<td>%DURATION%</td>
<td>the time spent for performing the operation.</td>
</tr>
<tr>
<td>%RESULTS%</td>
<td>the per machine execution results table.</td>
</tr>
<tr>
<td>%LOCAL_HOST%</td>
<td>the name of the machine hosting the program.</td>
</tr>
<tr>
<td>%RUNNING_PRODUCT%</td>
<td>the running program name.</td>
</tr>
<tr>
<td>%PRODUCT_VERSION%</td>
<td>the current version of the running program.</td>
</tr>
<tr>
<td>%TIME%</td>
<td>the current time.</td>
</tr>
<tr>
<td>%DATE%</td>
<td>the current date.</td>
</tr>
<tr>
<td>%DATETIME%</td>
<td>the current date and time.</td>
</tr>
</tbody>
</table>
Chapter 7: Network Management

Remote Shutdown interaction with the network is designed in a way that enables a fast and easy search for Machines all over the network and their subsequent processing. Remote Shutdown saves the network structure in its database and shows it in form of a tree. Automatic scan results are displayed within the **Network** node in the **Network** view and can be used to create **Collections**. The Collections group Machines and Queries used to fetch Machines to define the scopes of Machines to be operated. All available Machines are also displayed in the **All Machines** view as long as there is any data referenced by those Machines. If the current user account does not have sufficient rights to access the remote Machines, the ability to specify network credentials comes to your help. You are enabled to provide specific credentials for both domains and individual Machines.

The purpose of this chapter is letting you know how to manage the representation of your network structure in the program, how to provide credentials to access specific Machines and how to operate remote Machines.
Configuring Machines to allow remote access

Remote Shutdown is used to manage Machines available in your network remotely, so it requires a remote access to the Machines to be enabled. The necessary requirements for the Machines to be accessed are described in the Requirements section of the document. Let us take a closer look at each one of them.

As mentioned in the requirements, NetBIOS over TCP/IP should be enabled on the network adapter. This option is configured in the WINS settings of the TCP/IP protocol configuration. In the NetBIOS settings group, you should either choose the Enable NetBIOS over TCP/IP value or leave the Default value if a static IP is used or the DHCP server in your domain is configured to enable NetBIOS.

The next requirement to check is that the File and Printer Sharing and ADMIN$ shares are enabled. In the domain environment, you can use the group policies to enable sharing (it is enabled for domain by default). As for workgroup environments, File and Printer Sharing should be enabled on each Machine separately either in the network and sharing center, for Microsoft Windows Vista and newer, or directly in the Windows Firewall for Windows XP. The ADMIN$ shares are not enabled on workgroup PCs even if you have enabled the file and printer sharing, so additional configuration steps are required. Let us take a closer look at those steps.

For Microsoft Windows Vista and newer operating systems, you should disable UAC remote restrictions. To achieve this, you should create the LocalAccountTokenFilterPolicy value and set it to 1 within the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System

You can use this Microsoft support article as a reference.

For Machines running Windows XP, you should set the Network access: Sharing and security model for local accounts policy within the Local Policies > Security Options to the Classic: Local users authenticate as themselves value. You can refer this article to learn more about this policy.

The next thing to check is that the network discovery is enabled for Machines and it is allowed to ping Machines. The ping functionality should be enabled either in Windows Firewall or in the firewall you are using on your Machines. You should also check that the firewall allows access to TCP ports 135, 139 and 445, as well as 137 and 138 UDP.

If your Machines are located in multiple subnets, you should ensure that the remote scope of outbound rules from the File and Printer Sharing and Network Discovery groups in the advanced firewall settings is set to Any for the currently applied network profile.

To check if the Machine is configured properly, you can use Windows Registry Editor and Windows Explorer. Within the registry editor, you should be able to connect to the remote registry and browse through any administrative section of the Local Machine hive, e.g. SYSTEM. Windows Explorer can be used to check access to administrative shares, such as \MACHINE\C$.
Network Enumeration

Network enumeration means adding Machines for their further processing by Remote Shutdown either via an automated scan process or manually. Automatic network enumeration can be performed using either Active Directory, Computer Browser or IP ranges enumeration. You can also add a single Machine manually, if required, or import a set of Machines from a file.

The current user credentials, just like the specified credentials, might not give access to the Active Directory data during an automatic network enumeration process. In such case, an authentication dialog is displayed to input the credentials for the domain being connected to. The Remember my credentials option allows saving the provided credentials as the credentials for this domain. If this option is not enabled, the provided credentials are cached for the current session only.

This chapter contains a detailed description of the network enumeration process and of all the options you can specify for this process.
Enumerate Machines Wizard

The Enumerate Wizard Pic 1 is designed to provide you with a single entry point for adding Machines to the program and is intended to make the process of building the network structure quick and easy. It allows performing an automatic network scan, enumerating an IP range and importing Machines to the program.

Enumerate Machines

The Enumerate Machines button from the Network Ribbon group on the Home page and from the Enumeration Ribbon group on the contextual Network page should be used to display the Enumerate Machines wizard, which can help you with adding Machines to the program for further processing.

After Remote Shutdown has built the network structure, it can be used to operate remote Machines and create Collections for further processing. The Enumerate Machines wizard welcome page Pic 1 displays built-in help information on when this wizard should be used and how it may help you, as well as a warning of possible situations that might be unexpected for you.
During the first step, you are offered to specify the method to be used for fetching Machines. You can choose among scanning the network automatically, enumerating an IP range and importing Machines from a file.

If you have chosen the **Scan Network** option, on the next page you are required to specify the scope of operation for the automatic enumeration process. You can scan the entire network or only particular Groups for available Machines. When scanning specific groups, it is possible to define a filter condition to constrict the scope of fetched Machines. See the **Network Scan** topic for details. Having selected the appropriate options, press **Finish** to proceed with enumeration.
If the **Enumerate IP Range** option is chosen, you are offered to specify the environment options, the Group to add Machines to and the IP range to scan. See the **IP Range Enumeration** section for details. Having specified the required configuration options, press **Finish** to proceed.

![Enumerate IP Range](image)

**Pic 4. Configuring the IP range enumeration**
In case you have chosen the **Import** option, the routine to follow is the same as used for import with the help of the **Import Machines** wizard.

After you have passed all the steps of the **Network Enumeration Wizard** and pressed the **Finish** button, the process of adding Machines to the program is initiated. As soon as it is completed, you can see the result within the **Network** view (Pic 5).

The added Machines can be processed in the future with Remote Shutdown and used for creating Collections for further processing.
Network Scan

Network scan is an automated process of searching a network for available remote Machines to be later processed by Remote Shutdown. The scan is performed in accordance with the specified enumeration options. The network scan feature is available via the Enumerate Machines wizard, the Scan Network button within the Network Ribbon group on the Home page, and the Enumeration Ribbon group on the contextual Network page. These actions are available from the toolbar and the pop-up menu of the Network view.

Two modes of network scan are available; those are Enumerate New and Enumerate. In the Enumerate New mode, the program only performs a search for new Machines without removing those that were not found during the scan process. Also, the automatic MAC address scan is executed only for new Machines and the found ones that have not been scanned for MAC address yet. The Enumerate mode means that the program performs a scan for Machines, removing those that were not found during the scan process from the Network node. All found Machines are scanned for their MAC addresses.

The network scan available in the Enumerate Machines wizard and the Scan Network dialog is performed in the Enumerate mode, thus the Machines that are not found during the enumeration process are removed from the Network node.

| Scan Network | The Scan Network button from the Network Ribbon group on the Home page and from the Enumeration Ribbon group on the contextual Network page should be used to scan the entire network or specific Groups for Machines and add them to the program for further processing. |
| Enumerate | The Enumerate button from the Enumeration Ribbon group on the contextual Network page should be used to scan the selected containers for Machines removing those not available during the enumeration process. |
| Enumerate New | The Enumerate New button from the Enumeration Ribbon group on the contextual Network page should be used to scan the selected containers for Machines leaving those not available during the enumeration process. |

The pane for configuring network enumeration displayed within the Enumerate Machines wizard and the Scan Network dialog, allows you to specify the enumeration scope [Pic 1]. Here you can specify if you wish to search for Machines available in the entire network or in particular Groups only.
Pic 1. Configuring the network scan process
As for the entire network enumeration, the program tries to detect all the Groups available in the network and fetch all Machines from those Groups. If you only want to scan specific Groups, they should be checked within the Group list. The Refresh button should be used to synchronize the Group list displayed with the current network state. If the Group you want to scan cannot be detected automatically, you can add it to the list of groups by typing its NetBIOS name to the Add Group field on the toolbar and pressing the + button.

When scanning specific Groups only, it is possible to define a filter condition used for constricting the scope of fetched Machines. If the query condition is left empty, all Machines from the checked Group will be queried. To specify the condition, you should either double-click the required Group or select it and press the Edit Filter button on the toolbar. The filter condition editor is similar to the filter editor used for data filtering. The condition can be applied to the Machine name, the Container and the Last Logon timestamp. The Container condition should contain the Active Directory container path, where '\\' is used as a separation for path elements, e.g. Computers\Office 203. If the container name contains the '|' character, it should be replaced with '\\'.
The specified condition, if any, can be reviewed without opening the filter editor by expanding the row displayed under each group. You can expand and collapse this preview by either double-clicking the preview row or using the arrow on the right of the row. If you are not interested in this preview, you can hide it by disabling the **Show Details** option in the **Configuration** menu.

As soon as you have configured the network scan process to fit your needs, press the **Scan** button and the scan will be initiated. As a result, the **Network** node is filled with Machines found during the scan [Pic 3].

![Pic 3. The result of an automatic network enumeration](image)

When the program is already introduced to the network structure, you can enumerate any group or active directory container by selecting it and pressing the **Enumerate** or **Enumerate New** button from the **Enumeration** Ribbon group on the contextual **Network** page. Use the corresponding items in the pop-up menu or the **Enumeration** button on the toolbar. This approach can be used to enumerate specific containers with a single click.

The fetched Machines can be processed in the future with Remote Shutdown and used for creating Collections for further processing.
IP Range Enumeration

Remote Shutdown provides you with an option of adding Machines to the program by enumerating a specific range of IP addresses. Each IP address from the range is resolved to a host name and, in case of a successful reverse name resolution, the Machine is added to the Network node. The resolving method can be optimized for different environments. The Group for each Machine can also be detected automatically or defined manually.

Add IP Range

The Add IP Range button from the Network Ribbon group on the Home page and from the Enumeration Ribbon group on the contextual Network page should be used to add Machines to the program by scanning a specific range of IP addresses.

To add Machines via an IP Range, you should either press the Add IP Range button from the Network Ribbon group on the Home page or from the Enumeration group on the Network page. Alternatively, you can choose an appropriate option within the Enumerate Machines wizard.

Pic 1. Configuring an IP range enumeration
When preparing for an IP range enumeration, you are proposed to choose the network environment type, define if the Group to add Machines to should be determined automatically, and provide the IP range to be enumerated. As soon as you have provided the required settings, press the **Add** button to proceed with the scan process.

### How should I configure the IP range enumeration?

Remote Shutdown stores remote Machines by their host names, so when Machines are added via an IP range, a reverse name resolution is performed. To improve the performance of the reverse name resolution process and the ability to detect a Group for each Machine automatically, you should choose a proper environment configuration before performing an IP range enumeration. The environment is the first and the most important thing to specify for a successful enumeration.

The **Domain** environment type should be chosen, if the Machines from the specified range are part of an Active Directory domain infrastructure. It is supposed that a proper DNS server configuration is available in such a case, so the reverse name resolution process can be optimized by querying the DNS server only. Similarly, if you have chosen an automatic Group detection for each Machine, it is supposed that the group information is available in the Active Directory database and is accessible from the PC Remote Shutdown is running on.

The **Workgroup** environment type should be used if you are using a simple Windows network with Machines joint into a workgroup, so there is no Active Directory database available and no time should be spent on finding a domain controller for each Machine. For such environments, NetBIOS name resolution techniques are used and each Machine is connected to for detecting its Group automatically. The process can be optimized by enabling the remote Machines availability detection by using pings on the **Scan Settings** preference page. In case the remote Machines ping is not enabled in your environment, this option should be disabled.

The next thing to specify is the Group the remote Machines should be added to. It is strongly recommended to use the automatic groups detection by choosing the **Detect Group for each Machine automatically** option, because in such a case there should be no conflicts between the IP range and the network scan enumeration methods. Besides, this approach will secure a proper behavior when applying the network credentials. However, if you are sure that all Machines from the specified range belong to the same Group, you can switch to the **Add all Machines to the specified Group** option and fill in the **Group Name** field. In such a case, the automatic Group detection will be skipped, thus the overall range enumeration performance may be increased.

Finally, after you have specified the range to be scanned in the **Start IP** and **End IP** fields, you can proceed with the enumeration process.
Adding Machines Manually

Remote Shutdown provides you with an option of adding Machines to the program manually by using the Add Machine command. This action can be found in the Network Ribbon group on the Home page or in the Enumeration Ribbon group on the Network contextual page.

Add Machine

The Add Machine button from the Network Ribbon group on the Home page and from the Enumeration Ribbon group on the contextual Network page should be used to add a single Machine to a specific group for further processing.

The Add Machine dialog will be displayed on the screen for you to provide the required data for the Machine to be added. The first thing to specify is the name of the group the new Machine(s) will be added to. You can specify it manually in the Group Name field or click and select one from those detected automatically as available in the network. The next step is specifying the name for the Machine to be added in the NetBIOS Name field. Optionally, you can also provide a comment and a description to be set for the Machine.

![Add Machine dialog](image)

Pic 1. Adding a single Machine

After the required fields have been filled, press the Add button to proceed with the addition process. The Machine with the defined name will be added to the specified group in the Network node.

Collections

A Collection either groups a set of static Machines or defines the method and conditions for fetching Machines to be operated dynamically. It is a component for building a Machine Queue that describes the scope of Machines to be processed by any operation in Remote Shutdown.
In this chapter, we will provide a detailed description of a Collection structure and review the Collections management process to help you understand the idea of Collections and benefit from using them in your everyday work.

**Collections Overview**

A Collection is a component for building a **Machine Queue** that describes a scope of Machines to be processed by any operation in Remote Shutdown. It consists of Machines and/or Queries that define a set of Machines to be retrieved dynamically.

Each Query in a Collection defines a condition to fetch Machines from a single Group. It is possible to check the Machine name and the Active Directory Container the Machine is from for satisfying any condition. The querying source defines if the Machines from a specific Group should be fetched from those available in the program database, or a network scan of the Group should be performed to fetch the Machines that match the specified condition.

The main advantage of using Queries in Collections instead of a set of static Machines is that such Collections can reflect the changes made to the network environment automatically. For instance, if you use a Collection to group Machines from a specific Organization Unit, you'll have to modify this Collection every time you add Machines to or remove Machines from this Organization Unit, whereas if Machines from that unit are fetched by a Query in the Collection, no changes to that Collection are required to reflect the changes in Active Directory.

Remote Shutdown allows you to set a **Machines Filter** on each Collection, which enables you to filter Machines by their data, e.g. the operating system, the platform, etc. The Machine Filter is applied to both static Machines and those fetched via Machine Queries.

You can create Collections within a program scope or separately for a specific operation. The Collections defined within a program scope are displayed under the **Collections** node in the **Network** view and can be reused in multiple operations. Collections that are defined for specific operations are called embedded Collections and are available only in a specific Machine Queue. The advantage of using Collections defined within in a program scope is obvious. You can include them to the Machine Queues of different tasks and then only change the Collection itself, if required. The task's Machine Queue will reflect the changes to the Collection automatically, so you do not need to reconfigure multiple tasks that should operate the same scope of Machines when the scope changes. You can also easily create new tasks for operating this scope of Machines.

When you start any operation with only standalone Machines and/or Queries selected, an embedded Collection is automatically created in the Machine Queue to group those Machines and/or Queries, so that you can combine those Machines with the Machines provided by other Collections.

For details on creating and editing Collections, refer to the **Collections Management** section of this document, and detailed information on possible Machines filters is available in the **Machines Filter** section.
Collections Management

A Collection is a component for building a Machine Queue that describes the scope of Machines to be processed by any operation in Remote Shutdown. It either groups a set of static Machines or defines a method and conditions for fetching Machines to be operated dynamically. In this section of the document, we will describe how to create and configure Collections within the program scope. Management of embedded Collections defined within the scope of a single Machine Queue is the same; the only difference is that they are stored locally within the Machine Queue.

<table>
<thead>
<tr>
<th>Collection</th>
<th>New</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Collection</strong>&lt;br&gt;The Collection button from the New Ribbon group on the Home page should be used to create a new Collection to group static Machines and Queries to fetch Machines dynamically.</td>
<td><strong>New</strong>&lt;br&gt;The New button from the Collections Ribbon group on the contextual Network page should be used to create a new Collection to group static Machines and Queries to fetch Machines dynamically.</td>
</tr>
</tbody>
</table>

To create a new Collection, you can use the Collection button from the New Ribbon group on the Home page or the New button from the Collections group on the contextual Network page. Alternatively, you can use the New Collection menu item from the Network view pop-up menu and the Collections button drop-down from the toolbar. You can also use the New Collection option of the Add to Collection drop-down to create a Collection initializing it with the selected Machines and Queries. In any case, the New Collection dialog will appear on the screen to configure the Collection being created. [Pic 1]
Pic 1. Choosing the Collection members
The Collection editor consists of four tabs. The **Properties**, **Members** and **Filter** tabs are used to configure the Collection being created. The **Machines Preview** tab allows previewing the set of Machines defined by the Collection.

On the **Properties** tab, you are supposed to specify the common Collection properties such as the Collection name, comment and description. It is recommended that the comment and description fields be filled in to easier distinguish this Collection from others in the future.

The **Members** tab is used to specify the set of Machines and Queries included into the Collection and to configure the querying options. It is divided in two parts: the tree of Machines and Queries available in the program and the tree of Machines and Queries from the Collection being edited. The available Machines are grouped, and you can choose from the Machines available in the **Network** view, the **All Machines** view and other Collections. In addition, if there are any Machines and/or Queries in the clipboard, they are displayed under the **Clipboard** group within the **Additional Sources** node. If you have expanded the available Machines scope to include imported Machines or those found during the enumeration, the **Additional Sources** node also contains the **Enumerated** node where you can find those Machines. The Machines that are already in the Collection being edited are automatically filtered out from those available and shown again when removed from the Collection. Within the **Collection Members** part, standalone Machines are grouped within the **Static Machines** node and Queries are grouped within the **Machine Queries** node.

To add Machines to the Collection, you should check them in the **Available Sources** part and press the button with a single right arrow. The checked Machines will appear in the **Collection Members** part and disappear from the **Available Sources** part. You can also add all available Machines to the Collection being edited by using the button with a double right arrow.

Queries can be copied from **Available Sources** to **Collection Members** the same way as Machines. It is also possible to create new Queries using the **New Machine Query** button and edit queries and query options using the Edit button on the **Collection Members** part toolbar. Each query retrieves Machines from a single Group depending on the specified query conditions. Those conditions should be defined within the Machine Query editor **Pic 2**.
Within the Machine Query editor, you can provide the query name, the group to query Machines from and the query conditions. Optionally, you can also specify a comment and a description for the query. The group is chosen from the drop-down list of available groups. It is also possible to add a new group and configure the credentials to be used for connecting to Active Directory using the button on the right of the groups list. After pressing this button, the Select Group dialog is displayed.
In the **Select Group** dialog, the tree of available groups is displayed along with the credentials to be used to connect to Active Directory. You can provide and reset the credentials the same way as for the **Credentials** view. It is also possible to add a new group by typing its name into the Add Group field and pressing the † button. You can check the provided credentials and build the network structure using the **Build Structure** button on the **Credentials** toolbar. After all the required groups have been added and the credentials have been specified, press the **OK** button to proceed.

After you provide the Machine Query name and the group to retrieve Machines from, you should define the query condition, if required. If the query condition is left empty, all Machines will be queried from this group. The query condition editor is similar to the **filter editor** used for data filtering. The condition can be applied to the Machine name, the Container and the Last Logon timestamp. The Container condition should contain the Active Directory container path, where ‘\’ is used as a separation for path elements, e.g. *Computers\Office 203*. If the container unit name contains the ‘\’ character, it should be replaced with ‘\\’.

On the **Machines Preview** tab page, you can execute a query by pressing the **Preview** button. The Machines fetched by the query will be displayed within the **Machines** part, and the **Log** part will show if there have been any problems while executing the query.

Machine Queries can fetch Machines either from the network or from the program database. The default querying source is defined on the **Collections Settings** preference page, but you can override the behavior for specific collections using the querying options group at the bottom of the **Members** tab and ticking the **Override querying configuration** checkbox.

To remove Machines or Machine Queries from the Collection being edited, select them in the **Collection Members** part and press the **Delete** button from the toolbar. The selected Machines will disappear from the **Collection Members** part and appear in the **Available Sources** part. The Machine Queries will simply be removed.

All the Machines grouped within a Collection, both static and those fetched via Machine Queries, can be filtered by their properties such as the operating system version and type, the platform, etc. The condition to be used for filtering is defined on the **Filter** tab (Pic 4). Refer to the **Machines Filters** section of this document for details.
Pic 4. Configuring the Machines Filter
After a Collection has been configured, you can press the **Preview** button to execute all the queries and apply all the filters and review the effective set of Machines defined by this Collection on the **Machines Preview** page (Pic 5).

![Pic 5. Reviewing the effective set of Machines](image)

Copyright © 2001-2019 EMCO. All rights reserved.
During the Collection editing process, you can expand the scope of available Machines by using the **Expand Scope** button on the toolbar and from the pop-up menu. The **Expand Scope** wizard is similar to the **Enumerate Machines** wizard, the only difference being that Machines are added to the **Available Sources** part.

Press the **Create** button to proceed with creating the Collection. After the Collection has been created, it can be found in the **Network** view under the **Collections** node. It can be added to a Machine Queue of any operation.

To edit a Collection, if required, you can select it and choose the **Edit** button from the **Organize** Ribbon group on the **Program** page, the **Edit** menu item or the **Edit** button on the toolbar. Alternatively, you can just double-click the Collection. When a Collection is edited, the configuration process is the same as during the Collection creation. When a Collection is no longer needed, you can delete it. To delete a Collection, select it and choose the **Delete** button from the **Organize** Ribbon group on the **Program** page, the **Delete** menu item or the **Delete** button on the toolbar. It is also possible to delete any item from an existing Collection. After a Collection has been deleted, it is also removed from all Machine Queues it was used in.

With Remote Shutdown it is really easy to transfer and back-up Collections. You can use the well-known drag/drop and copy/paste techniques, simply duplicate **Collections** and export/import them. You can also copy a Collection from this or another EMCO program and paste it into the Collections node. Export and import can also be used to share and back up Collections; refer to the Importing and Exporting Network section for details.

---

| Create Snapshot | The **Create Snapshot** button from the **Collections** Ribbon group on the contextual **Network** page should be used to create a snapshot of a Collection containing the currently effective set of Machines defined with this Collection. |
| Preview | The **Preview** button from the **Collections** Ribbon group on the **Network** contextual page allows you to review the currently effective set of Machines defined with the selected Collection. |

A Collection defines a set of Machines to operate using Queries. Each Query defines a group to fetch Machines from and the conditions to be used. Filtering may also be applied to a Machines scope. However, it may sometimes be useful to work with standalone Machines currently defined with the Collection. To resolve this issue, the Collection Snapshots are introduced. For each Collection, there can be only one snapshot representing its most relevant result. Snapshots are displayed under the **Collections' Snapshots** node in the **Network** view. To create a snapshot from a Collection, you should select this Collection and either click the **Create Snapshot** button from the **Collections** Ribbon group on the contextual **Network** page or choose the corresponding item from the pop-up menu or the **Collections** button drop-down on the toolbar. All the queries defined in the Collection will be executed, all the filter conditions will be applied, and the snapshot containing the currently effective set of Machines will be added to the **Collections' Snapshots** node. The query log becomes available on the process completion in the **Application Log** view.

As it has already been mentioned, you can preview the effective set of Machines while editing a Collection, but it is not required to open the Collection for editing to review it again. You can simply select the Collection and either click the **Preview** button from the **Collections** Ribbon group on the contextual **Network** page, or choose the corresponding item from the pop-up menu or the **Collections** button drop-down on the toolbar. The effective machines set preview will be opened in a new window and displayed in the same manner as when editing a Collection.
Add to Collection

The Add to Collection button from the Collections Ribbon group on the contextual Network page should be used to add the selected Machines and/or Machine Queries to a new or an already existing Collection.

The Collection editing process is not the only way to add Machines and Machine Queries to any Collection. Remote Shutdown allows you to add the items you have selected within the Network or the All Machines view to any Collection. Simply select those items and choose the required Collection from the Add to Collection pop-up menu. The pop-up menu displays only the first ten Collections. If the required Collection is not displayed and you have more Collections to display, you can click the Choose Collection item under the Collections list and choose the required Collection through the dialog where all the Collections are displayed. To create a new Collection based on the selection, choose the New Collection item under the Collections list. It is also possible to copy Machines and Queries from any view and paste them into any Collection, as well as cut them from any Collection and paste them into another one. The drag-and-drop feature is fully supported, too. You can even import items into a Collection by selecting this Collection and either pressing the Import button from the Organize Ribbon group on the Home page or choosing the corresponding menu item from the pop-up menu.

We've done our best to make the Collections management both easy-to-use and flexible, and we hope you'll be able to solve your management tasks without any difficulties and with full understanding of the process.
Machines Filter

Collections allow defining to define a set of static Machines and Queries for retrieving Machines from specific Groups with an ability to filter fetched Machines by their name and location in an Active Directory database. Remote Shutdown also enables you to filter the defined static Machines and the resulting set fetched by all the Queries defined in a Collection by applying conditions to remote Machines' properties. The Machines filter is defined on the Filter tab when editing a Collection [Pic 1].
The Machines filter editor is similar to the filter editor used for filtering data in trees and tables. You can combine any number of conditions, as well as groups of conditions, with or and and operators. You can filter by the following Machine properties: the operating system version, the operating system type, the service pack, the platform and the language.

By default, to get the most relevant filtering results, the program tries to connect to each remote Machine to refresh the properties used for filtering before checking the condition, but you can allow the program to use cached property values. The Machines filter options used by default for all Collections are defined on the Collections Settings preference page. It is also possible to override those options for a specific Collection, if required. To override the default options, expand the filtering options group on the Filter tab while configuring the Collection and tick the Override filtering configuration checkbox.

For the Wake-on-LAN operation the program assumes that the Machine is turned off, so the properties are not refreshed and the cached values are always used.

In case the filters preview is enabled in a view, the Machines filter, if defined, can be easily reviewed by expanding the preview row of the Collection node. Therefore, you do not need to edit the Collection to see if there is any condition defined and which condition is defined.

Credentials

The credentials to be used for connecting to remote Machines are provided in the Credentials view and stored between the program sessions. Thus, you can specify the credentials once for Machine, Group or Network, and they will be applied automatically when required.

Although the credentials are stored in a strongly encrypted state, it is still possible for an intruder to decrypt the credentials.

Credentials set on the Network item are used to set the same credentials for all the Machines in the network.

Credentials defined for an individual Group are used when several domains or workgroups with different administrative accounts are present in the network.

The function of specifying credentials for an individual Machine is mainly used to set credentials for separate Machines with unique accounts in the network.

Providing Credentials

Remote Shutdown allows you to specify credentials both for groups of Machines and for individual Machines in the Credentials view using in-place editors. It is also possible to import credentials from a file or copy them from another EMCO program. Credentials can be provided with or without explicit specification of the domain. The domain may be specified by using the User Principle Name or Down-Level Logon Name.

User Principal Name

The User Principal Name (UPN) format is used to specify an Internet-style name, such as UserName@Example.Emco.local. The following table summarizes the UPN components.

<table>
<thead>
<tr>
<th>Component</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>User account name. Also known as the logon name.</td>
<td>UserName</td>
</tr>
<tr>
<td>Component</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Separator. A character literal, the at sign (@).</td>
<td>@</td>
</tr>
<tr>
<td>UPN suffix. Also known as the domain name.</td>
<td>Example.Emco.local</td>
</tr>
</tbody>
</table>

A UPN can be defined implicitly or explicitly. An implicit UPN has the following form: **UserName@FQDN**. An explicit UPN is always associated with the user’s account, even if an explicit UPN is not defined. An explicit UPN has the form **Name@Suffix**, where both the name and suffix strings are explicitly defined by the administrator.

### Down-Level Logon Name

The down-level logon name format is used to specify a domain and a user account in that domain, for example, **DOMAIN\UserName**. The following table summarizes the components of a down-level logon name.

<table>
<thead>
<tr>
<th>Component</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>NetBIOS domain name.</td>
<td>DOMAIN</td>
</tr>
<tr>
<td>Separator. A character literal, the backslash ().</td>
<td>\</td>
</tr>
<tr>
<td>User account name. Also known as the logon name.</td>
<td>UserName</td>
</tr>
</tbody>
</table>

Beside an explicit domain specification, you can use an implicit one by providing the Down-Level Logon Name with the '.' character instead of the domain part (**\UserName**). In such case, the '.' character is replaced by the NetBIOS name of the Machine to connect to.

If the user name is provided without an explicit or implicit domain specification, the program generates one of the user name formats described above using the following rules:

- If credentials are specified on the Machine node, the following Down-Level Logon Name is generated for connection: **MACHINE\UserName**, where **MACHINE** is the NetBIOS name of the Machine the program is connecting to and **UserName** is the specified user name.

- If credentials are specified on the Network or Group node, than the group the Machine is located in is used to form the user name used for connection. If the group is an Active Directory domain, then the following UPN name is formed: **UserName@FQDN**, where **UserName** is the specified user name and **FQDN** is a fully qualified name of the domain the Machine is located in. In case the group is not an Active Directory domain, the following Down-Level Logon Name is generated for connection: **DOMAIN\UserName**, where **DOMAIN** is the NetBIOS name of the group the Machine is located in and **UserName** is the specified user name.
You can easily review the credentials that are going to be used for connecting to the remote Machine in the tool tip displayed for this Machine in the **Credentials** view.

### Examples for Credentials specification

Specifying credentials for complex network environments may not be a trivial task, and this chapter is written to show you some examples that can help you with this task. Let's assume we have the following network structure:

Consider the following methods of setting the credentials:

1. The credentials are set for the *Network* item. Connection to remote Machines and Active Directory will take place using the credentials set for the Network.
Same Credentials for Entire Network

2. Two different credentials are set for the *Emco* and *Dev* groups. Connection to remote Machines from the *Dev* group will take place using the credentials set for the *Dev* group, Machines from the *Emco* group will be processed using the credentials set for the *Emco* group.

Specific Credentials for Groups

3. Three different credentials are set for the *Network*, the *Dev* group and the *Dev-PDC* Machine. Connection to remote Machines from the *Emco* group will take place using the credentials set...
for the Network, the Dev group will use the credentials specified for the Dev group and for Dev-PDC the credentials set for Dev-PDC will be used.

Specific Credentials for Groups
EMCO Remote Shutdow n Enterprise 6

Netw ork Management

How do I access another domain?
By default, the credentials used for a Machine are applied as credentials for the domain where the
remote Machine is located. It is displayed in the Log on to field of the credentials edit. In case you
need to use the remote Machine's local account or the account from a domain that differs from the
one provided by default, you should explicitly specify the Machine or the domain where the account
is located in the user name. The Log on to field value is then changed to give you a clear
understanding of which domain credentials are used.
The Log on to field displays, by default, the name of the domain where the network resource
is located. If you explicitly specify a certain account, this field shows the domain or computer
name for the account you are using. Thus, it always displays actual information about the
domain to be used to establish connection.
To do the actions described above, you should input the value in the following format to the User
Name field of the credentials pop-up edit:
<Username>@<FQDN> - for an explicit specification of an Active Directory domain account,
where 'FQDN' is a fully qualified name of the domain.
<Domain name>\<User name> - for an explicit specification of a domain account, where 'Domain
name' is a NetBIOS name of the domain to be used.
<Machine name>\<User name> - for an explicit specification of a remote Machine account.

Pic 1. Providing the specific domain credentials

Now you know how to provide the credentials to be used from a specific domain and can configure
network credentials without any difficulties.

Copyright © 2001-2019 EMCO. All rights reserved.

176


Defining Machines to Operate

Each operation in Remote Shutdown is represented with a Machine Queue, which describes the scope of Machines to be operated, and an operation-specific configuration, which defines what exactly should be made with those Machines. A Machine Queue consists of Collections. Each Collection either groups a set of static Machines or defines the method and conditions for fetching Machines to be operated dynamically.

You can either use the Collections defined in the program scope for filling in the Machine Queue or create embedded Collections for the Machine Queue, or combine both methods. When any operation for the selected standalone Machines and/or Queries is launched, the embedded Collection containing those items is created automatically and added to the Machine Queue. A Machine Queue is configured before executing an operation or while configuring a task Pic 1.
The pane used for configuring a Machine Queue has the following tab pages: **Machine Queue** and **Machines Preview**. The **Machine Queue** page is used to define the Collections to be included into the Machine Queue being edited. You can add Collections defined in the program scope using the **Link** item from the pop-up menu or from the toolbar. To create a new embedded Collection, you can use the **New Embedded Collection** item from the pop-up menu. The embedded Collections created while editing the Machine Queue exist as long as the corresponding Machine Queue and cannot be used in other Machine Queues. You can edit Collections and Queries using the **Edit** button on the toolbar or the **Edit** item in the pop-up menu. To delete a Collection from a queue, select it and press the **Delete** button on the toolbar or choose the **Delete** item from the pop-up menu.

You can review the effective set of Machines defined with the Collections added to the Machine Queue using the **Preview** button and menu item. While preparing for a preview, all Queries are executed and filters are applied, the Collections are merged and the resulting set of Machines to be operated is formed and displayed on the **Machines Preview** tab.

Now that you have been introduced to the Machine Queue concept, you should be able to configure the scopes of Machines to be operated without any difficulties and benefit from reusing the Collections defined in the program scope.
Remote Machine Statuses

Remote Shutdown is used to operate remote Machines, so the status of access to each remote Machine is important information. When activated, Remote Shutdown determines the access status for each remote Machine and stores it in the program database together with the last access time, so you can always see this information when required.

**Check State**

The **Check State** button from the **Machines** Ribbon group on the contextual **Network** page should be used to refresh the access status of the selected remote Machines.

The access status of each remote Machine is displayed in the **Access Status** column of the **All Machines** view. [Pic 1]

![Pic 1. Remote Machine statuses displayed in the All Machines view](image)

The remote Machine status can be represented by one of the following values:

- **[Indefinite]** - the access status of the Machine is indefinite – you can press the **Check State** button from the **Machines** Ribbon group on the contextual **Network** page or choose the **Check State** item from the pop-up menu to check the Machine’s access status;
- **Accessible** - the Machine is accessible, i.e. it satisfies the requirements for remote Machines and can be operated;
- **Agent Not Running** - the Machine is accessible and the remote agent is installed, but it is not running;
- **Agent Running** - the Machine is accessible, the remote agent is installed and running;
- **Agent Update Required** - the Machine is accessible, the remote agent is installed, but it is not up-to-date;
- **Agent Unreachable** - the Machine is accessible, but the remote agent is unreachable: either it is impossible to check state of the remote agent, or it fails to start;
- **Offline** - it is currently impossible to connect to this Machine, i.e. the Machine is offline;
- **Inaccessible** - the Machine is inaccessible, i.e. it is currently impossible to operate this Machine;
- **Access Denied** - the access to the remote Machine is denied; to operate this Machine, you should provide the administrative credentials in the **Credentials** view;
Client Not Supported - the operating system installed on the Machine is no longer supported.

The remote Machine status is also displayed in the right bottom part of the Machine icon in the **Network** view and in the **Machine Queue** pane, so you can easily see it from any view displaying remote Machines. The information on the access status and the last access time, if any, is also available in the tooltip for each remote Machine.
Network Objects Properties

Every network object contained within the network structure available in the Remote Shutdown has a number of properties. Most of the properties are detected during the **network enumeration** process and are overridden during every enumeration. Unlike this, the description property is used to enable the end user to provide some information that will be stored permanently for this object. To review and change the object properties, you should select this object in any view and press the **Edit** button from the **Organize** Ribbon group on the **Home** page. This action is also available in the pop-up menu of a view. Let us review the range of properties available for each type of objects.

**Group Properties**

The Group properties consist of the **DNS Name**, **NetBIOS Name**, **Comment** and **Description**. The **NetBIOS Name** and **DNS Name** fields are maintained automatically and cannot be changed manually.

![Pic 1. Group Properties](image-url)
The full DNS name and comment are filled automatically during every scan if the group is an Active Directory domain. The provided description is always specified manually and can be used as information for this Group to permanently store in the program database.

**Active Directory Container Properties**

The Active Directory container properties consist of the **Name**, **Comment** and **Description**. The **Name** field for the **Active Directory** container is maintained automatically and cannot be changed manually.

![Pic 2. Active Directory Container Properties](image-url)
The object name and the comment are retrieved from the Active Directory during an automated network enumeration process. The provided description is permanently stored in the program database. You can use it to save some additional information about this object.

**Machine Properties**

The Machine properties consist of the **NetBIOS Name**, **DNS Name**, **MAC Address**, **Comment** and **Description**. The **NetBIOS Name** and **DNS Name** fields are maintained automatically and cannot be changed manually.

![Machine Properties](image)

The Machine name, full DNS name and comment are filled automatically during every scan. The MAC address is changed if it can be retrieved during the scan. The provided description is always specified manually and can be used as information for this Machine to permanently store in the program database.
Importing and Exporting Network

With Remote Shutdown, you can easily import and export network objects any time you want. You can export one or all of the available Machines, Credentials and Collections to use the exported data as a backup, to share data with your colleagues or simply to import the objects to another instance of the program. The import feature can be used both to import Machines, Credentials, Collections and Collection Members from files created during export and those created manually. For example, you can create a CSV file manually to add Machines by specifying their data in Microsoft Office Excel. This chapter covers the process of importing and exporting network objects.

Import

The Import button from the Organize Ribbon group on the Program page can be used to import Machines' data from an XML or CSV file and Credentials, Collections or Collection Members from an XML file with the help of the wizard.

It is possible to import Machines, Credentials, Collections and Collection Members. Machines can be imported into Remote Shutdown from XML and CSV files. You can import Machines to the Network node or to any Collection, depending on the selection in the Network view. When running import from the All Machines view, Machines are imported into the Network node. Other network objects can be imported only from the XML format. To import Collections, you should select either the Collections node in the Network view or any Collection. The Credentials import can be launched when the Credentials view is active. The file formats are described in detail the Export/Import Formats section. You can use the files created by the program during previous exports or create new files manually.

To perform import, press the Import button from the Organize Ribbon group on the Program page. The import wizard will appear on the screen. Let us take a closer look at the import process using the Machines import as an example Pic 1.

Pic 1. The Import Machines Wizard welcome page
The first page of the Import Machines Wizard is the welcome page used to introduce you to the feature the wizard is supposed to help you with. After reading the welcome information, press Next to continue with import.

On the next page of the Import Machines Wizard, you are offered to choose the file you are going to import Machines from (Pic 2). The file path should be provided to the Import From field. The format of the provided file is detected automatically. The encoding of the XML file with Machines is also detected automatically. For the CSV format, a preview page is displayed where you can tune the parse options while immediately seeing the results.

Pic 2. Choosing the import source file
In case of a CSV file, the next page is a preview page. When you change the CSV format options, the preview is refreshed so that you can see if the format options are chosen properly [Pic 3].

After you have tuned the parse options, press Next to choose the Machines to import. The next page is the page for choosing Machines from those available in the file [Pic 4]. It is also displayed if you have chosen an XML file containing Machines. By default, all available Machines are chosen for import.
When the Machines to import have been chosen, press the **Finish** button to proceed with import. As soon as the import is complete, the imported Machines are added to the **Network** and the **All Machines** views. The same concept is used for importing Credentials and Collections, importing into Collections, etc.

**Export**

The **Export** button from the **Organize** Ribbon group on the **Program** page can be used to export the selected Machines, Queries, Collections or Credentials from the program to a file that can be used in the future for import.

Remote Shutdown allows you to export Machines, Machine Queries, Collections and Credentials. Machines can be exported to the XML or CSV file format. Other network objects can be exported to the XML file format only. To perform export, select the objects to export and press the **Export** button from the **Organize** Ribbon group on the **Program** page. Let us take a closer look at the network objects export using the Machines export as an example. When you choose to export some objects, the export wizard appears on the screen **Pic 5**.

**Pic 5. The Export Machines Wizard welcome page**
The first page of the export wizard is the welcome page used to introduce you to the feature the wizard is supposed to help you with. After reading the welcome information, press **Next** to continue with export.

On the next page of the export wizard, you are offered to choose the file you are going to save the Machines data to, the file format and the format options [Pic 6]. The file path should be provided to the **Export To** field. For the XML format, you can choose the encoding to be used for saving the objects, and for the CSV file, the text delimiter and the field delimiter should also be specified along with the encoding.

After the file path and the export form have been chosen, press **Finish** to proceed with export. A file containing the exported objects will be created in the specified path. The file created during export can be used in the future to import the objects back to the program.

Now you are fully introduced to the network objects export and import options available in Remote Shutdown and can use them in the future to solve your tasks. If you are interested in creating files to import manually, you can read the Export/Import Formats section that follows this section to get detailed information on the file formats.

### Export/Import Formats

This section describes the format of the files used by Remote Shutdown while importing and exporting network objects. The CSV export and import is only supported for Machines; other network objects can only be transferred via XML files. The CSV file format for exporting Machines in general consists of eighteen columns, namely:

<table>
<thead>
<tr>
<th>Index</th>
<th>Header</th>
<th>Description</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>GroupName</td>
<td>The NetBIOS name of the group the Machine is located in.</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>The NetBIOS name of the Machine.</td>
<td>Yes</td>
</tr>
<tr>
<td>Index</td>
<td>Header</td>
<td>Description</td>
<td>Mandatory</td>
</tr>
<tr>
<td>-------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>3</td>
<td>GroupDNSName</td>
<td>The full DNS name of the domain the Machine is located in (can be empty for network environments with workgroups).</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>DNSName</td>
<td>The full DNS name of the Machine. This column can be empty for network environments with workgroups.</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>OrganizationUnit</td>
<td>The path of the organization unit containing the Machine in the Active Directory database. The path elements should be separated with the '' character. If the organization unit name contains the '' character, it should be replaced with '\'. If you would like to scan and rescan the imported units, you should define the container type for each path element: the organization unit should start with 'OU=' and the container, such as the default one named Computers, with 'CN='.</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>Comment</td>
<td>The comment for the Machine.</td>
<td>No</td>
</tr>
<tr>
<td>7</td>
<td>Description</td>
<td>The description for the Machine.</td>
<td>No</td>
</tr>
<tr>
<td>8</td>
<td>GUID</td>
<td>The unique Machine identifier in the Active Directory database. This column can be empty for network environments with workgroups.</td>
<td>No</td>
</tr>
<tr>
<td>9</td>
<td>Username</td>
<td>The username used to connect to the Machine.</td>
<td>No</td>
</tr>
<tr>
<td>10</td>
<td>Password</td>
<td>The password used to connect to the Machine in a strongly encrypted state. This column value cannot be provided manually.</td>
<td>No</td>
</tr>
<tr>
<td>11</td>
<td>IPAddress</td>
<td>The last retrieved IP address of the Machine.</td>
<td>No</td>
</tr>
<tr>
<td>12</td>
<td>Platform</td>
<td>The platform of the Machine: x86 or x64.</td>
<td>No</td>
</tr>
<tr>
<td>13</td>
<td>OSVersion</td>
<td>The major and minor version of the remote Machine's operating system, e.g. '5.2' for Microsoft Windows XP/2003.</td>
<td>No</td>
</tr>
<tr>
<td>14</td>
<td>OSType</td>
<td>The remote Machine's operating system type: 'Workstation', 'Server' or 'Server R2'.</td>
<td>No</td>
</tr>
<tr>
<td>15</td>
<td>ServicePack</td>
<td>The service pack version of the remote Machine's operating system, e.g. '2' for Service Pack 2.</td>
<td>No</td>
</tr>
<tr>
<td>16</td>
<td>OSLanguage</td>
<td>The language code of the remote Machine's operating system, e.g. 'en-US' for English (United States).</td>
<td>No</td>
</tr>
<tr>
<td>17</td>
<td>MACAddress</td>
<td>The MAC address of the Machine.</td>
<td>No</td>
</tr>
<tr>
<td>18</td>
<td>NICVendor</td>
<td>The vendor of the Network Interface Card. This field is only used for export for your convenience: you do not need to search over the Internet to determine the NIC vendor by MAC address.</td>
<td>No</td>
</tr>
</tbody>
</table>
If you are preparing a CSV file for import manually, you have two options: follow the indexes of columns or provide the column headers. If the headers are provided, the columns order is not taken into account. So, for example, if you want to provide the IP addresses for Machines you can create a file only with Name, GroupName and IPAddress columns – the program will determine the fields you are going to import using the header.

Sample CSV file with Machines

"GroupName","Name","GroupDNSName","DNSName","OrganizationUnit","Comment","Description","GUID","Username","Password","IPAddress","MACAddress","NICVendor"
"DREAMLIGHT","W2003-X86-MKVI","Dreamlight.local","W2003-X86-MKVI.Dreamlight.local","CN=Computers","","aee74a8b-26dc-47b8-89a4-d16e3ecba8d2","192.168.5.195","000C295C3F52","VMware, Inc."
"DREAMLIGHT","W2008-R2-MKIV","Dreamlight.local","W2008-R2-MKIV.Dreamlight.local","CN=Computers","",",","192.168.5.109","000C2904BE85","VMware, Inc."
"DREAMLIGHT","W7-X86-SP1-MKII","Dreamlight.local","W7-X86-SP1-MKII.Dreamlight.local","CN=Computers","",",",",",",",",",",",",",",","192.168.5.108","000C292287F2","VMware, Inc."
"DREAMLIGHT","DREAMLIGHT-PDC","Dreamlight.local","Dreamlight-PDC.Dreamlight.local","OU=Domain Controllers","",",",",",",",",",",",",",",",",","192.168.5.12","000C299C0D16","VMware, Inc."
"DREAMLIGHT","W7-X86-SP1-MKV","Dreamlight.local","W7-X86-SP1-MKV.Dreamlight.local","OU=Floor 2\OU=Office 203","",",",",",",",",",",",",",",",",",",",",",",","192.168.5.118","000C294B7001","VMware, Inc."
"DREAMLIGHT","WVISTA-X86-SP1","Dreamlight.local","WVISTA-X86-SP1.Dreamlight.local","OU=Floor 2\OU=Office 203","",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",",","," As for the XML files, each file containing exported data has the Data root node that defines the data format and the format version. The following formats are supported:

- **Machines**, used to represent the exported Machines, respecting the network structure;
- **Queries**, used to represent the exported standalone Queries and Machines;
- **Collections**, used to represent the exported Collections;
- **Network**, used to represent the mix of exported Collections, standalone Queries and standalone Machines and can be imported into the Network view or into a Collection;
- **Credentials**, used to represent the exported Credentials respecting the network structure.
All XML formats for exporting network objects contain the network structure. Each element in the structure is represented with the **Entry** node. The root node is always a network node that has its **Type** attribute set to 'Network'. For all the formats, except **Machines** and **Credentials**, there is also the **Explorer** root node available, which contains Collections, Queries and references to the nodes representing the network item. For example, if there is the same Machine in two Collections, the Machine is only stored once within the network structure, and both the Collections contain references to that Machine. Let us take a look at the available entry types for each data format.

<table>
<thead>
<tr>
<th>Type</th>
<th>Formats</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network</td>
<td>All</td>
<td>This is the root node of the network structure, which can also contain the credentials to be used as default for connecting to remote Machines.</td>
</tr>
<tr>
<td>Group</td>
<td>All</td>
<td>This node represents a Group in the network structure.</td>
</tr>
<tr>
<td>OU</td>
<td>All</td>
<td>This node represents an Active Directory container (either Organization Unit or Container) in the network structure.</td>
</tr>
<tr>
<td>Machine</td>
<td>All</td>
<td>This node either represents a Machine in the network structure (when located within the Network node) or a reference to a Machine in the network structure.</td>
</tr>
<tr>
<td>Query</td>
<td>Queries, Collections, Network</td>
<td>This node represents a query for fetching remote Machines and references a Group in the network structure.</td>
</tr>
<tr>
<td>Collection</td>
<td>Collections, Network</td>
<td>This node represents a Collection and contains Queries and references to remote Machines grouped by this Collection.</td>
</tr>
</tbody>
</table>

Each node representing a network object has a set of properties used to describe the object. The table below contains a joint set of attributes and describes each attribute and its purpose in details.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of a network item. This attribute defines either the name for Active Directory Containers, Queries and Collections or the NetBIOS name for Groups and Machines.</td>
</tr>
<tr>
<td>Comment</td>
<td>The comment used for a network item.</td>
</tr>
<tr>
<td>Description</td>
<td>The description defined for a network item.</td>
</tr>
<tr>
<td>GUID</td>
<td>The unique item identifier in the database. This attribute is not applicable to Machines and Groups in workgroup environments.</td>
</tr>
<tr>
<td>CNType</td>
<td>The type of a network item. It should be 'DC' for domains, 'OU' for organization units and 'CN' for other active directory containers, such as the default one named Computers, and Machines.</td>
</tr>
<tr>
<td>Username</td>
<td>The username used to connect to a network item.</td>
</tr>
<tr>
<td>Password</td>
<td>The password in a strongly encrypted from used to connect to a network item. This attribute cannot be provided manually.</td>
</tr>
<tr>
<td>DNSName</td>
<td>The DNS name of a Machine or the Fully Qualified Domain Name of a Group.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The following attributes are used for the <strong>Machine</strong> entries representing the network structure, in all formats, except <strong>Credentials</strong>.</td>
<td></td>
</tr>
<tr>
<td>IPAddress</td>
<td>The last retrieved IP address of a Machine.</td>
</tr>
<tr>
<td>Platform</td>
<td>A Machine’s platform: x86 or x64.</td>
</tr>
<tr>
<td>OSVersion</td>
<td>The major and minor version of a remote Machine’s operating system, e.g. ‘5.2’ for Microsoft Windows XP/2003.</td>
</tr>
<tr>
<td>OSType</td>
<td>A remote Machine’s operating system type: 'Workstation', 'Server' or 'Server R2'.</td>
</tr>
<tr>
<td>ServicePack</td>
<td>The service pack version of a remote Machine’s operating system, e.g. ‘2’ for Service Pack 2.</td>
</tr>
<tr>
<td>OSLanguage</td>
<td>The language code of a remote Machine’s operating system e.g. ‘en-US’ for English (United States).</td>
</tr>
<tr>
<td>MACAddress</td>
<td>The MAC address of a Machine. This attribute is only applicable to Machine nodes.</td>
</tr>
<tr>
<td>NICVendor</td>
<td>The vendor of the Network Interface Card. This field is only used for export for your convenience, and you do not have to do Internet search to determine the NIC vendor by MAC address.</td>
</tr>
<tr>
<td>The following attributes are used for <strong>Machine</strong> entries in the <strong>Collections</strong> and <strong>Network</strong> formats.</td>
<td></td>
</tr>
<tr>
<td>ref</td>
<td>A reference to the Machines that is included into a <strong>Collection</strong> or a <strong>Network</strong> node in the network structure definition.</td>
</tr>
<tr>
<td>The following attributes are used for <strong>Query</strong> entries in the <strong>Queries</strong>, <strong>Collections</strong> and <strong>Network</strong> formats.</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>The Query condition to be used for fetching remote Machines.</td>
</tr>
<tr>
<td>ref</td>
<td>A reference to the Group that should be used to fetch Machines from in the network structure definition.</td>
</tr>
<tr>
<td>The following attributes are used for <strong>Collection</strong> entries in the <strong>Queries</strong>, <strong>Collections</strong> and <strong>Network</strong> formats.</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>The condition to be used for the <strong>Machines Filter</strong>.</td>
</tr>
<tr>
<td>OverrideMode</td>
<td>The sign that the Machine querying options are overridden for this Collection. The value is either ‘yes’ or ‘no’.</td>
</tr>
<tr>
<td>Mode</td>
<td>The overridden querying source: ‘0’ to fetch Machines from the entire Network and ‘1’ to select Machines from the program database.</td>
</tr>
<tr>
<td>OverrideCache</td>
<td>The sign that the filtering options pertaining to the property values cache are overridden for this Collection. The value is either ‘yes’ or ‘no’.</td>
</tr>
<tr>
<td>UseCache</td>
<td>The overridden sign showing if it is allowed to use cached property values for filtering.</td>
</tr>
<tr>
<td>PropsMeasurement</td>
<td>The overridden expiration measurement unit of the operating system properties cache: ‘0’ for minutes, ‘1’ for hours, ‘2’ for days.</td>
</tr>
<tr>
<td>PropsExpire</td>
<td>The overridden number of measurement units (minutes/hours/days) for the time span defining the properties cache expiration interval.</td>
</tr>
</tbody>
</table>

Sample XML file with network objects

```xml
<?xml version="1.0" encoding="utf-16"?>
<Data Version="3" Format="Machines">
  <Entry Type="Network">
    <!-- Your XML data goes here -->
  </Entry>
</Data>
```
Now you are introduced to the formats used for storing the network objects data and can prepare files for manual import or for editing data exported earlier to be used for future imports.
Chapter 8: Operations' Execution Results

The operation execution results are stored either within the execution results or in the log depending on the operation type.

The execution results part of the program database stores all results of business operations performed on remote Machines grouping them by runs. You can review those results within the Execution Results view. For each run, you can see the operation name, the operation type, the execution type and brief execution statistics. Under each run, you can find detailed results info grouped by Machines and Groups those Machines belong to.

The log is designed to store information on supplementary operations' results and other events taking place while the program is running. For example, the results of enumerating a network for Machines performed either for building the network structure or while executing machine queries is stored within the log. The log also contains events that are not directly connected to remote operations and merely provide you with details on the program lifecycle. Such events are displayed in the Log view.

Both the execution results and the log are designed so as to help you to analyze the operation execution results and to troubleshoot problems taking place while the program is in use. The execution results and the log databases may grow continually, thus slowing down the program loading and response time. To prevent this, you can either delete execution results and clear the log manually or allow the program to perform the clean-up automatically on a regular basis. The options for deleting execution results and events automatically are available on the Execution Results and Log Configuration preference pages. On the Log Configuration page, it is also possible to change the Log view presentation options.

In this chapter, we will explain how to analyze execution results and the log to ensure that operations have been completed successfully or to troubleshoot possible problems. We will also describe the option of exporting execution results and logged events into a simple format.
Analyzing Execution Results

The main purpose of the **Execution Results** view is to help you understand if the business operation performed on remote Machines has succeeded and troubleshoot eventual problems. Each entry in the **Execution Results** view has a severity icon, a title, a description and possibly a hint on solving the problem, if any. From the title, you can understand which operation has been performed; the description contains the result message; the hint provides you with troubleshooting advice; and the severity icon helps you to quickly understand if the task has fully succeeded.

For example, let us take a closer look at the following result set in the **Execution Results** view.

![Sample execution results](image)

As we can see from the picture above, most of the Machines have been processed successfully, but some of them have not. We need to find out what caused the problem and what should be done to avoid it in future. Also, it may be interesting to go through the warnings to see if anything wrong is going on. So, let us take a closer look at each problem.

For **WVISTA-X86-SP1** we've got the following error message:

_Could not ping the 'WVISTA-X86-SP1.Dreamlight.local (192.168.5.84)' Machine using the following timeout: 1500 ms. Ping reply was not received within the allotted time._

There are a few possible scenarios that may have caused such an error:

- The remote Machine is turned off. Hence that Machine should be turned on to be operated by Remote Shutdown.
- The remote Machine could not be contacted due to a hardware networking failure. In this case you need to check the network environment.
- The ping functionality is disabled on the remote Machine. You should enable the Ping functionality on the remote Machine. If it is not applicable, go to the **Scan Settings** preference.
page and disable the **Ping Machines using the following timeout (ms.)** option. Please note that this may significantly decrease the performance.

The **EMCO-PDC** Machine returned another error:

_Could not connect to the 'Emco-PDC.Emco.local (192.168.5.10)' Machine. The connection was performed using the current user credentials. This means that the currently active user account has no right to access to the remote Machine._

To solve the problem, you must provide proper credentials to access this Machine in the **Credentials** view.

Finally, the operation over the **LAB-PDC** Machine did not succeed returning the following message:

_Could not connect to the 'Lab-PDC.Lab.Dev.Emco.local (192.168.5.14)' Machine. The connection was performed using the specified credentials: 'admin@Lab.Dev.Emco.local'. _

This means that the credentials provided in the **Credentials** view do not allow you to perform operations over the remote Machine. You must provide proper credentials to get rid of this error.

After the results have been reviewed and all problems have been solved, you can run the operation again and ensure that the problematic Machines are processed successfully this time.
Exporting Execution Results

With Remote Shutdown, you can easily export the execution results of a business operation to the CSV file format for future analysis or processing by an automated tool. To export the execution results, click the **Export** button from the **Execution Results** view toolbar. You are proposed to choose between exporting the selected results and all results. You can also press the **Export** button from the **Organize** Ribbon group on the **Program** page when the **Execution Results** view is in focus. It is also possible to use the pop-up menu of the **Execution Results** view to export the results. The **Export Execution Results Wizard** will appear on the screen. 

![Pic 1. The Export Execution Results Wizard welcome page](image)

Pic 1. The Export Execution Results Wizard welcome page
The first page of the Export Execution Results Wizard is the welcome page used to introduce you to the feature the wizard is supposed to help you with. After reading the welcome information, press Next to continue with export.

On the next page of the Export Execution Results Wizard, you are offered to choose the file you are going to save the execution results to and the CSV format options. The file path should be provided to the Export To field [Pic 2]. You can choose the encoding to be used for saving the data, as well as the field delimiter and the text qualifier. While performing export, you may also define if you would like the column header to be present in the resulting file, which would make it easier for you to identify each column. This feature can be enabled using the Include column header option.

Pic 2. Configuring the export options
After you are ready with configuring the export options, press **Finish** to proceed with export. The file containing the task execution results will be created in the path specified.

The CSV file with the exported results consists of seven columns, which are the following:

<table>
<thead>
<tr>
<th>Column Index</th>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run</td>
<td>Information about the run during which the result was generated.</td>
</tr>
<tr>
<td>2</td>
<td>Group</td>
<td>The group the operated Machine belongs to.</td>
</tr>
<tr>
<td>3</td>
<td>Machine</td>
<td>The operated Machine's name.</td>
</tr>
<tr>
<td>4</td>
<td>Container</td>
<td>The Active Directory container the operated Machine belongs to.</td>
</tr>
<tr>
<td>5</td>
<td>Title</td>
<td>The execution result title.</td>
</tr>
<tr>
<td>6</td>
<td>Type</td>
<td>The execution result type that indicates severity level.</td>
</tr>
<tr>
<td>7</td>
<td>Description</td>
<td>The execution result description.</td>
</tr>
<tr>
<td>8</td>
<td>Time</td>
<td>The time when the event occurred.</td>
</tr>
<tr>
<td>9</td>
<td>Error Code</td>
<td>The error code for the execution result, if any.</td>
</tr>
</tbody>
</table>

Sample exported data in the CSV format

```
"Run","Group","Machine","Container","Title","Severity","Description","Time","Error Code"

"'Shut Down' - 1/17/2018 6:34:46 PM - Processed: 1 Machine (Successful: 0, Warnings: 0, Errors: 1, Canceled: 0) - Duration: less than 1 sec","Dreamlight","W2003-x86-sp1","Floor 2\Office 203","Prepare Remote Agent","Error","The remote agent cannot be installed to the 'W2003-x86-sp1.Dreamlight.local (192.168.5.94)' Machine as the client operating system is no longer supported by the agent. ","2018-01-17 18:34:46",

"'Retrieve MAC Address Task' - 1/17/2018 7:01:53 PM - Processed: 2 Machines (Successful: 2, Warnings: 0, Errors: 0, Canceled: 0) - Duration: less than 1 sec","Dreamlight","WXP-X86-SP1","Floor 2\Office 204","NetBIOS","Warning","The MAC address could not be retrieved using the NetBIOS method. Command timed out."","2018-01-17 19:01:53",

"'Retrieve MAC Address Task' - 1/17/2018 7:01:53 PM - Processed: 2 Machines (Successful: 2, Warnings: 0, Errors: 0, Canceled: 0) - Duration: less than 1 sec","Dreamlight","WXP-X86-SP1","Floor 2\Office 204","DHCP (192.168.1.1)","Warning","The MAC address could not be retrieved using the DHCP method. Failed to read the MAC address from the '192.168.1.1' DHCP server. Could not connect to the DHCP server using the credentials specified within the Credentials view. Access is denied (Error code: 5). ","2018-01-17 19:01:53","10051"

"'Wake on LAN Task' - 1/17/2018 6:58:36 PM - Processed: 2 Machines (Successful: 2, Warnings: 0, Errors: 0, Canceled: 0) - Duration: 10 sec","Dreamlight","W2003-x86-sp1","Floor 2\Office 203","WOL","Information","The 'W2003-x86-sp1.Dreamlight.local (192.168.5.94)' Machine is responding, thus it has been turned on successfully.","2018-01-17 18:58:46",

"'Wake on LAN Task' - 1/17/2018 6:58:36 PM - Processed: 2 Machines (Successful: 2, Warnings: 0, Errors: 0, Canceled: 0) - Duration: 10 sec","Dreamlight","W2003-x86-sp1","Floor 2\Office 203","IPv6 Link-Local Multicast","Warning","The WOL packet could not be sent using the IPv6 Link-Local Multicast method. A socket operation was attempted to an unreachable network (Error code: 10051). ","2018-01-17 18:58:36","10051"
```
Execution Results on the Web

EMCO Remote Shutdown Enterprise comes with an option of deploying an IIS web site together with the server application to provide web access to operations’ execution results. This site is installed by default when performing a complete server installation.

The Execution Results on the Web button from the Remote Actions group on the Home Ribbon page can be used to open the EMCO Remote Shutdown Enterprise program web site in the default browser to let you review execution results.

On the web site home page, you can see the results summary for operations launched during the specified period of time. By default, all runs for the requested period are displayed, split into pages. You can narrow the results selection using the filter on the left of the home page. The report period and the report time zone is selected at the top of the page.

Pic 1. The execution results summary
On the summary page, you can find only the aggregated information on each run of any operation. To review the execution results in details, you should click on the run you are interested in. The page with detailed information will be displayed.

Pic 2. The detailed execution results on the web site

The detailed information consists of per Machine results. In case there are additional events for specific Machines, you can find the expand button next to the result row. When the row is expanded, all events for the Machine are listed. You can filter the detailed results by the Group the operated Machines are located in and the result type that displays the severity level.
Analyzing Log

The main purpose of the Log view is to help you understand if the enumeration, state checking and other service operations execution has succeeded and troubleshoot problems if any have occurred. Each entry in the log has a severity icon, a title, and a description, and possibly a hint on solving the problem, if any. From the title, you can understand which operation has been performed and which resource has been operated; the description provides you with the result message, a hint is used to provide you with an advice on solving the problem, if any; and the severity icon can be used to quickly understand if the operation has fully succeeded.

For example, let us take a closer look at the following result set in the log Pic 1.

Pic 1. Sample logged events

The picture above displays the set of results we received after performing state check on a number of selected Machines. The results of checking the Machines are grouped by the Group the Machines are located in. In each group node, we can see how many Machines have been processed successfully, with warnings or not processed due to errors.

As we can see from the picture, most of the Machines have been processed successfully, but some of them have not. We need to find out what caused the problem and what should be done to avoid it in future. Also, it may be interesting to go through the warnings to see if anything wrong is going on. So, let us take a closer look at each problem.

For WVISTA-X86-SP1 we've got the following error message:

_Could not ping the 'WVISTA-X86-SP1.Dreamlight.local (192.168.5.84)' Machine using the following timeout: 1500 ms. Ping reply was not received within the allotted time._

There are a few possible scenarios that may have caused such an error:

- The remote Machine is turned off. Hence that Machine should be turned on to be operated by Remote Shutdown.
- The remote Machine could not be contacted due to a hardware networking failure. In this case, you need to check the network environment.
- The ping functionality is disabled on the remote Machine. You should enable the Ping functionality on the remote Machine. If this is not applicable, go to the Scan Settings preference page and disable the Ping Machines using the following timeout (ms.) option. Please note that this may significantly decrease the performance.
The **EMCO-PDC** Machine returned another error:

*Could not connect to the 'Emco-PDC.Emco.local (192.168.5.10)' Machine. The connection was performed using the current user credentials.*

This means that the currently active user account has no right to access the remote Machine. To solve the problem, you must provide proper credentials to access this Machine in the **Credentials** view.

Finally, the operation on the **LAB-PDC** Machine did not succeed returning the following message:

*Could not connect to the 'Lab-PDC.Lab.Dev.Emco.local (192.168.5.14)' Machine. The connection was performed using the specified credentials: 'admin@Lab.Dev.Emco.local'.*

This means that the credentials provided in the **Credentials** view do not allow you to perform operations on the remote Machine. You must provide proper credentials to get rid of this error.

After the events have been reviewed and all the problems have been solved, you can run the operation again and ensure that it completes successfully.
Exporting Log

With Remote Shutdown, you can easily export the log to the CSV file format for future analysis or processing by an automated tool. To export the logged events, click the **Export** button from the **Log** view toolbar. You are proposed to choose between exporting the selected events and all events. You can also press the **Export** button from the **Organize** Ribbon group on the **Program** page when the Log view is in focus. It is also possible to use the pop-up menu of the Log view to export logged events. The **Export Log Wizard** will appear on the screen

![Image of Export Log Wizard welcome page](Pic 1. The Export Log Wizard welcome page)
The first page of the Export Log Wizard is the welcome page used to introduce you to the feature the wizard is supposed to help you with. After reading the welcome information press Next to continue with export.

On the next page of the Export Log Wizard, you are offered to choose a file you are going to save the logged events to and the CSV format options. The file path should be provided to the Export To field (Pic 2). You can choose the encoding to be used for saving the data as well as, the field delimiter and the text qualifier. While performing exporting, you may also define if you would like the column header to be present in the resulting file, which would make it easier for you to identify each column – this feature option can be enabled using the Include column header option.

After you are ready with configuring the export options, press Finish to proceed with export. The file containing the logged events will be created in the path specified.

The CSV file with the exported data consists of six columns, which are the following:

<table>
<thead>
<tr>
<th>Index</th>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Path</td>
<td>The path to the logged event in the log tree.</td>
</tr>
<tr>
<td>2</td>
<td>Title</td>
<td>The logged event title.</td>
</tr>
<tr>
<td>3</td>
<td>Severity</td>
<td>The logged event severity level.</td>
</tr>
<tr>
<td>4</td>
<td>Description</td>
<td>The logged event description.</td>
</tr>
<tr>
<td>5</td>
<td>Time</td>
<td>The time when the event occurred.</td>
</tr>
<tr>
<td>6</td>
<td>Error Code</td>
<td>The error code for the event, if any.</td>
</tr>
</tbody>
</table>

Sample exported logged events in the CSV format

"Path","Title","Severity","Description","Time","Error Code"
"Clear Application Log","Clear Application Log","Information","The operation was completed successfully.","2015-01-10 16:13:21","
"Check State","Check State","Warning","Processed: 8 Machines (Successful: 5, Warnings: 0, Errors: 3, Cancel: 0)","2015-01-10 16:13:33",
"Check State\Wintoolkit","Wintoolkit","Information","Processed: 5 Machines (Successful: 5, Warnings: 0, Errors: 0, Cancel: 0)","2015-01-10 16:13:31",
"Check State\Wintoolkit\Wintoolkit-PDC","Wintoolkit-PDC","Information","The remote service is installed on the 'Wintoolkit-PDC.Wintoolkit.local (192.168.5.138)' Machine.","2015-01-10 16:13:28",
"Check State\Wintoolkit\W2008-R2-SP1","W2008-R2-SP1","Information","The remote service is installed on the 'W2008-R2-SP1.Wintoolkit.local (192.168.5.158)' Machine.","2015-01-10 16:13:28",

Now you are introduced to the log export and export data file format and can use the export feature for the log analysis without any misunderstanding.
Chapter 9: Program Preferences

Remote Shutdown comes with a big range of settings available for changing to each user. Every preference page has a detailed description of its content and of the feature it is used to configure. You can configure almost everything: application behavior regarding the System Tray, database storage, proxy settings to be used to connect to the Internet, etc. To reach application preferences click Preferences button available from the Application Menu. Also the clickable Ribbon groups’ glyphs open the preference pages that configure the functionality assembled in this group.

Remote Shutdown Part

The Network part of the application preferences should be used to configure the Network Enumeration process behavior and remote Machines scan options. To open the Preferences dialog click Preferences button available from the Application Menu. Feel free to configure the settings available to best meet your needs.
WOL Configuration Page

The WOL Configuration preference page is used to configure the Wake-On-LAN (WOL) functionality built into Remote Shutdown. To access this preference page press the Preferences button from the Application Menu and select the WOL Configuration link in the navigation bar on the left of the opened dialog.

You can choose the UDP port to be used for sending Wake-on-LAN package in the Remote UDP port field. UDP traffic through this port should be forwarded on the routers that connect the Machine Remote Shutdown is running on with the Machines you want to wake up. The following one click configuration methods are available:

The other thing to specify is one or more of the transmission methods to be used for sending the packet. The following one click configuration methods are available:

- **IPv4 Link-Local Broadcast** – should be used to wake up the Machines from the same subnet the PC with Remote Shutdown running is located in using a broadcast over the IPv4 protocol.
- **IPv6 Link-Local Multicast** – should be used to to wake up Machines using a multicast over the IPv6 protocol targeting all nodes from the same subnet the PC with Remote Shutdown running is located in.
- **Unicast** – should be used to wake up the Machines using the Machines' IP address. This is a more secure solution but Wake On LAN will fail to find target computers that have changed their subnet address since the last hardware inventory schedule.

- **IPv4 Directed Broadcast** – should be used to wake up Machines from different subnet, according to the subnet mask specified, using a directed broadcast over the IPv4 protocol.

In case the simple methods do not satisfy your needs, you can use the advanced methods to provide custom targets to send the WOL packages to, those are:

- **Custom IPv4 Target** – should be used to wake up Machines over the IPv4 protocol by sending the packet to the specified target;

- **Custom IPv6 Target** – should be used to wake up Machines over the IPv6 protocol by sending the packet to the specified target.
Power Peaks settings allows you to set a number of Machines to be woken up per second. These settings allow you reducing the power network load while waking up a large number of Machines.

**Transmission methods used for sending WOL packets**

Let us take a closer look on each method of forming a destination address for the magic packet to be sent.

The **IPv4 Link-Local Broadcast** method is using the `255.255.255.255` address as a destination address. This is a broadcast address that stands for this network – it means that the magic packet is sent to all Machines from the subnet Remote Shutdown host machine is located in. For example, let us suppose that Remote Shutdown is running on the **MERCURIUS** machine that has the `192.168.1.10` address and is a part of subnet with the `255.255.255.0` mask. In such a case all the Machines from the `192.168.1.0` network will receive the packet.

When the **IPv6 Link-Local Multicast** method is used, the packets are sent to the `ff02::1` address. This address stands for all nodes in the link-local – it means that the magic packet is sent to all Machines from the subnet Remote Shutdown host machine is located in.

The **Unicast** method is using an IP address of the remote Machine to send the magic packet to. This method will fail if the remote Machine host could not be resolved.

The **IPv4 Directed Broadcast** is a datagram which is sent to the broadcast address of a subnet to which the sending machine is not directly attached. The directed broadcast is routed through the network as a unicast packet until it arrives at the target subnet, where it is converted into a link-layer broadcast. Because of the nature of the IP addressing architecture, only the last router in the chain, the one that is connected directly to the target subnet, can conclusively identify a directed broadcast. Directed broadcasts are occasionally used for legitimate purposes, but such use is not common outside the financial services industry. The broadcast address is calculated using the IP address of the remote Machine and the specified subnet mask. Let us suppose we are running Remote Shutdown on the **MERCURIUS** machine that has the `192.168.1.10` address in and is a part of subnet with the `255.255.255.0` mask. This case is quite simple – if we are going to wake up the **TYRONE** machine that has the `192.168.5.1` address the packet will be sent to `192.168.5.255` address – note that it will be delivered till the `192.168.5.0` network router as a unicast. The more complex case if, for example, the `255.255.255.192` mask is used, dividing the C-class network to four subnets. If we are going to wake up the **TYRONE** machine that has the `192.168.5.1` address the packet will be sent to the `192.168.5.63` address, and for **LAB-PDC** with the `192.168.5.130` address – to `192.168.5.191`. So in any case the packet should be received by the destination subnet.

**⚠️ Please notice that routers default configuration does not allow broadcasts between different subnets to protect from network attacks, but you can allow broadcasts only from the Remote Shutdown hosting Machine via the port defined in the preferences. This method will also fail if the remote Machine host could not be resolved.**

For more information about WOL packets transmission see the **WOL Packets Transmission Methods** section of this document.
The **Custom IPv4 Target** method can be used to wake up Machines over the Internet or from a specific subnet. To wake up Machines over the Internet you should specify the IP address or host name of the Machine, modem or router visible from the Internet and leave subnet mask the **255.255.255.255**. In such a case the packet will be sent to the address specified using the Unicast transmission – the router should be configured to forward the packets received to a specific Machine or the whole subnet for the Wake-on-LAN to succeed. The other case of using this method is waking up the Machines from a different subnet that cannot be resolved. To reach the goal the IP address of any Machine from that subnet should be provided along with the subnet mask used for the interested subnet. The packets will be sent to that subnet using the Directed Broadcast transmission.

As for the **Custom IPv6 Target**, it can also be used to wake up Machines over the Internet. The target address might either be the address of the destination PC to wake up or the address of the server that serves as the wake-up agent and simply forwards all the traffic received on the specific port to the link-local multicast groups.
MAC Address Scan Page

Remote Shutdown needs to know the remote Machines' MAC addresses to provide you with the Wake-on-LAN feature. The MAC address scan is executed automatically during the Network Scan process. The methods used to retrieve the MAC address are configured on the MAC Address Scan preference page. To open this page click Preferences button from the Application Menu and select MAC Address Scan link in the navigation bar on the left in the Preferences dialog within the Remote Shutdown group.

![Image of MAC Address Scan preferences]

Pic 1. Configuring the MAC address scan
You can choose between the Neighbor Discovery, IPv6 EUI-64, NetBIOS, WinAPI, WMI and DHCP methods. Each of the methods is described in detail in the MAC Address Retrieving Methods section. For the DHCP method, you can choose if the program should determine the available DHCP servers automatically or they will be provided manually. To add a new server manually, switch to the Use the following DHCP servers option and press the Add Server button on the DHCP Servers panel toolbar. The Add Server dialog will appear on the screen Pic 2.

Within the dialog, you are requested to provide the DHCP server address along with the credentials to be used for connection. When you are ready with configuring the server, press OK to add the server. To edit the server information, select it in the DHCP Servers part and press the Edit Server button. If the server is no longer needed, you can remove its information using the Remove button.

You can check the DHCP servers’ configuration using the corresponding hyperlink on the MAC Address Scan preference page. As soon as the check is completed, the results are displayed for each server.
Scan Settings Page

The scan settings are designed to enable you to configure the processing of remote Machines in the most optimal way depending on the network structure, thus increasing the overall scan performance. To configure the Scan Settings, click the Preferences button in the Application Menu and switch to the Scan Settings preference page using the corresponding link in the navigation bar on the left in the Preferences dialog within the Remote Shutdown group.

You are offered to configure the Machines availability detection, administrative access assurance and hyper-threading options.

Pic 1. Configuring scan settings.
Remote Shutdown provides an option of detecting the remote Machines’ availability by pinging them before processing. This can significantly speed up bulk operations on remote computers, but if your environment has any ping restrictions, you should disable this option, so that remote Machines that are not allowed to be pinged could also be processed. To detect remote Machines’ availability using the ping functionality, check the **Ping Machines using the following timeout (ms.)** option and provide the required timeout value. To enable the administrative access assurance, check the **Assure administrative access option**.

The ultimate Hyper-Threading technology provided by EMCO allows you to perform network operations in parallel to reach the highest performance available. You can set an optimal operation execution threads count depending on the network environment by using the **Threads** editor.

**Administrative access assurance**

The **Assure administrative access** option allows connecting only to the Machines that can be processed using administrative rights. It is convenient if you are targeting data modification and would like to retrieve data only from the Machines where it can then be changed by you.
Enumeration Options Page

Enumeration options are designed to make the network enumeration process clearer and more comfortable for you [Pic 1]. To configure the enumeration options, click the glyph of the Network Ribbon group. Also, you can click the Preferences button from the Application Menu and switch to the Enumeration Options preference page using the appropriate link in the navigation bar on the left in the Preferences dialog within the Remote Shutdown group.

![Enumeration Options](image)

Pic 1. Configuring the enumeration options
The **Enumeration type** option specifies the way of performing a network scan for Machines.

The Active Directory scan runs significantly faster than the Computer Browser scan and allows you to get more information on your network structure. Also, there is no need for all network computers to be turned on, because information on the network is gathered directly from the domain controller. However, this type of enumeration requires access to the domain controller and won’t find Machines that are not registered in the Active Directory database.

For the Active Directory scan, the domain hierarchy and structure are respected. Respecting the domain hierarchy means that the same structure will be preserved for domains having a tree structure (registered domains and sub-domains) in the **Network** view as in your Active Directory. Respecting the domain structure means that the Machines in the **Network** view are grouped in the same way they are grouped in Active Directory with the help of containers.

Searching for computers by means of Computer Browser will result in finding all the Machines that are turned on and visible from yours during the Enumeration process.

In the combined mode, the program performs the Active Directory scan first, then adds the Machines found by means of Computer Browser.

Let us take a look at the results received using different options:

**Active Directory scan enabled:**

As a result, all the domains are displayed in a hierarchy where each sub-domain is located under its parent domain (in our case *Dev* is a sub-domain of *Emco* and *Lab* is a sub-domain for *Dev*) with Machines found in them grouped by the Active Directory containers they are located in.
Computer Browser scan enabled:

As a result, we've got only the Machines that are turned on, including those that are not registered in any domain, and all the workgroups and domains are displayed as children of the Network item.
Both Active Directory and Computer Browser scan enabled:

As a result, we've got both the Machines that are turned on and those that are registered in domains: workgroups, domains and Machines are grouped by the structure respect options.
Collections Settings Page

Collection either groups a set of static Machines or defines the method and conditions for fetching Machines to be operated dynamically. The resulting set of Machines, including those retrieved via queries and defined as static entries, can be filtered using custom conditions based on Machine properties. The Collections Settings preference page allows you to configure the Machines querying and filtering options [Pic 1]. To open the Collections Settings page, click the Preferences button in the Application Menu and press the corresponding link in the navigation bar on the left of the Preferences dialog within the Remote Shutdown group.

![Pic 1. Configuring Collections Settings](image-url)
Within the **Collection Members** group, you can define if you would like the Machine Queries to fetch a set of Machines to operate from the entire network or from those already available in the program database. Simply choose the required option in the **Source** field.

When configuring the Machine Filter behavior, you can specify if the program is allowed to use the property values cache, if any, for filtering or if the properties used in the filter condition should be refreshed during each operation before checking the condition. In case you are going to use the cached property values, you can define the time interval during which the properties are considered relevant. All these options can be configured within the **Machines Filter** group.

The **Collections Settings** page defines the querying and filtering configuration used by default by all the Collections, but it is still possible to use a different configuration of each aspect for particular Collections. Refer to the **Collections Management** section of this document for details on how to override the described options.
Remote Agent Page

Remote Shutdown uses an agent to operate remote Machines. This agent can be installed by the program on demand or by a system administrator at any time. The agent deployment type is configured on the Remote Agent preference page [Pic 1]. To change the deployment type, click the Preferences button in the Application Menu and switch to the Remote Agent preference page using the appropriate link in the navigation bar on the left of the Preferences dialog within the Remote Shutdown group.

Pic 1. Choosing the remote agent deployment type
On the Remote Agent page, you are offered to choose if the state of the remote agent should be maintained automatically by the program or the remote agent deployment should be overseen by the network administrator. The difference between these two modes is that when the Automatic Deployment mode is used, Remote Shutdown requires administrative access to the remote file system so the remote Machine should be configured to allow access to its file system. Access to the file system is required to perform the remote agent installation and updates. When the Manual Deployment mode is used, the program does not need to access the remote Machines’ file system to work with the agent; however the remote operation will fail if the remote agent installation or update is required.

In the Manual Deployment mode, the program adds an information to the Execution Results when it fails to operate the remote Machine because the required remote agent installation or update cannot be performed.

For manual deployment, the network administrator should use one of the installation packages supplied with the program. Those packages are available in the Setup folder of the program installation – this folder can be reached using the Remote Agent Setup link in the program sub-menu of the Start menu. The installations are shipped in form of both an executable file, which is platform-independent, and two different platform-dependent MSI files, which can be used, for example, for automatic deployment through GPO.
Execution Results Page

Remote Shutdown stores the results of each remote operation execution, so that you can review the execution statistics for each operation in future. Storing all operation execution results over a lengthy period of time can significantly increase the size of the program database and decrease the program performance. To avoid performance issues, it is recommended to optimize the program database by deleting the results that are no longer needed. Since it is not always easy for the user to remember all the tasks that have ever been executed and remove the results that are no longer needed, the program comes with a built-in option to automatically remove execution results based on their age.

To configure the conditions for automatic removal, open the program preferences using the Preferences button from the Application Menu and click the Execution Results link in the navigation bar on the left of the Preferences dialog within the Remote Shutdown group Pic 1.

You can choose the condition to trigger automatic removal of the execution results within the Auto Remove Options group. It is possible to remove the results that are older than one day, one week, one month, one year, or choose Remote Shutdown not to remove the results automatically. In any case, you can always remove the results that are no longer needed directly from the Execution Results view.
Notifications Page

Another useful feature of Remote Shutdown is that it can send notification e-mails to a preset e-mail address and show balloon tips on occurrence of certain events. This feature can be configured on the Notifications preference page [Pic 1], and the messages are sent using the E-mail Options specified. The e-mail message subject and body used for creating notification messages can be configured on the Mail Templates preferences page. The placeholders that can be used in the templates are described in the Notification E-mails part of this guide.

![Configuring notifications](image)

To access the notifications configuration page, click the Preferences button in the Application Menu and switch to the Notifications preference page using the appropriate link in the navigation bar on the left of the Preferences dialog within the Remote Shutdown group. On the page that opens, you can check the events you want to send notification messages for.

Balloon tips are displayed and sounds are played to notify of each client connected to the server. When disabling such notifications, you disable them only for the client you use at the moment.

Events may occur during two types of task execution: scheduled task execution and manual task execution. Scheduled task execution means that the task execution is initiated by the Remote Shutdown scheduling engine. Task execution via the Run feature is considered to be manual task execution.
Mail Templates Page

Mail Templates are used to form e-mail messages sent by Remote Shutdown. They can be configured on the Mail Templates preference page [Pic 1]. To access this page, click the Preferences button from the Application Menu and select the appropriate link in the navigation bar on the left of the Preferences dialog within the Remote Shutdown group.

[Pic 1. Configuring Mail Templates]

On this page, you are offered to choose a template that you want to review and edit. The template description shows you the use case of the chosen template, and if there are placeholders available for this template, a link to a detailed placeholders description is shown under the template description.

Tasks and Schedule Part

The Tasks and Schedule part of the program preferences should be used to configure the Remote Shutdown features targeted at executing tasks and scheduling their execution, as well as configuring the Tasks and Schedule view. To open the Preferences dialog, click the Preferences button available from the Application Menu. Feel free to configure the available settings to meet your needs best.
Calendar Options Page

The Calendar Options are designed to make the process of interaction with the Tasks and Schedule functionality more convenient for you and enable you to use the whole range of the Tasks and Schedule features to solve your tasks in a more efficient way. To configure the Calendar Options, click the Preferences button from the Application Menu and switch to the Calendar Options preference page using the corresponding link in the navigation bar on the left in the Preferences dialog within the Tasks and Schedule group [Pic 1].

After you have chosen the working days, the other days in the Work Week view are filtered out, and the working hours are highlighted in the Scheduling area for the selected working days. Changing the first week of the year affects the Date Navigator week numbering rule.

On this page, it is also possible to define if the Task execution dates should be highlighted in bold in the Date Navigator and if the week numbers should be displayed on the left, next to each week.
Scheduler Configuration Page

The **Scheduler Configuration** preference page contains settings for representation of the **Scheduling** area. To change the **Scheduler Configuration**, click the **Preferences** button from the **Application Menu** and switch to the **Scheduler Configuration** preference page using the corresponding link in the navigation bar on the left in the **Preferences** dialog within the **Tasks and Schedule** group.[Pic 1]

![Scheduler Configuration](image)

**Pic 1. Changing the Scheduler Configuration**

The **Scheduling Area Presentation** group of the **Scheduler Configuration** preference page should be used to change the default color scheme used by the **Scheduling** area. Also, it is possible to change the **grouping** settings used for the **Scheduling** area. You can group tasks either by type or by date by choosing the required option from the **Grouping mode** drop-down list.
Additional Time Rulers Page

Additional time rulers can be displayed for the Scheduling area when it is in the Day View or Work Week View view modes allowing you to see the time of the time zones that differ from the one defined in the underlying operating system. The Additional Time Rulers preference page should be used to enable those rulers and configure the time zones to be used. To configure additional time rulers, click the Preferences button from the Application Menu and switch to the Additional Time Rulers preference page using the corresponding link in the navigation bar on the left in the Preferences dialog within the Tasks and Schedule group Pic 1.

Pic 1. Configuring additional time rulers
You can add up to two additional time rulers to the **Scheduling** area.

**Example**

![Image of time rulers and scheduling area]

To add a time ruler, you should first enable it by using the **Show additional time zone in Scheduling area** option, then specify the time zone to be used and if the daylight saving time adjustment should be applied to it. You can also provide a label for each additional time ruler to help you identify it.

The **Current Time** field displays the current time in the selected time zone.
Confirmations Page

In some cases, the user's decision may be required for Remote Shutdown to perform further steps, so that the user could get an anticipated result. However, if your decision is always the same, you may not want to see the confirmation requests again and again. The Confirmations preference page was designed to help you set your preferences.

To access this page, click the Preferences button from the Application Menu and select the appropriate link in the navigation bar on the left of the Preferences dialog within the Tasks and Schedule group.

Pic 1. Configuring confirmations
The confirmations are divided into two groups: the Task Execution and Occurrence Change confirmations. Let us take a closer look at each group.

The Task Execution confirmations are required to let the scheduling engine know if it should execute the tasks that should have been executed when the program was not running (such tasks are called Past Tasks), and if it should execute the tasks moved to the past or created for the past. By default, the Confirm Execution dialog is displayed on the screen to let you decide what to do with each task.

![Confirm Execution dialog](Image)

However, if your decision is always the same, you can simply choose the Skip task execution or Run Task option on the Confirmations preference page to always perform the selected action with respect to Past Tasks. The same approach is used for the tasks created for the past and moved to the past.

The Occurrence Change confirmation is displayed during a quick edit of a recurrent task (e.g. dropping Machines on some occurrence). For that confirmation, it should be defined if the changes should refer to the particular occurrence only or the whole series.

![Change Recurring Item confirmation dialog](Image)

If you want to always change the occurrence, simply choose the Change occurrence option on this page.
Miscellaneous Part

The **Miscellaneous** part of the program preferences should be used to configure the common Remote Shutdown options, such as the program behavior in respect to the System Tray, the proxy settings to be used to connect to the Internet, etc. To open the **Preferences** dialog, click the **Preferences** button available from the **Application Menu**. Configure the available settings to best suit your needs.
General Settings Page

Remote Shutdown can automatically check for updates for you to always have the latest version of the program and can be added to the Windows startup. You can configure this feature from the General Settings preference page. To open this page, click the Preferences button from the Application Menu and select the General Settings link in the navigation bar on the left in the Preferences dialog within the Miscellaneous group [Pic 1].

![Image of General Settings](image)

Pic 1. Configuring general settings

Remote Shutdown can check for updates automatically every day or once a week. To enable an automatic checking for updates, check the Automatically check for updates option and choose the checking frequency between Daily and Weekly. You can also define if the program should check for major updates by changing the Automatically check for major updates option value.

If you use a proxy server to connect to the Internet and the required proxy settings are not provided, an automatic check for updates will not take place.

If you want Remote Shutdown to be automatically started right after you are logged on to the underlying operating system, enable the Launch at Windows startup option.
E-mail Options Page

Remote Shutdown can send notification e-mails only after your mailbox settings have been configured properly. To perform the mailbox configuration click the Preferences button from the Application Menu and select the E-mail Options link in the navigation bar on the left in the Preferences dialog within the Miscellaneous group.

Pic 1. Configuring a mailbox
You should specify the mail server host, the encryption type the port to be used for connection to the mail server, the e-mail address to send e-mail messages from, the e-mail message format and the credentials to be used to access the mail server.

**Although Remote Shutdown supports both explicit and implicit SSL/TLS encryption, it is strongly recommended that explicit SSL/TLS be preferred due to its optimized performance and security. Thus, implicit SSL/TLS should only be used for compatibility with servers that do not support explicit SSL/TLS.**

The **Mail Server (SMTP)** value can be provided both as an IP address and as a host name.

Remote Shutdown supports mail servers that run using SMTP. A mail server configuration may be quite complex. Contact your system administrator to get proper configuration details to be used for accessing your mailbox.

You can send a test e-mail to check the settings provided using an appropriate hyperlink. In the next section, it is described how the settings test works and how you can tell if the e-mail options are configured properly.

**How does the test work?**

After you have configured the e-mail options you can send a test e-mail to check the mail server settings. A test message is generated and sent to the specified recipients and the e-mail address specified in the **E-mail Address** field. If you and the other recipients receive the message, it is assumed that the mail options are configured properly, and there will be no problems with sending notification e-mail messages.
Program Database Page

The program database is a storage used by Remote Shutdown to keep all business data and logged events. The program database configuration can be changed on the Program Database preference page. To access this page, click the Preferences button from the Application Menu and select the corresponding link in the navigation bar on the left of the Preferences dialog within the Miscellaneous group.

By default, Remote Shutdown uses the SQLite database management system to store the data within the common application data folder. Using this concept as default, allows you to start using the program without performing additional data storage configuration. The program also supports the Microsoft SQL Server database management system. You can choose the database engine to be used within the Database Management System drop-down list.

Pic 1. Configuring the SQLite database
For the SQLite database, you can choose a new database location. You can either choose the predefined database location or provide a path to the database files manually. While choosing the program database location, be aware of the fact that the concurrent access to the database is not supported by Remote Shutdown. Please also take into account that full access to the database location folder should be granted to the program for it to operate correctly.

Although the SQLite database is preconfigured and set by default, it is recommended to use the Microsoft SQL Server database if you are going to operate in an enterprise environment, because it provides you with a much higher performance and reliability.

Pic 2. Configuring the Microsoft SQL Server database
While choosing the Microsoft SQL Server database to be used by Remote Shutdown, you should provide the database server name to the **Server Name** field and configure the authentication options. You can choose between **Windows Authentication** and **SQL Server Authentication**. It is strongly recommended by Microsoft that integrated security via **Windows Authentication** be preferred. As soon as you have completed this configuration step, you can press the **Test Connection Settings** hyperlink to check if the database server is accessible.

The next step is choosing the database to store data in. You can either use the default configuration or define the required database manually. When choosing a database from those available on the server, it is also possible to create a new one with default settings having provided its name.

When you apply changes to the program database configuration, the program checks the provided settings for validity. If the specified database is empty, you are proposed to fill it with the data available in the database currently used by the program. This feature allows you to switch to the Microsoft SQL Server database from the SQLite database you are using easily and at any time. Besides, if the server restart is required for the applied changes to take effect, you are immediately prompted to restart the server.
Connection Options Page

EMCO Remote Shutdown Enterprise server allows connection from both local and remote clients, including those from other Windows domains and those reachable through the Internet only. When connecting to the EMCO Remote Shutdown Enterprise server using the windows credentials of the session run by the client, the integrated security is used for authentication and communication processes. In a cross-domain case, the client is authenticated to the server using the specified windows credentials, and the server is authenticated with the help of a domain identification certificate enabling communication over a secure socket layer of a TCP channel. This process can be configured on the Connection Options preference page. To open the Connection Options page, click the Preferences button in the Application Menu and press the corresponding link in the navigation bar on the left of the Preferences dialog within the Miscellaneous group.

Pic 1. Configuring Connection Options
By default, the server uses a self-signed custom certificate issued to RemoteShutdownEnterpriseServer.exe, thus there is actually no identification of the server host. It is possible to accept this certificate when connecting to the server; however, it is strongly recommended to use a certificate that actually identifies the server. Such a certificate should be issued to the specific server host by a certification authority trusted in your organization.

For a digital certificate to be used by Remote Shutdown for authenticating the server, the following set of requirements must be met:

1. The certificate must include the **Server Authentication (1.3.6.1.5.5.7.3.1)** within its **Intended Purpose**.
2. The certificate's **Valid From** date must be earlier and the **Valid To** date must be later than the connection date.
3. The digital certificate must be placed in the **Local Computer** certificates storage.
4. The private key must be available together with the signing certificate in the certificates storage. In case you have a private key in a separate file, please use the tool provided by Microsoft for preparing a private & public key pair to be imported into the certificates storage as described here: **Pvk2Pfx, Combine PVK + SPC to PFX**.

To choose a certificate, you should use the **Select Certificate** button in the **Certificate** field. A dialog will be displayed showing you the server authentication certificates available on the PC hosting the service. You can review detailed information on each of the available certificates using the **View Certificate** button. The same button is also available in the **Certificate** field when a server authentication certificate is already selected. The **Reset Certificate** button in the **Certificate** field should be used to discard the selected certificate and use the default one.

To start using the selected certificate for securing communication, it is required to restart the server. The program will notify you of it and prompt for an immediate server restart.
Proxy Settings Page

Remote Shutdown requires an Internet connection to support the **Live Update** and **Feedback** features, as well as be able to upload reports to an FPT server. Therefore, if a proxy server has to be used to connect to the Internet, it should be configured on the **Proxy Settings** preference page [Pic 1]. To access this page, click the **Preferences** button from the **Application Menu** and select the appropriate link in the navigation bar on the left in the **Preferences** dialog within the **Miscellaneous** group.

![Proxy Settings](image)

**Pic 1. Proxy Settings**
On this page, you can configure client and server proxy settings. The client settings are used when checking for updates and providing feedback. For the client settings, you may choose among three variants of the proxy configuration. If **Auto-detect proxy settings** is chosen, the program uses the settings predefined in the **Internet Explorer**. If Remote Shutdown does not have to use a proxy server to connect to the Internet, the **Direct connection to the Internet** option should be chosen. The **Manual proxy configuration** option allows you to provide the proxy server address and port manually.

Both for the automatic detection and manual configuration, it is possible to specify if the proxy server requires authentication and what credentials should be used to connect to the proxy server. For the manual configuration, an NTLM authentication can be used (i.e. connection to the proxy server takes place using the credentials of the user currently logged on) by enabling the **Use NTLM authentication** option.

As for the server settings [Pic 2](#), the configuration process is the same. The difference is only that it is not possible for the server side to detect proxy settings automatically and use NTLM authentication.

![Pic 2. Server proxy settings](#)

After the proxy settings have been configured, it is possible to test if the Internet connection is available by using the corresponding hyperlink on the bottom of the settings page.
Log Configuration Page

To configure the Log behavior, click the Preferences button from the Application Menu and switch to the Log Configuration preference page using the appropriate link in the navigation bar on the left in the Preferences dialog within the Miscellaneous group. Here, you can specify both storing and viewing options to make your work with the log as comfortable as possible [Pic 1].

Remote Shutdown gives you an option of an automatical removal of logged events from its database. The maximum event age can be specified by the Auto remove events option. Choose Do not remove events if you do not want any events to be removed automatically. Anyway, it is always possible to remove logged events by clearing log manually.

The Show Options are designed to help you configure the log representation to best fit your needs. These options specify the maximum age and types of the logged events to be shown.
System Tray Page

The Tray icon provides a quick access to some of the program functionality and serves to notify you of any significant changes taking place while the program is running when the main program window is minimized or hidden behind other windows. To configure the program behavior regarding the System Tray, click the Preferences button from the Application Menu and switch to the System Tray preference page using the corresponding link on the navigation bar to the left in the Preferences dialog within the Miscellaneous group (Pic 1).

If you prefer the program main window to be minimized during the program start, you should check the Minimize on startup option.

The Show program icon in System Tray option allows you to choose if the program icon should be shown in the tray. If it is enabled, you may also specify if the program should be hidden from the Windows taskbar when it is minimized to System Tray, and if the main window should be restored from the tray with a single or double click.
Chapter 10: Evaluation of the Program

EMCO Remote Shutdown Enterprise is a shareware product but you can use it as long as the evaluation period does not expire to get a closer introduction to its main features. To activate the program you should enter the License Code EMCO Software provides you with after you have purchased the license for using EMCO Remote Shutdown Enterprise. This chapter will cover the particularities of the evaluation mode, tell you how and where you can get the license code and how you can request the extended evaluation. Read this chapter carefully to face no difficulties during the EMCO Remote Shutdown Enterprise evaluation.
Evaluation Wizard

As long as the EMCO Remote Shutdown Enterprise is not activated on each program startup the **Evaluation Wizard** is displayed on the screen, showing you the information about the evaluation process and providing with quick links for the program activation, purchase and extended evaluation request.

![Evaluation Wizard](image)

Pic 1. The EMCO Remote Shutdown Enterprise Evaluation Wizard welcome page
The welcome page of the Evaluation Wizard allows you to choose between four options to continue. Those are Evaluate, Enter License Code, Request extended evaluation and Buy now. Optionally you can press Exit button to close the program. In this section we will help you to choose the option that will best fit your needs.

The Evaluate option shows you the time left until the evaluation period expires. You should choose this option to continue the evaluation process – the wizard will be closed and you can start working with Remote Shutdown. You can use the program as long as the evaluation period does not expire to get a closer introduction to its main features.

If you have already purchased the license for using the EMCO Remote Shutdown Enterprise you should choose the Enter License Code option to activate the program. This option also should be chosen if the extended evaluation request has been approved by EMCO Software and you have been provided with the Extended License. If you are having problems with finding the License Code refer to the Where can I get my License Code? section of this document. After choosing the Enter License Code option the program activation page is displayed on the screen Pic 2.

Pic 2. Activating EMCO Remote Shutdown Enterprise
To activate EMCO Remote Shutdown Enterprise copy and paste the License Code to the input field on this page and press **Activate**.

If the evaluation period has expired and you are not sure you have fully introduced yourself to EMCO Remote Shutdown Enterprise main features you can once request the extended evaluation. As soon as the request is processed by EMCO Software you are provided with the Extended License to prolong the evaluation period. To request the Extended License you should choose the **Request extended evaluation** option. After choosing this option the request form will appear on the screen.

![Requesting an extended evaluation](image)

To request the Extended License fill the fields on the request form regarding the **recommendations** and press the **Send Request** button.

The **Evaluation Wizard** also provides you with the short cut action that allows you to visit EMCO Software web store. To use this feature choose the **Buy Now** option. The on-line ordering process is fast, easy, and fully secure.
Where can I get my License Code?

After you have purchased the license for using EMCO Remote Shutdown Enterprise our experts will generate the License Code and send it to you via e-mail to the address you have specified during the purchasing process. You are supposed to receive two e-mail messages – one with the License Code written in the message body and one with the attached text file (license.txt), containing the license. It is your choice to use any message because both License Codes are identical.

To activate the program the License Code received via e-mail should be copied and pasted to the program activation form [Pic 1]. This form can be reached using the Enter License Code button from the Information group on the Ribbon bar or by choosing the appropriate option in the Evaluation Wizard.

![Pic 1. Activating EMCO Remote Shutdown Enterprise](image)

To activate Remote Shutdown, copy and paste the License Code to the input field and press Activate.
How should I formulate the Extended License request?

The Extended License is used to prolong the evaluation period to get a closer look at EMCO Remote Shutdown Enterprise. This feature can be reached by choosing the appropriate option in the Evaluation Wizard. Here we’ll give you the recommendations on filling the Request extended evaluation form.

In the Request extended evaluation form you should obligatory specify your name in the Name field, company name in the Company field and your e-mail address in the E-mail field.

Though the Comment field is optional it is strongly recommended to use this field for providing EMCO Software with the reason of requesting the Extended License. Please notice that EMCO Software reserves the right to decline the request without providing a requester with any explanations.

If the extended license request is approved by EMCO Software experts you’ll receive the License Code to the e-mail address specified.
Chapter 11: Program Updates

EMCO Software cares for versatile needs of the users of EMCO programs and fully understands their wish to have the most up-to-date software installed on their PCs. That is why we provide you with an easy update feature. You do not need to browse the Internet again and again to find out if any updates are available – Remote Shutdown will do this work for you. Checking for updates can be performed both manually and automatically. This chapter describes the Live Update process for the current major version of the program and the Major Update feature which allows you to get a brand new version of Remote Shutdown quickly and easily.
Live Update

Remote Shutdown can be easily updated with just a few clicks. The update process is performed via an Internet connection using preconfigured proxy settings.

**Check for Updates**

The **Check for Updates** button from the **Update** Ribbon group should be used to check for new versions of Remote Shutdown.

Remote Shutdown can check for updates automatically. You can configure the program behavior regarding the automatic check for updates on the **General Settings** preference page.

To check for updates, click the **Check for Updates** button from the **Application Menu** or from the **Update** group of the **Program** Ribbon page. Remote Shutdown will check if any updates are available and if so, the **Live Update Wizard** [Pic 1] will appear on the screen.

![Pic 1. The Live Update Wizard welcome page](image)

The **Live Update Wizard** will introduce you to the changes made in the newer version and guide you through the whole updating process while showing the detailed download progress. When the download is finished, the program will be restarted to perform the actual update.
Major Update

Along with the **Live Update** feature, Remote Shutdown comes with a built-in function of automatic checking for Major Updates. The Major Update is an update to a brand-new version of Remote Shutdown that includes a number of significant changes.

You can install this version alongside the version you are using now. It will import the settings and data from your current version, so that you won't need to configure the new version in the same way you configured the one you are using at the moment. Such parallel installation allows you to inspect the new version and compare it with the previous one in your environment with your data and settings.

The Major Update is installed alongside the version you currently use. The existing version is not automatically uninstalled from your PC, and you can continue using the program version you are accustomed to while having a look at the brand new one.

If the program detects availability of a Major Update, the **Major Update Wizard** will appear on the screen.

The **Major Update Wizard** will introduce you to the features available in the brand new version of Remote Shutdown and guide you through the update process. The message displayed at the bottom of the welcome page will let you know if the current License allows you to install and use the Major Update for free. When the download is finished, the new version installation will be run automatically.
Chapter 12: Main Program Actions

The main program actions are all gathered on the Ribbon bar and are grouped by the functions performed into pages. There are static pages, that are always displayed, and categories, containing contextual pages, that are displayed only when a specific context is active. As for the static pages, they are the following: Home, Remote Actions, View and Program. These static pages are filled up with the pages available in the Network Tools, Tasks and Schedule Tools and Execution Results Tools categories.

This chapter is to describe the actions available on all the pages and can be used as a glossary while working with Remote Shutdown.
Home Ribbon Page

The Home Ribbon page contains all main actions related to the primary features of Remote Shutdown. This chapter will describe each group and the actions available in it for the Home page.

Remote Actions Group

The Remote Actions Ribbon group contains the actions intended for initiating operations over remote Machines and reviewing execution results on the web.

<table>
<thead>
<tr>
<th>Power</th>
<th>The Power button is a multifunctional button that allows you to choose a power management operation to be performed over the selected remote Machines.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration</td>
<td>The Administration button is a multifunctional button that allows you to retrieve MAC address of the selected remote Machines or send a message to these Machines.</td>
</tr>
<tr>
<td>Session</td>
<td>The Session button is a multifunctional button that allows you to choose a windows session management operation to be performed over the selected remote Machines.</td>
</tr>
<tr>
<td>Input Devices</td>
<td>The Input Devices button is a multifunctional button that allows you to lock and unlock input devices on the selected remote Machines.</td>
</tr>
<tr>
<td>Execution Results on the Web</td>
<td>The Execution Results on the Web button can be used to open the EMCO Remote Shutdown Enterprise program web site in the default browser to let you review execution results.</td>
</tr>
</tbody>
</table>

Network Ribbon Group

The Network Ribbon group contains actions intended for filling the program network structure with Machines.

<table>
<thead>
<tr>
<th>Enumerate Machines</th>
<th>The Enumerate Machines button should be used to display the Enumerate Machines wizard, which can help you with adding Machines to the program for further processing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Network</td>
<td>The Scan Network button should be used to scan the entire network or specific Groups for Machines and add them to the program for further processing.</td>
</tr>
<tr>
<td>Add IP Range</td>
<td>The Add IP Range button should be used to add Machines to the program by scanning a specific range of IP addresses.</td>
</tr>
</tbody>
</table>
Add Machine
The **Add Machine** button should be used to add a single Machine to a specific Group for further processing.

New Ribbon Group

The **New** Ribbon group contains the actions for creating new business objects within Remote Shutdown.

Collection
The **Collection** button should be used to create a new Collection to group static Machines and Queries to fetch Machines dynamically.

Scheduled Task
The **Scheduled Task** button should be used to create and schedule a new Task.
Remote Actions Ribbon Page

The **Remote Actions** Ribbon page contains actions for initiating operations over remote Machines, either immediately or on schedule.

Power Ribbon Group

The **Power** Ribbon group is used to group a set of actions targeted on the power management of remote Machines.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shut Down</td>
<td>The <strong>Shut Down</strong> button should be used to turn remote Machines off by performing the operating system shutdown.</td>
</tr>
<tr>
<td>Wake on LAN</td>
<td>The <strong>Wake on LAN</strong> button should be used to wake up remote Machines by sending a magic packet.</td>
</tr>
<tr>
<td>Restart</td>
<td>The <strong>Restart</strong> button should be used to restart the operating system on remote Machines.</td>
</tr>
<tr>
<td>Hibernate</td>
<td>The <strong>Hibernate</strong> button should be used to turn off the remote Machines saving RAM content to disk.</td>
</tr>
<tr>
<td>Sleep</td>
<td>The <strong>Sleep</strong> button should be used to switch remote Machines to stand-by mode for energy saving.</td>
</tr>
</tbody>
</table>

Administration Ribbon Group

The **Administration** Ribbon group contains the actions for performing common administrative operations on remote Machines.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieve MAC Address</td>
<td>The <strong>Retrieve MAC Address</strong> button should be used to scan remote Machines for their MAC addresses.</td>
</tr>
<tr>
<td>Send Message</td>
<td>The <strong>Send Message</strong> button should be used to display a message dialog on remote Machines.</td>
</tr>
</tbody>
</table>

Session Ribbon Group

The **Session** Ribbon group is used to group a set of actions targeted on the management of operating system sessions on remote Machines.
**Sign Out**

The **Sign Out** button should be used to sign out from user sessions on remote Machines.

---

**Lock Session**

The **Lock Session** button should be used to lock the operating system sessions on remote Machines.

---

**Input Devices Ribbon Group**

The **Input Devices** Ribbon group contains the actions for locking and unlocking input devices on remote Machines.

- **Lock Devices**
  
  The **Lock Devices** button should be used to lock the input devices on remote Machines.

- **Unlock Devices**
  
  The **Unlock Devices** button should be used to unlock the input devices on remote Machines previously locked by Remote Shutdown.

---

**New Ribbon Group**

The **New** Ribbon group contains actions for creating and scheduling tasks for performing operations over remote Machines.

- **Scheduled Task**
  
  The **Scheduled Task** button should be used to create and schedule a new task for performing operations over remote Machines. You can choose between the power management, administration, session management and input devices locking tasks.
View Ribbon Page

The View Ribbon page is used to control the program representation, such as the currently applied skin, visible views and their layout.

Layout Ribbon Group

The Layout Ribbon group should be used for a workspace layout management.

Reset Workspace

The Reset Workspace action should be used to restore the default windows', views' and dock panels' layout.

Show Ribbon Group

The Show Ribbon group should be used for managing the currently visible Remote Shutdown views.

<table>
<thead>
<tr>
<th>Welcome</th>
<th>Welcome</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows or hides the Welcome Screen. The Welcome Screen is designed to help you start working with Remote Shutdown.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tasks and Schedule</th>
<th>Tasks and Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows or hides the Tasks and Schedule view. The Tasks and Schedule view allows you to create and schedule predefined tasks for operating remote Machines.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Network</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows or hides the Network view. The Network view shows information on the entire pool of remote Machines introduced to Remote Shutdown. It consists of the Machines discovered during the network scan and Collections.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Credentials</th>
<th>Credentials</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shows or hides the Credentials view. The Credentials view allows you to provide the credentials to be used by the program to access Machines (while performing remote operations) and Active Directory domains (while fetching Machines from the network environment).</td>
<td></td>
</tr>
</tbody>
</table>
Main Program Actions

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Execution Results</td>
<td>Shows or hides the <strong>Execution Results</strong> view. The <strong>Execution Results</strong> view shows the results of business operations on remote Machines.</td>
</tr>
<tr>
<td>Log</td>
<td>Shows or hides the <strong>Log</strong> view. The <strong>Log</strong> view shows information on the events taking place during the program execution.</td>
</tr>
<tr>
<td>Access Control</td>
<td>The <strong>Access Control</strong> view is used to define roles used to control access to the Remote Shutdown server and assign those roles to users and groups.</td>
</tr>
<tr>
<td>All Machines</td>
<td>Shows or hides the <strong>All Machines</strong> view. The <strong>All Machines</strong> view shows the Machines available all over the network.</td>
</tr>
<tr>
<td>Operations</td>
<td>Shows or hides the <strong>Operations</strong> view. The <strong>Operations</strong> view shows detailed progress of each operation currently performed and allows canceling some or all running operations.</td>
</tr>
</tbody>
</table>

**Skins Ribbon Group**

The **Skins** Ribbon group provides you with an option of quick changing of the program skins.

**Skin Chooser**

The **Skin Chooser** is a drop-down button that should be used to select the skin from the available skins to be applied to the program. The currently active skin is the highlighted one.
**Program Ribbon Page**

The **Program** Ribbon page contains service actions that are not connected to the business area of the program.

**Server Ribbon Group**

The **Server** Ribbon group contains actions for reconnecting the client to another server and reviewing information on the server the client is currently connected to.

<table>
<thead>
<tr>
<th>Switch Server</th>
<th>The <strong>Switch Server</strong> button should be used to connect to another Remote Shutdown server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Info</td>
<td>The <strong>Server Info</strong> button allows you to review information on the server the client is currently connected to, including information on other connected clients.</td>
</tr>
</tbody>
</table>

**Organize Ribbon Group**

The **Organize** Ribbon group contains the actions to be used for managing objects.

<table>
<thead>
<tr>
<th>Import</th>
<th>The <strong>Import</strong> button should be used to import objects to Remote Shutdown from a file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export</td>
<td>The <strong>Export</strong> button should be used to export objects from the currently focused view in Remote Shutdown to a file.</td>
</tr>
<tr>
<td>Edit</td>
<td>The <strong>Edit</strong> button allows you to edit the object selected in the currently focused view.</td>
</tr>
<tr>
<td>Delete</td>
<td>The <strong>Delete</strong> button is used to delete the selected objects from the currently focused view in Remote Shutdown.</td>
</tr>
</tbody>
</table>

**Clipboard Ribbon Group**

The **Clipboard** Ribbon group contains the actions to copy/move objects to the clipboard and paste data from the clipboard.

| Paste         | The **Paste** button should be used to add the objects that are currently available from the clipboard to a selected location in the currently focused view. |
Cut
The Cut button should be used to put the selected objects from the currently focused view to the clipboard and remove them from the source after pasting them to the destination.

Copy
The Copy button allows you to put the selected objects from the currently focused view to the clipboard to be copied to the destination when pasting.

Update Ribbon Group
The Update Ribbon group is responsible for the product updates function. The glyph of this group opens the General Settings preference page enabling you to configure the auto-update options.

Check for Updates
The Check for Updates button should be used to check for new versions of Remote Shutdown.

Feedback Ribbon Group
You can use the Feedback Ribbon group to send EMCO Software a request for a new feature you are missing in Remote Shutdown or to report on problems you faced while working with the program.

Suggest a Feature
The Suggest a Feature button should be used to suggest a functionality you would like to see in the next versions of Remote Shutdown.

Report a Problem
The Report a Problem button should be used for reporting the problem you faced while working with Remote Shutdown.

Information Ribbon Group
The Information Ribbon group has a range of useful actions to manage licensing issues, get help or information you may require.

Enter License Code
The Enter License Code action should be used to enter the license code you received from EMCO to activate Remote Shutdown.

Buy Now
The Buy Now button is only visible if Remote Shutdown is not activated. It provides you with a quick access to the EMCO web store.

Contact Support
The Contact Support button should be used to get efficient technical assistance from EMCO Software support team.
EMCO on the Web
The **EMCO on the Web** button provides you with a short-cut to the EMCO website.

About
It opens the **About** dialog to review the Remote Shutdown information, licensing information and the End-User License Agreement.

**Network Tools Category**

The Network Tools Ribbon category is displayed when the **Network** view or the **All Machines** view is active and contains the **Network** page with actions for filling the program network structure with Machines and for managing network objects.
Network Contextual Ribbon Page

The Network contextual Ribbon page from the Network Tools category contains the actions for filling the program network structure with Machines and for managing network objects.

Enumeration Ribbon Group

The Enumeration Ribbon groups contains actions intended for filling the program network structure with Machines.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enumerate Machines</td>
<td>The Enumerate Machines button should be used to display the Enumerate Machines wizard, which can help you with adding Machines to the program for further processing.</td>
</tr>
<tr>
<td>Scan Network</td>
<td>The Scan Network button should be used to scan the entire network or specific Groups for Machines and to add them to the program for further processing.</td>
</tr>
<tr>
<td>Add IP Range</td>
<td>The Add IP Range button should be used to add Machines to the program by scanning a specific range of IP addresses.</td>
</tr>
<tr>
<td>Add Machine</td>
<td>The Add Machine button should be used to add a single Machine to a specific Group for further processing.</td>
</tr>
<tr>
<td>Enumerate New</td>
<td>The Enumerate New button should be used to scan the selected containers for Machines keeping those not available during the enumeration process.</td>
</tr>
<tr>
<td>Enumerate</td>
<td>The Enumerate button should be used to scan the selected containers for Machines removing those not available during the enumeration process.</td>
</tr>
</tbody>
</table>

Collections Ribbon Group

The Collections Ribbon group contains actions for creating Collections and Collections Snapshots; and adding Machines or Queries to existing Collections.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>The New button should be used to create a new Collection to group static Machines and Queries to fetch Machines dynamically.</td>
</tr>
<tr>
<td>Create Snapshot</td>
<td>The Create Snapshot button should be used to create a snapshot from a Collection containing the currently effective set of Machines defined with this Collection.</td>
</tr>
<tr>
<td>Preview</td>
<td>The Preview button allows you to review the currently effective set of Machines defined with the selected Collection.</td>
</tr>
</tbody>
</table>
### Add to Collection

The **Add to Collection** button should be used to add the selected Machines and/or Machine Queries to a new or an already existing Collection.

### Machines Ribbon Group

The **Machines** Ribbon group contains actions for refreshing the remote Machines data and checking their access status.

### Check State

The **Check State** button allows you to check the remote Machines state and to refresh the Machine data.

### Remote Agent Ribbon Group

The **Remote Agent** Ribbon group contains actions for controlling the agent installed to remote Machines to perform remote operations.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>The <strong>Update</strong> button should be used to update the remote agent on the selected Machines.</td>
</tr>
<tr>
<td>Install</td>
<td>The <strong>Install</strong> button should be used to install the remote agent to the selected Machines.</td>
</tr>
<tr>
<td>Uninstall</td>
<td>The <strong>Uninstall</strong> button can be used to remove the remote agent from the selected Machines.</td>
</tr>
<tr>
<td>Reinstall</td>
<td>The <strong>Reinstall</strong> button allows you to reinstall the remote agent on the selected Machines.</td>
</tr>
</tbody>
</table>

### Tasks and Schedule Tools Category

The **Tasks and Schedule Tools** Ribbon category is displayed when the **Tasks and Schedule** view is active. It consists of two pages: **Management** and **Presentation**. The **Management** page contains the actions for creating tasks, navigating the schedule and managing tasks' Machine Queues. The **Presentation** page is used to configure the view modes and the scheduler zoom factor.
Management Contextual Ribbon Page

The Management contextual Ribbon page from the Tasks and Schedule Tools category contains actions for managing scheduled tasks and tasks' Machine Queues and navigating within the scheduler.

New Ribbon Group

The New Ribbon group contains actions for creating regular and scheduled Tasks.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular Task</td>
<td>The Regular Task button should be used to create a new Task without scheduling it.</td>
</tr>
<tr>
<td>Scheduled Task</td>
<td>The Scheduled Task button should be used to create and schedule a new Task.</td>
</tr>
<tr>
<td>Recurring Task</td>
<td>The Recurring Task button should be used to create and schedule a new recurring Task.</td>
</tr>
</tbody>
</table>

Tasks Ribbon Group

The Tasks Ribbon group contains actions for running Tasks.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>The Run button should be used to run the selected Tasks. You can either execute the task for all Machines from the Machine Queue or only for those not processed during the latest execution due to errors.</td>
</tr>
</tbody>
</table>

Navigation Ribbon Group

The Navigation Ribbon group contains actions for navigating within the Scheduling area. The glyph of the group opens the Calendar Options preference page.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backward</td>
<td>The Backward button should be used to navigate backward in the currently selected view within the Scheduling area.</td>
</tr>
<tr>
<td>Forward</td>
<td>The Forward button should be used to navigate forward in the currently selected view within the Scheduling area.</td>
</tr>
<tr>
<td>Today</td>
<td>The Today button enables you to quickly navigate to the today's date within the Scheduling area.</td>
</tr>
</tbody>
</table>
Machine Queue Ribbon Group

The Machine Queue Ribbon group contains actions for adding existing Collections to the current Machine Queue.

Link Collection
The Link Collection button allows you to add Collections from those defined in the program scope to the current Machine Queue.

Presentation Contextual Ribbon Page

The Presentation contextual Ribbon page from the Tasks and Schedule Tools category contains actions for switching between different view modes within the Scheduling area and for changing the level of details for the scheduler.

View Mode Ribbon Group

The View Mode Ribbon group contains actions for switching the view mode within the Scheduling area. The glyph of the group opens the Scheduler Configuration preference page.

Day
The Day button should be used to switch the Scheduling area to the Day View. If the Day View is already chosen, this button is highlighted.

Work Week
The Work Week button should be used to switch the Scheduling area to the Work Week View. If the Work Week View is already chosen, this button is highlighted.

Week
The Week button should be used to switch the Scheduling area to the Week View. If the Week View is already chosen, this button is highlighted.

Month
The Month button should be used to switch the Scheduling area to the Month View. If the Month View is already chosen, this button is highlighted.

Timeline
The Timeline button should be used to switch the Scheduling area to the Timeline View. If the Timeline View is already chosen, this button is highlighted.
Scale Ribbon Group

The Scale Ribbon group contains actions for configuring the level of details for the Scheduling area. The glyph of the group opens the Additional Time Rulers preference page.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td>The Zoom In button should be used to increase the level of details for the currently active view within the Scheduling area.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>The Zoom Out button should be used to decrease the level of details for the currently active view within the Scheduling area.</td>
</tr>
<tr>
<td>Time Scales</td>
<td>The Time Scales button allows you to choose the scales displayed within the Timeline View of the Scheduling area.</td>
</tr>
</tbody>
</table>

Execution Results Tools Category

The Execution Results Tools Ribbon category is displayed when the Execution Results view is active. It contains the Execution Results page that is used to configure the scope of data displayed within the Execution Results view.

Execution Results Contextual Ribbon Page

The Execution Results contextual Ribbon page from the Execution Results Tools category contains actions for configuring the Execution Results view.

View Mode Ribbon Group

The View Mode Ribbon group contains action for switching the view mode within the Execution Results view.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Runs</td>
<td>The All Runs button switches the Execution Results view to the mode in which runs for both tasks and individual operations from the specified date range are displayed.</td>
</tr>
<tr>
<td>Task Runs</td>
<td>The Task Runs button switches the Execution Results view to the mode in which only runs of tasks for the specified date range are displayed.</td>
</tr>
<tr>
<td>Individual Runs</td>
<td>The Individual Runs button switches the Execution Results view to the mode in which only execution results of individual operations for the specified date range are displayed.</td>
</tr>
<tr>
<td>Link with Selection</td>
<td>The Link with Selection button should be used to turn on and off the option of synchronizing the results displayed in the Task Runs mode of the Execution Results view with the tasks selected within the Task and Schedule view.</td>
</tr>
</tbody>
</table>
Chapter 13: Remote Shutdown Client-Server Concept

Remote Shutdown Enterprise is shipped as a client-server application, thus allowing to run tasks on schedule with no logged-on user session required. The server part is represented with the EMCO Remote Shutdown Enterprise Server 6 Windows service, and the client part is the program that is running in a user session. By default, the service is configured to start together with the underlying operating system, thus allowing you to run tasks on schedule as soon as the hosting PC is up and running. When you launch the client program, it prompts you to choose if the server to connect to is located on the local or remote PC [Pic 1].

![Pic 1. Choosing the server to connect to](image)

For the server to accept remote connections, the following ports should be opened in the firewall for inbound TCP connections:

- **48014** – this port is used to connect to the remote server using the Windows session credentials;
- **48015** – this port is used to connect to the remote server via a SSL channel using the specified credentials.

If you would like to use custom ports, you can define the required ports in the HKEY_LOCAL_MACHINE\SOFTWARE\EMCO\Remote Shutdown Enterprise\v6 key in the Windows Registry on the PC hosting the EMCO Remote Shutdown Enterprise server. To override the port used for connection by using the Windows session credentials, you should specify it in the **Port** DWORD value. The **SSLPort** DWORD value should be defined to override the port used for connection via a SSL channel using the specified credentials. For the client to be able to connect to the server via a custom port, you should define this port in the server name, e.g. *emco-server.local:3112*. 
After the connection is established, the client allows you to manage the machines and tasks if you account is authorized accordingly by the server access control configuration. You can disconnect from the current server and connect to another one at any time using the **Switch Server** button from the Application Menu or from the **Server** Ribbon group on the Program page.

When connecting to a remote server, you can choose if you would like to use the credentials of the Windows session the client program is executed in or to provide other credentials. When the current session credentials are used, all aspects of the Windows integrated security are applied to the client-server communication. Otherwise, when the credentials are provided manually, the transport layer of communication is secured with a SSL certificate provided by the server. By default, the self-signed certificate issued to `RemoteShutdownEnterpriseServer.exe` is used. It is not fully trusted, because the DNS match and the trusted root conditions are not met. Although it is possible to accept this certificate for communication, it is strongly recommended that you use the certificate issued to your server. It can be either your self-signed certificate issued by a certification authority trusted in your organization or the certificate issued to the server by one of the commonly known certification authorities. The certificate to be used by the server for authentication is selected on the Connection Options page of the program preferences.

In the **Server** group, you can also find the **Server Info** button. When this button is pressed, a dialog is displayed containing information on the server and all the clients currently connected to it. Upon exiting the program, the client is disconnected from the server application that keeps running on the server PC.

In case the currently installed client is not compatible with the server you are connecting to, the program will prompt you that a compatible client needs to be installed, if it is not installed yet, otherwise the compatible client is automatically launched and connected to the specified server.
Chapter 14: Access Control

Remote Shutdown server supports concurrent access by multiple users. Each user is authenticated by its Windows credentials, but for an enterprise solution it is not enough to authorize access since each action should also be authorized for specific users only so that a simple user cannot perform administrative tasks. In Remote Shutdown the server access is controlled by means of roles.

Each role defines a set of enabled privileges. There are three predefined user roles, which are Administrator, Read-Only and No Access. The Administrator role is used to grant users an unlimited access to the server. The Read-Only role allows the users in that role to access the server but does not allow performing any modifications to the server data and configuration. The No Access role should be used to disallow access for specific users that belong to the groups for which access is granted. In addition to these predefined roles, you can create custom roles enabling required privileges for those roles.

The roles may be assigned to users and groups thus granting or disabling access to Remote Shutdown features for specific users. By default, users that are members of the built-in administrator groups on the PC hosting the server are assigned the Administrator role. Other users are not allowed to connect to the server.

It is possible to grant users administrative access without applying the Administrator role to them by adding those users to the Remote Shutdown Administrators Windows group. This option can be used by the server administrator to get protected from losing the administrative role due to mistakes in roles configuration or manipulations performed by other administrators.

The roles are managed and assigned within the Access Control view. To assign roles to users and/or groups, use the Assign Permissions button in the Permissions part of the Access Control view. A dialog will be opened where you can add a set of principals and choose a role for each one.

Pic 1. Permissions assignment
The assignment process is fast and easy. All you need is adding a list of principals for which you would like to assign roles in the table then selecting a role for each one on the right of the table. You may select multiple principals and assign them the same role. For each role, you can review the set of enabled privileges. To proceed with assignment, press the **Assign** button.

To assign another role to any principal, select it in the **Access Control** view and click the **Edit** button. Alternatively, you can use the corresponding item in the pop-up menu. A dialog will be opened where you can choose a new role for the selected user or group. To delete role assignments, use the **Delete** buttons and menu item.

To create a custom role, use the **Add** button in the **Roles** part of the **Access Control** view. A dialog will be opened where you can specify a name for the role to be created and a set of privileges to be granted to users in this role [Pic 2].

![Add Role](image)

**Pic 2. Creating a user-defined role**

You can use the **Edit** button and menu item to change the role in the future. As during creation, it is possible to specify the role name and a set of privileges. To delete specific user-defined roles - if they are no longer required - use the **Delete** button and menu item. If the role is assigned to principals, you are prompted to decide during the deletion process whether you would like to delete the assignment altogether or reassign another role to those principals.
Chapter 15: Notification Center

The Notification Center is used to notify users about possible configuration problems, available program updates, etc. As soon as notifications arrive, you are able to see a balloon icon in the status bar together with the number of available notifications. When you click on this element, the notifications are displayed in a flyout window on the right of the main program window [Pic 1].

When you click on the notification, you are proposed to perform the action requested by the notification. For example, in case of the configuration issue, the preferences dialog is displayed on the appropriate page, allowing you to fix the issue, and in case of the available update, the update wizard is displayed.

If the notification is about any kind of a critical issue, it is highlighted red and it is not possible to ignore it. For other notifications, you can close each and every one using the cross button in the right top corner of the notification row. As the notification is closed, it won't be displayed again until the condition for displaying it is reached once again.
Chapter 16: Requirements

Please carefully read and follow all requirements, listed here, or you may not be able to successfully use the product. You can contact our support if you experience a problem during the product use.

System Requirements

Computer running Remote Shutdown must meet the following requirements:

Minimum Hardware Requirements

- Intel Core 2 Duo Processor or equivalent
- 2 GB of RAM
- 250 MB of free disk space

Recommended Hardware Requirements

- 6th Gen Intel Core Processor or equivalent
- 4 GB of RAM
- 500 MB of free disk space

Supported Platforms

Windows XP (with SP3 or later), Windows XP x64 (with SP2 or later), Windows 2003 (with SP2 or later), Windows 2003 x64 (with SP2 or later), Windows 2003 R2, Windows 2003 R2 x64, Windows Vista, Windows Vista x64, Windows 2008, Windows 2008 x64, Windows 2008 R2, Windows 7, Windows 7 x64, Windows 8, Windows 8 x64, Windows 2012, Windows 8.1, Windows 8.1 x64, Windows 2012 R2, Windows 10, Windows 10 x64, Windows 2016

Requirements

- Administrative rights on the local computer
- Microsoft .NET Framework 4.5 or above (recommended), Microsoft .NET Framework 4.0 (minimum)
- Ability to access ADMIN$ share on remote computers
- Enabled NetBIOS over TCP/IP

Requirements for Remote Computers

Remote computers, accessed by Remote Shutdown must meet following requirements.

- A remote access with a Local or Domain administrator rights
- Enabled NetBIOS over TCP/IP
• An ability to ping the computer within 1500 ms
• Started services: Computer Browser, Remote Registry
• File and Printer sharing enabled
• Enabled access to the ADMIN$ share
• TCP ports opened: 135, 139, 445
• UDP ports opened: 137, 138
Chapter 17: How can I leave my Feedback?

EMCO Software always takes care of its customers, and your opinion means a lot to us. For this reason, our programs have built-in features for your feedback. You can suggest a feature you want to see in new program versions or report a technical problem you have faced using the program. Specifying your contact information on the feedback forms ensures that you will be informed of any changes with regard to the reported issue, our plans for implementing the suggested feature or fixing the reported bug. Those actions can be found in the Feedback Ribbon group of the Program page.

Suggest a Feature

The Suggest a Feature button from the Feedback Ribbon group should be used to suggest a functionality you would like to see in the next versions of Remote Shutdown.

Remote Shutdown comes with a wide range of features, but if you feel some functionality is missing, you can always suggest a new feature to us that you want to see in the program. To suggest a new feature, you should press the Suggest a Feature button from the Feedback Ribbon group. After pressing this button, you will see the Feature Suggestion dialog on the screen where you are offered to enter your contact information and describe your suggestion.

Pic 1. The feature suggestion form
Press **Send** when you are done with filling out the form to send your suggestion.

**Report a Problem**

The **Report a Problem** button should be used to report a problem you have faced while working with Remote Shutdown.

Remote Shutdown is easy to use and very stable. Nevertheless, if you have faced any difficulty or problem while working with it, you can send us a problem report. To send such a report, you should press the **Report a Problem** button from the **Feedback** Ribbon group. When this button is pressed, the **Problem Report** dialog will appear on the screen where you are offered to enter your contact information and describe your problem.

![Problem Report dialog](Pic 2. The problem report form)

In the **Environment** field, you can provide us with a description of the specific environment used while working with the program. Press **Send** when you are done with filling out the form to send your report.

Do not hesitate to contact EMCO Software - we are always glad to receive your feedback and are doing our best to satisfy our customers' preferences.
Chapter 18: About EMCO Software

EMCO Software is a leading innovator on the remote administration and management solutions market. Headquartered in Reykjavik, Iceland, we are an international company with offices and operations around the globe. Since the company's founding in 2001, we have been dedicated to providing network administrators with feature-rich, easy-to-use and affordable software and improving productivity of IT departments. Focused on the real-world needs of network professionals, our products are simple to try, simple to use, and simple to maintain while providing the power, scalability and flexibility needed by companies and organizations of all sizes.

Our solutions portfolio includes award-winning products targeted at remote network inventory, remote software deployment, remote desktop access and administration, network protection from viruses and malware, network security and health analyzing, remote power management, and remote automation.

Our Innovations

For a long time, products for remote desktops management, administration and inventorying were positioned on the market as enterprise-level solutions with a prohibitive total cost of ownership. A high price and a significant complexity kept many companies and organizations away from those solutions despite their high demand for tools that can improve productivity of their IT departments. We came onto the market looking to change this situation focusing on real-world needs of network professionals by providing simple but effective products and making them affordable for companies and organizations of all sizes.

Our first releases in 2001 proved that our products - which can be up and running within minutes, with no learning and complex configuration required, to immediately provide remote desktop control over the network - were exactly the solution that network engineers need most. An intuitive interface, valuable highly demanded features and an affordable price were the key factors to our quick market acquiring. After the first big success, our solutions portfolio quickly grew to 35 products that cover various fields of network administration and help automate hundreds of administration tasks. Along with this, there is still a lot of space for improvement, and we plan to further extend our product range to provide best-of-breed solutions.

EMCO Worldwide

More than 20,000 customers in 85 countries around the world rely on our products every day to take the complex routine out of their network management tasks. Our solutions help them to remotely manage as many as 2,3 million desktops and 103,000 servers and save millions of hours of work and multi-million dollar costs in total every year. Our worldwide customer base includes dozens of Fortune 100 and hundreds of Fortune 500 companies, as well as numerous large and small businesses representing all industries, educational and healthcare organizations, charity and non-profit organizations, and government institutions.

As a global company, we have partners all around the world who contribute to our products development, international sales and technical support. We are proud to cooperate with leading distributors and more than 50 resellers from 20 countries who represent our products on local markets.

Company Facts

- Year founded: 2001
- Headquarters: Reykjavik, Iceland
• Status: International corporation
• Expertise: Software network solutions
• Number of products: 35+
• Technology awards: 100+
• Number of customers: 20,000+
• Customers in: 85 countries worldwide
• Fortune 100 customers: 37%
• Fortune 500 customers: 49%
• Operations in: 20 countries worldwide
• Number of sales partners: 50+
Chapter 19: Contact Information

We would be glad to help you with any questions and problems you might have. Here you can find all the information you will need to contact us. To get quick answers regarding support issues or any other services, use corresponding contact information.

Company Requisites

- Name: EMCO ehf.
- Address: 12, Bildshofda St.
- City: Reykjavik
- Country: Iceland
- Postal code: 110
- E-mail: emco@emcosoftware.com
- Site: emcosoftware.com

Sales Questions

For any pre-sales or sales questions, contact us at sales@emcosoftware.com or call us:

- +1 646 233-1163 Business days 9.00-18.00 GMT (8.00-13.00 EST; 8.00-12.00 CST; 8.00-10.00 PDT).
- +44 20 3287-7651 Business days 9.00-18.00 GMT.

Other hours: please leave your phone number and message - we will recall you within one business day.

Technical Support

In case of any problems with our products or any technical question related to our products, please visit our Support area to receive FREE technical support.